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WELCOME TO RAPID SQL

Welcome to Rapid SQL, the database administration and development solution that lets you
manage IBM DB2 for Linux, Unix, and Windows, IBM DB2 for z/OS and OS/390, Interbase/
Firebird, Microsoft SQL Server, MySQL, Oracle, PostgreSQL, Teradata, Sybase 1Q, and Sybase
ASE databases.

The list below describes the major sections of this document.

e Getting Started - Provides an introduction for new users and helps you set up Rapid SQL.
Included is an investigation of the major user interface elements, detailed tutorial exercises,
and instructions on configuring Rapid SQL features.

e Datasource and Server Management - Shows you how to register the datasources that Rapid
SQL will work against.This chapter also describes the extensive datasource management
facilities.

e DB Team Server Support - Shows you how to make use of datasource definitions and ER/
Studio model data in a Team Server Repository.

e Database Object Management - Describes how to create new database objects, edit
existing objects, and provides details on the operations you can perform against database
objects.

¢ Coding Environments/Editors - Describes the development/execution/testing environments

offered.

e Tools - Tools provide search, script and file execution, scheduling, visual difference, a visual
query builder, data import, a data editor, and an auto-replace tool for the scripting
environment.

e Project Management - Rapid SQL provides project support and version control system
integration.

e Add-on tools - License-dependent add-ons include:

e Debuggers - Rapid SQL provides debugging environments for DB2 LUW, SQL Server,
Oracle, and Sybase ASE.

® Oracle PL/SQL Profiler - captures metrics of various PL/SQL programmable objects as
they are executed

e Code Analyst - helps you identify time-consuming lines of code.

ADDITIONAL PRODUCT INFORMATION

The Embarcadero Web site provides access to information and resources useful through the life
of your product. This includes access to:

e Technical Support

RAPID SQL 8.7.2/XEé6 USER GUIDE 11
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e Case studies, video presentations, webinars and white papers
e Product communities through the Embarcadero Developer Network
e Free trials of related products

See www.embarcadero.com/support:

PREREQUISITES AND PRELIMINARY TASKS

The following topics provide information on requirements that must be satisfied and initial setup
tasks that must be performed before using Rapid SQL:

e Technical Requirements and DBMS Support

e Licensing

TECHNICAL REQUIREMENTS AND DBMS SUPPORT

For Rapid SQL system requirements and details on DBMS product support, see the Read Me at
http://docs.embarcadero.com/products/rapid sqgl/.

EMBARCADERO DB TEAM SERVER SUPPORT

Rapid SQL can make use of datasource definitions stored on Embarcadero Team Server
installation. For details, see "DB Team Server Support" on page 167.

GENERIC JDBC AND ODBC SUPPORT

Generic JDBC/ODBC connectivity to non-dedicated DBMS systems or non-database
datasources is also provided. Rapid SQL can connect to a datasource using a customer-
provided, third-party JOBC version 3.0 or ODBC version 3.0 driver. Minimal Rapid SQL
functionality is provided, including a basic Explorer tree and SQL querying.

IBM DB2 FOR Z/OS STORED PROCEDURE REQUIREMENTS

When working against an IBM DB2 for z/OS data source, Rapid SQL relies on the following
stored procedures, provided as an optional installation step in setting up the DB2 subsystem:

e DSNWZP
¢ DSNUTILS

+ ADMIN COMMAND DSN
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+ ADMIN_ COMMAND DB2

Prior to using Rapid SQL against an IBM DB2 for z/OS data source, ensure that these
components are installed on the server. See http://publib.boulder.ibm.com/infocenter/dzichelp/
v2r2/topic/com.ibm.db2.doc.inst/stpadd.htm#stpadd for more information.

LICENSING

For Rapid SQL licensing information, see the Quick Start Guide at http://
docs.embarcadero.com/products/rapid _sal/.

MORE INFORMATION ON USING THIS DOCUMENT

The following topics provide additional information that is useful when working with product
documentation:

o Accessing Third Party Documentation

e Shorthand for Third Party Product References

ACCESSING THIRD PARTY DOCUMENTATION

Many Rapid SQL features provide support for functionality available in the supported third party
DBMS platforms. In object management for example, properties available when creating or
editing objects and actions available against object types, are direct equivalents of clauses,
options, or keywords available for use with the third party equivalent.

In such cases, no attempt is made to duplicate detailed documentation by third parties. Casual
descriptions are provided, noting the third party equivalent. You can consult the third party
documentation for details or clarifications. The following links provide access to online
documentation for DBMS platforms supported by Rapid SQL:

e |[BM DB2 for Linux, Unix, and Windows documentation

IBM DB2 for z/OS documentation

InterBase/Firebird documentation

Microsoft SQL Server documentation

MySQOL documentation

Oracle documentation

PostgreSQL documentation

Sybase ASE and Sybase IO documentation
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SHORTHAND FOR THIRD PARTY PRODUCT REFERENCES

To save space in headings and table columns, shorthand is used to represent versions and
variations of the DBMS platforms supported by Rapid SQL.

e DB2 LUW
e DB2z/OS
e |TB/FBD *

e MySQOL

e PSTGRS *
e SQOLSVR

e SYB ASE

e SYBIQ

e TERA

For specific DBMS version support for Rapid SQL, see the Read Me at http://
docs.embarcadero.com/products/rapid _sgl/.

DB2 LUW
DB2 LUWis used as shorthand for IBM DB2 for Linux, Unix, and Windows.

DB2 z/0OS
DB2 z/OS is used as shorthand for IBM DB2 for z/OS.

ITB/FBD *
ITB/FBD is used as shorthand for InterBase/Firebird.

InterBase/Firebird is supported on Rapid SQL only

MySQL
MySQL is used as shorthand for the MySQL RDBMS.

ORCL
ORCL is used as shorthand for Oracle.

14 RAPID SQL 8.7.2/XE6 USER GUIDE
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PSTGRS *
PSTGRS is used as shorthand for PostgreSQL.

Specifically-supported PostgreSQL-based database products include Greenplum, Pivotal
HAWQ, and BigSQL.

SQL SVR
SQL SVR is used as shorthand for Microsoft SQL Server.

SYB ASE
SYB ASE is used as shorthand for Sybase Adaptive Server.

SYB IQ
SYB 1Q is used as shorthand for Sybase 1Q.

TERA
TERA is used as shorthand for Teradata.
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GETTING STARTED

The following sets of topics are intended for new users. They provide learning curve material and
tell you how to configure Rapid SQL:

e Application Basics - Provides detailed tutorial exercises that introduce the basic areas of
Rapid SQL functionality.

e Specifying Rapid SQL application and feature options - Tells you how to configure Rapid
SQL.
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APPLICATION BASICS

Application Basics is designed to situate you within the application and to provide information
about what Rapid SQL offers in the way of design, navigation, and application features. The
information presented here is high-level and conceptual.

Application Basics is divided into two sections, the table below describes each section:

Section Description

Starting Rapid SQL Describes the various ways to start the application.
Product Design This section describes the Rapid SQL user interface.
Specifying Rapid SOL This section describes how to customize Rapid SQL's
application and feature configuration to suit your specific needs.

options

STARTING RAPID SQL
There are three ways to start the Rapid SQL application:

e Starting an Installed version of Rapid SOL from the Start Menu

e Starting an Installed version of Rapid SOL from the Command Line

e Starting a .ion version of Rapid SQOL

STARTING AN INSTALLED VERSION OF RAPID SQL FROM THE START MENU

The Start menu sequence for DBArtisan is always in the form Programs > Embarcadero
DBArtisan version identifier > Embarcadero DBArtisan version identifier, where version
identifier reflects the version you are running.

STARTING AN INSTALLED VERSION OF RAPID SQL FROM THE COMMAND LINE

Command line startup is primarily aimed at identity management systems working in
conjunction with Rapid SQL. Such systems can be configured to start Rapid SQL and connect to
a specific datasource using credentials that are invisible to the user. Other applications that hide
credentials, force connection to a specific datasource, administer usage audits, or otherwise
automate startup of Rapid SQL can make use of this feature.

Two forms of command line startup are available. Syntax and parameters are as follows:
rsql.exe -D datasource -U username -P password
For example, rsql.exe -D torlabsy01 -U myusername -P mypassword

rsql.exe -R connectionstring -D datasource -U username -P password

RAPID SQL 8.7.2/XEé6 USER GUIDE 19



APPLICATION BASICS

For example, rsqgl.exe -R "oracle://
(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=TORLABORCL10g_2)(PORT=1521))(C
ONNECT_DATA=(SID=0ORASID)))" -D torlabora10g_2 -U sys -P squeal

NOTE: For details on valid connection strings, see "-R Switch Values by Platform" on page 21.

Keep the following points in mind when using command line startup:

Credentials remain valid until the user disconnects from the datasource.

When you try disconnect, a confirmation message box includes a warning message that the
connection has external credentials that will be lost if you choose to proceed with
disconnect.

Once disconnected, a user must connect to the previously disconnected datasource using
specified, valid credentials or rely on Auti-connect. For more information, see "Manually
Registering or Editing Datasources" on page 123.

Command line credentials override the default credentials provided if a datasource is
registered using the Auto-connect setting.

Regarding the switch specifications:

20

The password switch/value pair is optional and the P switch can be provided without a value.
The switches are case-sensitive while the datasource is case-insensitive;
The order of these switches doesn't matter;

Switches can be specified with the minus sign or with a slash and any combinations are
allowed. For example, RSQL.-D ROMLABSQLO08 /U sa /P.

If you specify a switch multiple times, it's last valid occurrence from left to right is used. We
auto-connect a single datasource, no matter the number of times a -D switch is specified,;

The -p switch (with lower case) prints a file;
If -R is specified then one of the following will occur:

e |f-Dis also specified, it will check to see if that datasource already exists. If it does exist, it
will check to see if its connection information matches the provided -R parameter. If it
matches, startup behavior will be the same as if -R was not specified. If it doesn't match, a
modified form of the datasource name is generated using the -D-provided name to
ensure uniqueness and give it the connection information specified by -R. If the
datasource doesn't exist, a new datasource is generated using the name provided by -D
and the remaining connection information provided by -R.

e o|f -D is not specified, the -R-provided datasource is checked for a match against existing
datasources. If a match is found, ithat datasource is connected. If no match is found, a new
datasource is generated using the -R-provided information to create a unique name.

NOTE: If connecting to an existing datasource with auto-connect enabled, if -U and -P values
were provided, then auto-connect will be disabled and the provided -U and -P values
are used.
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-R SWITCH VALUES BY PLATFORM

The following table lists the valid connection strings that can be used with the -R switch for a
command line startup.

APPLICATION BASICS

oracle:@<ALIAS>

where CONNECT_DESCRIPTOR is in the same
form as in the TNSNames.ora file. i.e.
(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(
HOST=<HOST>)(PORT=<PORT>))(CONNECT
_DATA=(SID=<SID>)))

where ALIAS is the name from the
TNSNAMES.ora file

Platform Connect String Notes
DB2 LUW and db2://<HOST>/<DB> If the DB2 ODBC/CLI driver is installed on the
DB2 z/OS db2://<HOST>:<PORT>/<DB> system, that driver will be used for DB2
’ ’ connections. Otherwise the IBM Data Server
db2:@<ALIAS> Driver for JDBC will be used.
whgre A!-lAS is the name from the DB2 client Using "db2p" will make the datasource created
registration permanent
ITB/FBD * interbase://<HOST>/<DB> If the InterBase ODBC driver is installed on the
interbase://<HOST>:<PORT>/<DB> system, that driver will be used for an InterBase
' ' connection. Otherwise, the InterBase JDBC
driver will be used.
Using "interbasep" will make the datasource
created permanent.
If the Firebird ODBC driver is installed on the
_— ) system, that driver will be used for Firebird
firebirdsql://<HOST>/<DB> connections. Otherwise, the Jaybird JDBC
firebirdsql://<HOST>:<PORT>/<DB> driver will be used.
Using "firebirdsqlp" will make the datasource
created permanent
MySQL mysql://<HOST> If the MySQL ODBC driver is installed on the
mysql://<HOST>/<DB> system, that driver will be used to make the
' connection. Otherwise, the MySQL Connector/
mysql://<HOST>:<PORT> J JDBC driver will be used.
mysql://<HOST>:<PORT>/<DB> Using "mysqglp" will make the datasource
created permanent
ODBC odbc://<CONNECT_STRING> Using "odbcp” will make the datasource
where connect string can be the a System DSN created permanent.
name on it's own or the full ODBC connection
string containing at least one of the following
tags: DSN=, FILEDSN= or DRIVER=
ORCL oracle://<CONNECT_DESCRIPTOR> If OCl is installed on the system, that driver will

be used. Otherwise, the Oracle Instant Client
will be used.

Using "oraclep" will make the datasource
created permanent
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teradata://<HOST>/<DB>
teradata://<HOST>:<PORT>
teradata://<HOST>:<PORT>/<DB>

Platform Connect String Notes
SQL SVR sqlserver://<HOST> The latest Microsoft ODBC driver for SQL
sqlserver://<HOST>/<DB> Server installed on the system is used to make
' the connection.
sqlserver://<HOST>:<PORT> . i
Using "sglserverp” will make the datasource
sqlserver://<HOST>:<PORT>/<DB> created permanent
sqlserver://<HOST>\<INSTANCE>
sqlserver://<HOST>\<INSTANCE>/<DB>
sqlserver://<HOST>\<INSTANCE>:<PORT>
sqlserver://<HOST>\<INSTANCE>:<PORT>/
<DB>
sqlserver:@<ALIAS>
sqlserver:@<ALIAS>/<DB>
where ALIAS is the name from the Network
Library Configuration
SQL SVR Azure | sglserverazure://<HOST> The latest Microsoft ODBC driver for SQL
sqlserverazure://<HOST>/<DB> Server installed on the system is used to make
' the connection.
Using "sglserverazurep” will make the
datasource created permanent
SYB ASE sybase://<HOST> If CTLIb is installed on the system that driver will
sybase://<HOST>/<DB> bg used.. Otherwise the Sybase jConnect JDBC
driver will be used.
sybase://<HOST>:<PORT> o .
Using "sybasep" will make the datasource
sybase://<HOST>:<PORT>/<DB> created permanent
sybase:@<ALIAS>
sybase:@<ALIAS>/<DB>
where ALIAS is the name from the SQL.ini file
SYB IQ sybaseiq://<HOST> If the Sybase IQ ODBC driver is installed on the
sybaseiq:/<HOST>/<DB> system it will use that, otherwise it will use the
' Sybase jConnect JDBC driver.
sybaseiq://<HOST>:<PORT> ) ) )
. Using "sybaseigp" will make the datasource
sybaseiq://<HOST>:<PORT>/<DB> created permanent
Teradata teradata://<HOST> If the Teradata ODBC driver is installed on the

system it will use that, otherwise it will use the
Teradata JDBC driver.

Using "teradatap" will make the datasource
created permanent.

For more general information, see "Starting an Installed version of Rapid SQL from the
Command Line" on page 19.

STARTING A .ION VERSION OF RAPID SQL
Start the application by double-clicking the file you downloaded.
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PRODUCT DESIGN

The Rapid SQL window opens with the Database Explorer on the left, the Workspace on the
right, and all toolbars docked at the top of the application. The Output Window is not
automatically displayed. Rapid SQL also offers you a number of desktops, or workspaces, that
you can toggle among while you work.

DATABASE EXPLORER

Rapid SQL organizes the wealth of information pertaining to your servers through its Database
Explorer. The Database Explorer provides a fast and efficient way to access your database
objects and scripts. The Database Explorer is a separate window containing a tree object that
you can select and expand. The tree object organizes and nests subjects as branches. By
expanding or collapsing the tree, you can efficiently browse multiple datasources. The Database
Explorer window is dockable so that you can maneuver through the application efficiently.

For details on the Explorer and datasource management, in general, see the following topics:

e "Datasource and Server Management" on page 121

e "Using the Datasource Navigator" on page 146

TIP:  You can also set these options on the Explorer tab of the Options Editor. For details,
see Explorer Options - Main Tab.

RapPID SQL WINDOWS

The Rapid SQL interface includes several windows to help you develop your program. The
windows include:

Topics
® Describe Window

Output Window

Browsers

Workspaces

Preview Dialog Boxes

DESCRIBE WINDOW

Rapid SQL offers a floating Describe window for procedures, tables, views, and functions (Oracle
and IBM DB2 LUW for Open Systems only). In the Describe window, you can view columnar
information (for tables and views) or input parameter information (for procedures and functions).
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Opening the Describe Window
Rapid SQL offers three ways to open the Describe window:

1 In an editor, right-click an object and then click Describe from Cursor.
2 On the Explorer Tab, select an object and then click Describe.

3 On the Explorer Tab or in an editor, select an object and then press CTRL+D.

Using the Describe Window

In the Describe window:
1 Click the Name list and then click a name to view a list of types of objects in the database.

2 Click the Owner list and then click an owner to view a list of all owners of objects in the
database.

3 Click the Type list and then click a type to view columnar information (for tables and views) or
input parameter information (for functions and procedures).

OuTPUT WINDOW

Rapid SQL incorporates a separate window to capture all messages returned by the server and
to log entries about the progress of operations started by the application.

For more information, see Configuring the Output Window

CONFIGURING THE OUTPUT WINDOW
Rapid SQL lets you display, hide, or dock the Output Window anywhere in the application.

Displaying the Output Window
1 On the View menu, click Output.
OR
On the Main toolbar, click Output.

Rapid SQL displays the Output Window.

Hiding the Output Window
1 On the View menu, click Output.

OR
On the Main toolbar, click Output.

OR
Right-click the Output Window and then click Hide.

Rapid SQL hides the Output Window.
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Docking the Output Window
Right-click the Output Window and then click Docking View.

Rapid SQL docks the Output Window to the bottom of the application frame.

Undocking the Output Window
Right-click the Output Window and then click Docking View.

Rapid SQL displays the Output Window as a floating window in the application.

MESSAGES IN THE OUTPUT WINDOW
The Output Window lets you save, print, copy, and clear server messages.

Saving Server Messages
1 Right-click the Output Window and then click Save.

Rapid SQL opens the Save As dialog box.
2 Enter the location and name of the file in the File Name box.

NOTE: Rapid SQL defaults the file extension to .msg.

3 To save the file, click OK.

Printing Server Messages
1 Right-click the Output Window and then click Print.

Rapid SQL opens the Print dialog box.

NOTE: Rapid SQL prompts you with information on the size of the print job before opening
the Print dialog box.

2 Configure your print job.
3 Click OKto print the file.

Copying Server Messages
1 Right-click the target Server Messages and then click Copy.

Rapid SQL copies the selected text to the Microsoft Windows Clipboard.

2 Paste the contents of the clipboard into target applications.

Clearing Server Messages
1 Right-click the Output Window and then click Clear.

Rapid SQL clears your Server Messages.
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BROWSERS

Browsers are a flexible environment where you can examine, extract, and execute database
objects and their dependencies. Browsers provide the means to view objects types across
multiple database platforms and connections. You can simultaneously view and work with
objects from InterBase/Firebird, Oracle, Microsoft SQL Server, Sybase Adaptive Server, and IBM
DB2 LUW for Open Systems.

The benefit of using Browsers is the ability to see detailed information about specific object
types. You can also print, search, copy, and sort the contents of a Browser window.

Topics

Browser Toolbar

Opening Browsers

Browser Object Types

Column filtering in the Browser

Extracting DDL from Browsers

Displaying Dependencies from Browsers

Refreshing Browsers

BROWSER TOOLBAR
You can place the floating Browser toolbar anywhere on the Rapid SQL workspace.

For more information, see Browsers.

OPENING BROWSERS
Browsers let you view all types of database objects, including the SQL procedures used to build
them. Browsers let you:

¢ Copy database objects
* Modify database objects
e Test database objects

The ability to browse dependencies is especially useful, particularly when modifying SQL code in
procedures and triggers. For example, in a situation where a trigger enforces a rule that does
not let you update a particular box, you can use the Browser to do the following:

* Browse the triggers to find the offending trigger.
e Extract the DDL for that trigger into one window.

® In another window, drop the offending trigger, make your update to the box, then execute
the corrected trigger DDL to replace the trigger in the database.
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Opening a Browser Window
Rapid SQL offers two ways to open a Browser:
1 On the Browse menu, click the target object type.
OR
In the workspace, right-click, click Browser, then click the target object.

Rapid SQL opens a Browser.

For more information, see Browsers.

BROWSER OBJECT TYPES

Rapid SQL's Browsers read the appropriate object types for specific databases. A select
statement is issued against the appropriate systems table based on the requested object to
bring back a listing of the objects in the database. The table below contains a list of the
Browsers available for each database platform:

Object Type | DB2 LUW DB2 z/OS InterBase/Firebird SQL Server Oracle Sybase

Aliases

v v v v

Blob Filters

Check

Constraints / / / /

Clusters

Databases

Database
Links

U . N T et

Defaults

Directories

Domains

Encrypted

Keys {

Event
Monitors {
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Object Type

DB2 LUW

DB2 z/OS

InterBase/Firebird

SQL Server

Oracle

Sybase

Exceptions

o

Extended
Procedures

External
Functions

Foreign Keys

Functions

Generators

Groups

Indexes

Libraries

Packages

*

Plans

PL/SQL Code
Profiling

Primary Keys

Procedures

Profiles

Roles

WON O N NN

Rules

Rollback
Segments

v
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Object Type | DB2 LUW DB2 z/OS InterBase/Firebird SQL Server Oracle Sybase

Segments

o

Sequences

Shadows

Snapshots

Snapshot
Logs

Materialized
Views

Materialized
View Logs

Synonyms

Tables

Tablespaces

.
.
.
.
RS N . N . U e e N . O e U S . W B
*

Triggers
v v v v v
Types
Type Bodies
Unique Keys
v v v v
User

Datatypes / /

User
Messages

Users

Views

S e S B W e N

RAPID SQL 8.7.2/XEé6 USER GUIDE 29



APPLICATION BASICS

WORKING WITH BROWSERS

Browsers offer a versatile method of browsing and managing the contents of your databases. To
help you maintain and organize your databases, you can:

® Print the contents of a Browser
e Search the contents of a Browser
e Copy the contents of a Browser

e Sort the contents of a Browser

Printing Browsers

1
2
3

Open a Browser for the desired object type.
On the File menu, click Print to open the Print dialog box.

In the Name box, click the list, which contains a list of local and network printers that you can
access (if you do not see any listed, then your computer is not configured for any printers).

Click the target printer.
In the Print Range box, click the appropriate option button to indicate print range.

In the Number of copies text box of the Copies box, click the Up or Down arrow or enter the
number of copies.

Click OK.

Rapid SQL prints the selection.

Searching Browsers

1
2

o~ o B~ oW

Open a Browser for the desired object type.

On the Edit menu, click Find.

Rapid SQL opens the Find box.

In the Find What text box, enter the search string.

To make the search case sensitive, select the Match Case check box.

To specify the direction to search, in the Direction box, click the Up or Down option button.
Click Find Next.

Rapid SQL finds the next occurrence of your search string.

Copying Browsers

1
2

30

Open a Browser for the desired object type.

Select the objects to copy.
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3 On the Edit menu, click Copy.

4 Place the pointer at the position where you want to paste the objects, and then on the Edit
menu, click Paste.

Sorting Browsers
1 Open or Create a Browser for the desired object type.

2 Double-click the column header for the column of data to sort and Rapid SQL lists the
contents of the column in ascending order.

3 Double-click the column header again and Rapid SQL lists the contents of the column in
descending order.

For more information, see Browsers.

COLUMN FILTERING IN THE BROWSER
Two methods of filtering are available when database objects are displayed in the Browser. Both
make use of the text boxes appearing below column names in the display.

Table Owner Table Name Index Mame

MOVIESL CUSTOMER CUSTOMER_IE1
MOVIESL CUSTOMER CUSTOMER_IEZ
[ElMovVIEST CUSTOMER CUSTOMER_IE3
MOVIESL EMPLOYEE EMPLOYEE_IE1
MOVIESL EMPLOYEE EMPLOYEE_IE2

To show only rows for which a given column value contains one or more contiguous
characters

1 Type those characters into the text box below that column name.

To make use of regular expressions in column filtering

1 Ensure that regular expression usage is enabled. For details, see"Explorer Options - Main
Tab" on page 92.

2 Type avalid regular expression search criteria into the text box below that column name. For
more information, see "Regular Expressions Support in Rapid SOL/DBArtisan" on page 920.

NOTE: The RegEx ON/RegEx OFF button lets you enable or disable regular expression usage
on-the-fly for a given Explorer window.
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EXTRACTING DDL FROM BROWSERS

For each database type, Rapid SQL provides an appropriate Browser. The Browsers are mutually
exclusive object windows, showing only objects of a given type. If you connect to multiple
datasources, you have access to a number of objects that are not available based on the
database platform. Rapid SQL includes intelligence to determine the valid object types in the
underlying datasource.

Using the Main Menu

1 On the Browse menu, click the target object type.
Rapid SQL opens the appropriate Browser:

2 Inthe Browser, double-click the target object type to extract the object type DDL into a DDL
Editor.

Using the Browser Toolbar

1 On the Browser toolbar, click Tables.

Rapid SQL opens the Table Browser:
2 Click the scroll bar arrow to locate the target table.
3 Double-click the target table.

Rapid SQL extracts the schema DDL into a DDL Editor.

Using the Shortcut Menu

1 Right-click an open area of the workspace, click Browsers, and then click the target object
type.

2 Inthe Browser, double-click the target object type.
Rapid SQL extracts the schema DDL into a DDL Editor.

For more information, see Browsers.

DISPLAYING DEPENDENCIES FROM BROWSERS
You can display object dependencies for an object from its corresponding object Browser. Rapid
SQL displays the dependencies in a separate result set window.

Displaying Dependencies
Rapid SQL offers three ways to display dependencies from Browsers:

1 Open a Browser for an object type.

2 Inthe Browser, click the target object.
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3 On the Object menu, click Dependencies.

OR

On the Browser toolbar, click Dependencies.

OR

Right-click the target object and then click Dependencies.
Rapid SQL displays dependencies in a separate window.

For more information, see Browsers.

REFRESHING BROWSERS
Rapid SQL lets you refresh and display the results of a Browser operation.

Refreshing the Browser
1 On the Object menu, click Refresh.

OR

On the Browser toolbar, click Refresh.

OR

Right-click the Browser workspace and then click Refresh.

Rapid SQL refreshes the results of the browser operation.

For more information, see Browsers.

WORKSPACES

Workspaces are a convenient way to maximize your desktop. You can use workspaces to multiply
the amount of scripting, script execution, and development resources you have available at any
one time. Rapid SQL lets you open and use several workspaces at one time. Using more than
one workspace lets you:

e Execute long running scripts in one workspace while working in other workspaces.

* Develop strategies for working on scripts and result sets in one workspace while other
scripts reside in one or more of the other workspaces.

Toggling Between Workspaces

Rapid SQL offers two ways to toggle between workspaces:
1 On the Main toolbar, click Workspace.

OR

Right-click the current workspace and then click the target workspace.

Rapid SQL brings the target workspace forward.
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For more information, see:

Managing Workspaces

MANAGING WORKSPACES
Rapid SQL provides you with three default workspaces. You manage the workspaces in the
Workspace dialog box. Using the Workspace dialog box you can:

¢ Differentiate between workspaces by changing the background color or wallpaper.
¢ Toggle among workspaces.

* Create, delete, rename, and specify the order of workspaces.

Managing Workspaces

The Workspace dialog box lets you manage all open windows in your workspace.
1 On the Windows menu, click Windows.

Rapid SQL displays the Workspace dialog box. Any open windows in the current workspace
display in the list.

The table below describes the options and functionality on the Workspace dialog box:

Option Description

Activate Sets the focus onto the window you have selected in the list
and closes the Workspace dialog box.

OK Closes the Workspace dialog box and accepts any changes you
have made to the windows in the current workspace.

Save Saves the contents of the window you have selected in the list.
You are prompted to provide a name and location for the file
you are saving if you have not done so already.

Close Window Closes the window you have selected from the list. If you have
not saved the contents of the window, you are prompted with a
save file alert.

Help Initiates and displays this Help topic in the Rapid SQL Help.

SET SORT COLUMNS DIALOG BOX
The Set Sort Columns dialog box lets you sort multiple columns, and sort column identification,
in the Right Pane of the application.

For more information, see Completing the Set Columns Dialog Box.
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COMPLETING THE SET COLUMNS DIALOG BOX
To complete the Set Columns dialog box, do the following:

1 In the right pane of the application, right-click a column heading and select Sort Multiple
Columns.

Rapid SQL opens the Set Sort Columns dialog box.

2 In Column Name select the column(s) to use to sort the information in the right pane of the
application.

3 Click the right arrow to move the column(s) to the Column Name box.
4 Click the up and down arrows to change the order of the sort columns.

For more information, see Set Sort Column Dialog Box.

PREVIEW DIALOG BOXES

Before executing any code, Rapid SQL offers Preview dialog boxes to let you confirm actions
before execution. In the Preview dialog boxes, you can:

® Preview the code to execute.

View the SQL of the code on your database.

e Create a report detailing the affect of executing code on your database.

Schedule execution of the code.

Save the code to execute.

e Open your e-mail program with the code to execute as an attachment.

Print the code to execute.

MENUS

Rapid SQL offers two context-sensitive menus to let you access all the application’s features. The
Main Menu is always on the top of the application window. The shortcut menu is accessible from
almost anywhere in the application. Right-click to view the available shortcut menu. Rapid SQL
lets you customize the Tools menu to help you tailor the application to your needs.

Topics

® Main Menu

Shortcut menus

Customizing General User Interface Appearance
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MAIN MENU

Rapid SQL's features can all be accessed from the Main Menu by clicking the menu name and
selecting from the submenu. The menus are context sensitive and change based on the tasks
you want to perform. The table below describes the Rapid SQL menus:

Menu Item Description

File Create, open, close, print, send, and save script files and result
sets. Set application options and defaults.

Datasource Create, modify, select, connect to, and disconnect from
datasources. Access the database search facility.

Project Available only when a project is open. Configure project
management, build projects, and use version control functions.

Browse Browse any object type a datasource connection.

Logdfile Activate/deactivate, open, set options, and flush the Rapid SQL
application log.

View Arrange the Rapid SQL environment. Display or hide the
Database Explorer, toolbars, Output Window, Describe window,
activate full-screen mode.

Tools Choose any of Rapid SQL's tools, such as Database Search and
the Visual Diff Utility. Customize and add tools of your own.

Bookmarks Access and manage bookmarks.

Help Access HTML Help.

Query Available only when an Editor is open. Execute and set options

for your SQL scripts.

Object Available only when a browser is open. Execute, view
dependencies, extract, and refresh objects in a database.

Edit Available only when an Editor is open. Edit and manipulate the
text in your scripts.

Format Available only when a Result Window is active. Format the
contents of result sets.

Window Cascade and tile open windows. Toggle among open windows.

For more information, see Menus.

EXPLORER BOOKMARKS
The Bookmarks menu lets you access and manage explorer bookmarks. Explorer bookmarks let
you quickly access nodes in the Database Explorer.

Creating Explorer Bookmarks

1 On the Database Explorer, right-click the target node, and then select Add Bookmark.
Rapid SQL opens the Add Friendly Bookmark Name dialog box.

2 Type the explorer bookmark name.
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3 Click OK.

Rapid SQL displays the explorer bookmark under the Bookmarks menu. Explorer
bookmarks are organized by platform.

Editing Explorer Bookmarks
1 On the Main Menu, select Bookmarks.

2 Select Bookmark Manager.
Rapid SQL opens Bookmark Manager.

3 To rename the explorer bookmark, select the target explorer bookmark, and then click
Rename.

Rapid SQL opens the Edit Bookmark Name dialog box.
4 Type the new explorer bookmark name.
5 Click OK.
6 To delete an explorer bookmark, select the target explorer bookmark, and then click Delete.

TIP: To add explorer bookmarks without using the Add Friendly Bookmark Name dialog
box, select Do not show ‘Add Friendly Bookmark Name’ dialog option.

SHORTCUT MENUS

Rapid SQL incorporates context-sensitive menus to give you another way to access object
functionality. These menus mirror the functionality that you can access from application toolbars
or the main menu.

Opening Shortcut Menus
1 Right-click anywhere on the Rapid SQL desktop to open the appropriate shortcut menu.

For more information, see Menus.

TOOLBARS

Rapid SQL toolbars change to reflect the element of the application you are using. The toolbars
contain icons that are the fastest way to access commonly used features of Rapid SQL. You can
move the toolbars to horizontal or vertical positions anywhere on the screen, and you can toggle
them off and on by using the shortcut menu when the pointer is positioned over one of Rapid
SQL's toolbars. For more information, see the following topics:

® Available Toolbars

e Using Toolbar Viewing Options
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* Moving Toolbars

NOTE: For related information, see Customizing General User Interface Appearance.

AVAILABLE TOOLBARS
The following list represents Rapid SQL's toolbars:

Datasource Toolbar

| : ? @ DAVE_DW [DAVE_DW 09.01.0000) [~ - ; :

Registration Toolbar

Main Toolbar

FrAHA. eE 6 BEEEY -

Windows Toolbar

windows ]
BEORET

Tools Toolbar

W L

Project Toolbar

BB 10 0a
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SQL Edit Toolbar

B WEEN =W N NN YW o T T T W

Browsers Toolbar

x|
HE & P o

USING TOOLBAR VIEWING OPTIONS

Rapid SQL offers standard Windows toolbar options such as docking, floating, and positioning
toolbars. The only application-specific viewing option is the hiding or display of the individual
toolbars.

To hide or display a toolbar

1 On the View menu, select Toolbars and then select the specific toolbar you want to display
or hide.

For information on the toolbars available, see Available Toolbars.

MOVING TOOLBARS
1 Click the pointer at the right edge of any toolbar.

2 Drag the toolbar to the new position.

For more information, see Toolbars.

CUSTOMIZING GENERAL USER INTERFACE APPEARANCE

Rapid SQL lets you choose from a set of general visual application styles, dictate hiding or
display of particular items, and select preferences for specific user interface elements.
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To customize the general look and feel of Rapid SQL

1 On the View menu, select Toolbars and then select Customize. The Customize dialog

opens.

2 Use the following table as a guide to understanding and setting options on tabs of the
Customize dialog:

Tab

Settings and tasks

Toolbars

Select the toolbars you want to display in the application. For information on the toolbars
available, see Available Toolbars.

Application Visual
Style

Select a visual style such as Microsoft Windows XP or one of the .NET options from the
dropdown. Depending on your selection, the following options may or may not be enabled:
Use default Windows XP colors, OneNote style tabs, Docking Tab Colors, Allow MDI Tab
Swapping, Enable Smart Docking, Enable Tab Menu, and 3D Rounded Docking Tabs.

Lets you specify a menu animation style of UNFOLD, SLIDE, or
FADE.

Menu animations

Menu Shadows Displays shadowed 3D effects.

Tools Lets you define external applications to run from the Tools menu of Rapid SQL: the text
displayed on the Tools menu command (Menu contents), the path and file name of the
executable (Command), optional Arguments, and an optional Initial Directory.

For detailed information on providing arguements, see Specifying an Argument for a Tools
Menu Command.

Keyboard Category Select a general category for a hot key for the command.
Commands Select a hot key command, based on the general category.
Description Displays the command description.

Set Accelerator for Select application area where you want new hot key to be active.
Current Keys Displays current hot key.
Press New Shortcut Press keyboard key or an unassigned F key.
Key
Options Show ScreenTips on Select to display a ScreenTip when you hover your mouse over a

button. For example, when you hover your mouse over the New
button, Rapid SQL displays the ScreenTip “New.”

toolbars

Select to display a shortcut key in the ScreenTip when you hover
your mouse over a button. For example, when you hover your
mouse over the New button, Rapid SQL displays the ScreenTip
“New (CTRL+N).”

Show shortcut keys in
ScreenTips

3 Click Apply at any time to implement any changes you have made and when finished, click

Close.

SPECIFYING AN ARGUMENT FOR A TOOLS MENU COMMAND

You can specify an argument to be passed to a program for newly added commands by
choosing one of Rapid SQL's predefined arguments or entering a command-line argument.
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The table below provides scenarios of how to use command-line arguments:

Command

Argument

Description

NOTEPAD.EXE

$$FilePath$$

Starts Microsoft Notepad displaying
the contents of the $$FilePath$$
argument.

ISQL.EXE

-U$$CurUserID$$ -P$$CurPwd$$
-S$$CurConString$$ -
i$$FilePath$$

Starts ISQL, automatically connects
to the current datasource using the
current user name and password,
and executes the contents of
$$FilePath$$.

SQLPLUS.EXE

$$CurUserlD$$/
$$CurPwd$$@$$CurConString$$
@$$FilePath$$

Starts SQL*Plus, connects to the
current datasource using the current
user name and password, and
executes the contents of

$$FilePath$$.

The table below provides scenarios of how to use Rapid SQL's predefined arguments:

Argument Description

$$FilePath$$ The complete filename of the current source (defined as
drive+path+filename); blank if a non-source window is active.

$$FileDir$$ The directory of the current source (defined as drive+path); blank if
a non-source window is active.

$$FileName$$ The filename of the current source (defined as filename); blank if
the non-source window is active.

$$FileExt$$ The filename extension of the current source; blank if a non-source
window is active.

$$CurLine$$ The current cursor line position within the active window.

$$CurCol$$ The current cursor column position within the active window.

$$CurText$$ The current text (the word under the current cursor position, or the
currently selected text, if there is one).

$$CurDir$$ The current working directory (defined as drive+path).

$$CurDatasource$$ The name of the current datasource as defined in Rapid SQL.

$$CurUserID$$ The name of the current datasource user.

$$CurPwd$$ The current datasource password.

$$CurConString$$ The current connection string or server name.
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PREDEFINED ARGUMENTS
Rapid SQL provides a number of predefined arguments that you can pass to programs that you
have added to the Tools menu. The table below lists the available predefined arguments:

Argument Description

$$FilePath$$ The complete filename of the current source (defined as
drive+path+filename); blank if a non-source window is active.

$$FileDir$$ The directory of the current source (defined as drive+path); blank if
a non-source window is active.

$$FileName$$ The filename of the current source (defined as filename); blank if
the non-source window is active.

$$FileExt$$ The filename extension of the current source; blank if a non-source
window is active.

$$CurLine$$ The current cursor line position within the active window.

$$CurCol$$ The current cursor column position within the active window.

$$CurText$$ The current text (the word under the current cursor position, or the
currently selected text, if there is one).

$$CurDir$$ The current working directory (defined as drive+path).

$$CurDatasource$$ The name of the current datasource as defined in Rapid SQL.

$$CurUserlD$$ The name of the current datasource user.

$$CurPwds$$ The current datasource password.

$$CurConString$$ The current connection string or server name.

NOTE: Arguments are case-sensitive.

KEYBOARD SHORTCUTS

Rapid SQL provides a number of keyboard shortcuts to help you expedite your tasks. The table
below lists the taxes and related shortcuts:

General Editing Keyboard Command
Delete one character to the left BACKSPACE

Delete one character to the right DELETE

Cut selected text to the Clipboard CTRL+X

Undo the last action CTRL+Z

Redo the last undo operation CTRL+Y

Copy text CTRL+C

Paste the Clipboard contents CTRL+V
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To Extend a Selection

Keyboard Command

One character to the right

SHIFT+RIGHT ARROW

One character to the left

SHIFT+LEFT ARROW

To the end of a word

CTRL+SHIFT+RIGHT ARROW

To the beginning of a word

CTRL+SHIFT+LEFT ARROW

To the end of a line

SHIFT+END

To the beginning of a line

SHIFT+HOME

One line down

SHIFT+DOWN ARROW

One screen up

SHIFT+PAGE UP

To the beginning of a document

CTRL+SHIFT+HOME

To the end of a document

CTRL+SHIFT+END

To include the entire document

CTRL+A

To Move the Insertion Point

Keyboard Command

One character to the left LEFT ARROW

One character to the right RIGHT ARROW

One word to the left CTRL+LEFT ARROW
One word to the right CTRL+RIGHT ARROW
One line up UP ARROW

One line down DOWN ARROW

To the end of a line END

To the beginning of a line HOME

One screen up (scrolling) PAGE UP

One screen down (scrolling) PAGE DOWN

To the end of a document CTRL+END

To the beginning of a document CTRL+HOME

Bookmarks Keyboard Command
Toggle bookmark on/off CTRL+F2

Go to next bookmark F2

Go to previous bookmark SHIFT+F2
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Splitter Windows

Keyboard Command

Go to next pane

F6

Go to previous pane

SHIFT+F6

Debugger Operations Keyboard Command
Start Debugging CTRL+F5

Stop Debugging SHIFT+F5

Step Over F10

Step Into F11

Run to Cursor CTRL+F10

Step Out SHIFT+F11

Describe from Cursor CTRL+D

Insert or Remove Breakpoint F9

Toggle (Enable or Disable) Breakpoint CTRL+F9

Edit Breakpoint ALT+F9

Go F5

Restart CTRL+SHIFT+F5
Debugger Windows Keyboard Command
Open or Close Watch Window ALT+3

Open or Close Variables Window ALT+4

Open or Close Call Stack Window ALT+5

Open or Close Dependency Tree Window | ALT+6

ISQL Window.

Other Windows Keyboard Command
Go to the Result Tab CTRL+ALT+R

Go to the Query Tab CTRL+ALT+Q

Open the Describe window (for highlighted | CTRL+D

object)

Toggle between Workspaces CTRL+W

Toggle between Datasource Explorer and | CTRL+ALT+E
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FULL SCREEN MODE

Rapid SQL has full screen mode capabilities so you can conceal the application framework and

use the entire monitor area. Full screen mode hides any other applications running on the
computer and uses every available pixel for the application. Main menu functionality is
accessible through keyboard commands when you use full screen mode.

Activating Full Screen Mode
Rapid SQL offers two ways to activate full screen mode:

1 On the View menu, click Full Screen.

OR
On the Main toolbar, click Full Screen.

Rapid SQL expands the application to fit the entire monitor area.

NOTE: The Full Screen mode icon is a stand-alone floating toolbar.

Dismissing Full Screen Mode
1 Click Full Screen to expand the application to fit the entire monitor area.

TIP:  Ifyou closed the Full Screen mode toolbar, right-click the top of the Rapid SQL desktop
to bring the toolbar back.

2 Click Full Screen to restore the application to the default size.

RAPID SQL 8.7.2/XEé6 USER GUIDE

45



APPLICATION BASICS

46 RAPID SQL 8.7.2/XE6 USER GUIDE



RAPID SQL TUTORIAL EXERCISES

RAPID SQL TUTORIAL EXERCISES

The exercises that follow walk you through Rapid SQL's major functional areas. After completing
these exercises, you will have the foundation you need to explore the many features and
benefits of Rapid SQL. You'll have learned how to competently manage the major database
administration and development tools provided.

This guide is divided into a set of sessions:

e Session 1: Getting Started

e Session 2: Productivity Enhancers

e Session 3: Scripting

e Session 4: Working with Code Workbench

e Session 5: Building a Database Project

e Session 6: Visual Query Builder

e Session 7: Live Data Editor

e Session 8: Code Analyst

e Session 9: SOL Debugging and Profiling

You can use this basic tutorial as a roadmap of product highlights, but also to help you find your
own path to explore Rapid SQL.

Once you've started, you can select Help Topics from the Help menu to find many additional
resources that complement and build on many of the activities shown in this tutorial.

NOTE: The tutorial exercises make use of the sample SQL Server database, AdventureWorks.
Since this is not part of a typical install, you can obtain the files from installation CDs or
online sources to install and attach that database. Alternatively, you can perform the
tasks targeted for the AdventureWorks database against another available database.
No destructive actions are initiated in the exercises.

SESSION 1: GETTING STARTED

Before anything else, you must perform the following tasks:

e Starting Rapid SOL

e Registering Cross-Platform Datasources

STARTING RAPID SQL
How you start Rapid SQL depends on the type of application you are evaluating:
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* InstantOn version - start the application by double-clicking the file you downloaded.

e Fully-installed version - The Start menu sequence for Rapid SQL is always in the form
Programs > Embarcadero Rapid SQL version identifier > Rapid SQL version identifier,
where version identifier reflects the version you are running.

To get started
1 Run Rapid SQL.

The first time Rapid SQL starts, a dialog opens, prompting you to set up datasources. In
addition to letting you manually set up individual datasources, a number of more
automated methods are available. If you have installed and used other Embarcadero tools,
Rapid SQL can find any active datasources being used by those tools. In addition, Rapid
SQL provides a Discover Datasources feature that automatically searches the DBMS
configuration files on your system for datasources that are not currently registered. Since
other Embarcadero tools let you export datasource definitions to file, you also have the
option of importing these definitions.
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2 For the purpose of this tutorial, click Cancel. You will be registering a datasource manually.

The main Rapid SQL window opens.

Application Workspace

Datasource Navigator Datasource
Datasource Group Toolbars
I
File Datagource Browse Logfjle View T%nls Window Help
hedPRARERP LGN
ML LT Lk
"EBE&D &L
: = | [Mo Datasource Selected] =
Datasource N;:rigat::ur X
Al@ &
[ DB2 Servers =

Interbase-Firebird Servers
[ JDBC Servers

[ MS SQL Servers

3l MySOL Servers
My_Custom_Group
Oracle Servers

T Filters
+}b Check Constraints
op Clusters

% Database Links

m

-

£l ROMLABORCL11g_2 (Oracle 11.1.0.7.0)
£l ROMLABORCL11g 3 (Oracle 11.2.0.1.0)

WEALA|A A NE
(mllER=NE]

1
Iffl

11

4

REGISTERING CROSS-PLATFORM DATASOURCES

For now, you will register a datasource manually.

1

On the Datasource menu, select Register Datasource. A Datasource Registration Wizard

opens.

Choose Microsoft SQL Server as the DBMS type and then click Next. The next panel

opens.
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Register Datasource @

Information [ .ﬂj
Pleaze enter the connection infarmation far the SEL Server. ['u e

Database Type

istrati - i - | Uze Encroption
e e e R egistration type: |L|ser defined | [Tl g
Security Parameters Pratacal: o TCRAR (1 Mamed Pipes
Custom Driver Properties
i Hioszt: || - ||
Datasource Properties
Datazource Group Part [aptional]:

Default OB [optional):

D atasource Mame; | = ||

T ezt Connection < Back i [=r e Finizh Carnicel Help

3 Ensure that a Registration type of User defined is selected, specify the Host name of an
SQL Server datasource on your network, override the Datasource Name with
SAMPLE_DATASOURCE and then click Next.

4 Provide valid credentials in the User ID and Password boxes, and then select the Auto-
Connect? checkbox to eliminate having to provide credentials each time you connect to this
datasource.

5 Inthe left-hand pane, select Datasource Group, select the MS SQL Server folder, and then
click Finish.

NOTE: The Datasource Group panel also lets you assign a category to a datasource. This
provides a means to visually distinguish between different server purposes,
development vs. production, for example, in your enterprise. Categorization is a
customizable feature.

6 Select Yes when prompted to connect to the new datasource.

Rapid SQL offers the same easy-to-use Datasource Registration Wizard for all supported DBMS
platform connections. The connection information only needs to be set up one time for each
platform and can be saved locally or in a common datasource catalog for use by other
Embarcadero products.

By default, Rapid SQL stores datasource definitions in the Windows Registry. There is also a
local, file-based option. Embarcadero products supporting these methods can share datasource
catalogs on the same machine.

There is also a network-shared storage option. Lastly, datasource definitions can be stored
centrally on an Embarcadero DB Team Server for use by Rapid SQL users.
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Rapid SQL also offers the ability to import and export datasource definitions. This lets you share
definitions among users and across datasource storage methods.

SESSION 2: PRODUCTIVITY ENHANCERS

This session focuses on some commonly used time-saving features:

e The Datasource Navigator Tree

e Creating an Object Using the Object Creation Wizard

o Working With an Existing Object Using the Object Editor

e Object Documentation and Reporting

e \Working With Code, Files and Data

e Setting Environment Options

e Favorites Tab

* \Working with Scripts and Files

¢ Viewing Data

e Retaining Datasource Navigator View Settings

e Datasource Navigator Bookmarks

o Setting Keyboard Shortcuts and Hotkeys

o Referencing Most Recently Used Datasources
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THE DATASOURCE NAVIGATOR TREE

Rapid SQL makes it easy and intuitive to navigate between datasources and to drill-down into
atomic database objects within the Datasource Navigator tree. The Datasource Navigator
displays all registered datasources and serves as the entry-point for much of Rapid SQLs
advanced functionality.

1 Click on the Navigator's dropdown and ensure that Organize By Object Type is selected.

Datasource Mavigator X

P @ -{!%
[CT1 DB2 Servers Organize by Object Type
[C71 Interbasze-Firebird Servers
[CT1 JDBC Servers
1 MS SOL Servers Full Refresh

Efm SAMPLE_DATASOURCE

Show System Cbjects 4

Expand All Groups
Collapse All Groups

Collapse All Datasources
Retain View Settings

Bookmarks 4

2 Select and expand the SAMPLE_DATASOURCE > Databases > AdventureWorks node to
display the database object sub-nodes.

[ AdventureWforks
& Check Constraints
#* Datahase Security
[J] Database Triggers
il Defaults

22 Fareign Keys
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CREATING AN OBJECT USING THE OBJECT CREATION WIZARD

From within the Navigator tree you can create any database object using simple Object Creation
Wizards. The following is an example of how to use the Table Object Creation Wizard. It is
similar to the Object Creation Wizards available within Rapid SQL for all database objects and
other supported elements.

1 Right-click on the Tables node and select Create. A Create Table Wizard opens.

.

Create Table Wizard - Step 1 of 6 a @
Properties
Specify the kable properties,
Bioperkes Property Walue

=l Creation
Schema -
Mame
AMS|_MULLS option F

= Phyzical Storage
Partitionzd ]
Filegroup FG_ReadQnly b
Text Image Filegroup FG_ReadOnly -

Cancel | | Help

2 Select a Schema and provide a Name of SAMPLE_TABLE. Leave the remaining default
settings and click Next.

3 Add a column, using a Name of Sample_Column1 and select a Type of char. Experiment
with the Add Column and Delete buttons, and with selecting a column and modifying its
attributes.

4 Click Finish. The DDL View panel opens showing the DDL that will be used to create the
new table.

5 Deselect the Launch Object Editor After Execute and then click Execute.

Rapid SQL builds the platform-specific SQL code, syntactically-correct and ready to run the first
time. There is no SQL coding required in any of the Rapid SQL Object Creation Wizards.
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WORKING WITH AN EXISTING OBJECT USING THE OBJECT EDITOR

While the wizard offered you the option to automatically open an editor on creating the table,
you can also manually open an editor.

1 In the Navigator, ensure that the Tables node is expanded and then right-click on your new
table and select Open.

Columns |
ah Add Column ~ & Delste
# Mame Tvpe Mull | Default Bighsity Value
I sample...  char(l) i = Column Attnbutes [
M ame Sample_Colurmnd ]
Computed ]
= Dratatype
Type char -
Size 1
Allovs Nulls

Sparze Column il
Drefault Collation SOL_Latinl_Gen_.=

Default W alue x

= Bindings
Drefault Binding -
Rule Binding T ™

Object Editor features are as follows:

All Object Editors provide standardized, multi-tabbed windows for each database object
type.
All Object Editors provide fully-functional toolbars for easy object management.

Rapid SQL has full knowledge of the underlying DBMS system catalog, syntax and
alteration rules, so the user can concentrate on what needs to be done, not on how to do
it.

Drop-down boxes allow you to easily move between owners and objects.

The Rapid SQL Object Editors easily perform operations that would normally require
painstaking and error-prone scripting, such as deleting or inserting columns in a table
while preserving data, dependencies and permissions. Rapid SQL analyzes the database
catalog to determine its structure, and then automatically generates the SQL script
required for the extended alteration. For instance, when a full table alteration is required,
Rapid SQL automatically unloads and reloads the data, eliminating tedious work.

2 Close the Object Editor window.
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OBJECT DOCUMENTATION AND REPORTING

Rapid SQL provides rich, detailed HTML Reporting for all database objects. Building a browser-
ready report for any object is only a few mouse-clicks away.

1 Expand the Tables node, right-click on any table and select Report from the menu. A
Report dialog opens.

2 Enter a destination Report Home Page File Name. This can be a network web server
directory.

3 Enter a Report Title and click Execute.

The HTML report will automatically be displayed in the Rapid SQL application workspace.
For example:

dbo.SAMPLE_TABLE

Object Type Tahle

Datasource ROMLABSCLDS 1 ( S0L Server 09.00.3073 )
Login 53

Database Adventureborks

Report Date FI23020M2 17:28:27 894

Columns

Name Datatype Null Default | Default Binding

sample_Column char(1) Yes

The HTML report can be saved to a new file or referenced in the file named above.

NOTE: All HTML reports are browser-ready and suitable for posting directly to the web.

WORKING WITH CODE, FILES AND DATA

Rapid SQL provides many features and powerful development tools for creating and executing
SQL code and working with data.

NOTE: For purposes of this exercise, we are only covering high-level functionality of the major
features and tools within Rapid SQL.
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SETTING ENVIRONMENT OPTIONS

The Options dialog allows you to set the Rapid SQL development environment to meet your
needs.

1 Select File > Options from the menu. The Options dialog opens.

Dakasource
i lagnesdl ! D atazource Storage M anagement

Conneckion

Java {#1wWindows Registy datasource catalog

Logging Legacy datasource storage that iz compatible with previous wversions of Embarcadera

SMTP Mail FIEEL e

Petf Center {_JFile bazed datasounce catalog

ERStudio Partal Datazources are stored in the current uzer's application data folder.

Reports i Wetwork, shared datasource catalog

Explorer D atazources are located in a common resource that iz shareable between multiple uzers
+-I90L Datazource changes are not propagated to other uzers and are naot retained between
% Debug inztances of thiz application.
+- DOL Extract Location of shared managed datasources file;
+- Results =

arid Propetties

Browsers : .

; FRecent D atazource List Containg: 8| Datazources [1-32)

Wersion Control

Warnings Re-zart the D atazource Combo bazed on Connection state

Data Transfer [ 1Default to Alias zage When Defining Mew D atasources

Cracle Utilities 5 e o

MySaL Utilities atazource Categon Sethings

Direckories Color the ztatus bar uzing the datasource's cateqgaony color

blag Edlt'_:'r Color the tabs using the datasource's categon color

Cuery Builder _

DEMS JAYA |nclude categaory short name in the datasource toalbar combo

Code Analwsk

The Options dialog has one page per option category. Select an option category in the left-
hand pane and you can subsequently set options on that page. Options are applied when you
click OK.

2 Close the Options dialog.

FAVORITES TAB

The Favorites Explorer provides a drag-and-drop library interface of all supported DBMS syntax,
SQL syntax, built-in functions, optimizer hints, and SQL-conditional syntax. Additionally, it
provides the ability to create custom folders to store commonly-used code for quick and
efficient access, as needed.
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To open the Favorites Explorer:

1 Select View > Favorites. The Favorites window opens.
2 Expand the Microsoft node and then expand the Schema sub-node.

3 Right-click the Procedures node and select Open. The selected code opens in the SQL
Editor window and is ready for execution.

4 Right-click in the editor window and select Close from the context menu.

To add a custom folder to the Favorites Explorer
1 Right-click the Favorites > Schema folder.

2 Select New Folder from the menu. A new folder is added to the bottom of the Schema
folder.

To close the Favorites Explorer:
1 Select View > Favorites.

WORKING WITH SCRIPTS AND FILES

Rapid SQL extends the auto-generation of SQL code by allowing you to run your scripts across
multiple databases at the same time.

FILE EXECUTION FACILITY

Files containing SQL scripts can be added to the File Execution Facility and executed
immediately or scheduled to run later.

1 On the Tools menu, select File Execution Facility. Rapid SQL opens the File Execution
Facility dialog box.

2 To locate the file you want to execute, click Add. Use the Add Files dialog box to locate and
select a file.

3 On the Target tab, select the datasources to run the script against.

4 On the Output tab, select the desired output option. For the purposes of this example,
select Graphical Output.

NOTE: To enable the scheduling function for the script, you must select the File Output
option.

5 If you want to send notification that the script has executed, on the Notify tab, complete the
target information.
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6 Click Execute if you want Rapid SQL to run the script against the target datasources.
Otherwise, close the dialog without executing.

NOTE: Separate script output windows are created for each selected datasource.

SCRIPT EXECUTION FACILITY

The Tools menu also offers a Script Execution Facility. Similar to the File Execution facility, it lets
you type or paste the script to be executed.

VIEWING DATA

Rapid SQL provides several options for browsing data. In addition, it gives you the ability to
construct even the most complex SQL statements with point-and-click ease.

SELECT * BROWSING
1 On the Datasource Navigator, expand the MS SQL Servers node.

2 Expand any database you know has table data, expand the Tables node, right-click a table,
and then click SELECT * FROM.

All columns and rows from the table are displayed in the active workspace.

3 Close the workspace window.

RETAINING DATASOURCE NAVIGATOR VIEW SETTINGS
1 Click on the dropdown at the top of the Datasource Navigator.

COrganize by Object Owner

Show System Objects k|
Sho Qnly My Objects L8
Full Refresh

Expand &ll Groups
Collapse All Groups

Collapse All Datasources

Retain View Settings

2 Select Retain View Settings.
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The Navigator will open the next time just as you left it. All connections that were present when

you closed Rapid SQL will be re-established.

DATASOURCE NAVIGATOR BOOKMARKS

Rapid SQL allows you to set bookmarks for frequently visited database objects.

1 Right-click on any node in the Datasource Navigator.

B
B
i
i
B
i
B
e
8
&
B
i
B
i

|

ADM
ADME

cLal
LA %
CLAL My

| HTHIL

CLAL

CLAL &

CLA!
cLal

CLAL
DE2/

Add Bookmark

{ MNew...

Cpen
Drop...
Report...

Debug...

Compile...

i Extract

:; Describe

Execute

2 Select Add Bookmark and use the Add Friendly Bookmark Name dialog to optionally

provide a new name, and create the bookmark.

After Bookmarks are defined you can use them to easily navigate to commonly used
datasource resources. In this case, you would select the dropdown at the top of the
Datasource Navigator, selecting Bookmarks > SQLServer and then selecting the bookmark
you just created.
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Datasource Mavigator ox

[2) DB2 Servers DOrganize by Object Owener
[C1 Interbase-Firehird Servers
1 JDBC Servers

[ M5 SOL Servers

Showe System Objecks k
Showe Orly My Objects k

3 MySQL Servers Full Refresh

= by_Custom_Group

31 Oracle Servers Expand &Il Groups
[ Servers Collapse All Groups

E] Sybase Servers Collapse All Datasources

Fetain YWiew Settings:

Bookmarks L4 Bookmark Manager...

The Bookmark Manager handles maintenance of Bookmarks.

3 Select the dropdown at the top of the Datasource Navigator and then select Bookmarks >
Bookmark Manager.

Bookmark Manager

Bookmark.z; Filker: |

B4 SALServer
LI dbo.procTable : Procedures (& pubs ROMLAESOLOS 2

D Help

[ 100 not show '4dd Friendly Bookmark Name' dialog. « OK # Close

4 Close the Bookmark Manager dialog.

SETTING KEYBOARD SHORTCUTS AND HOTKEYS

1 On the Tools menu, select Customize.

2 In the Customize dialog, go to the Keyboard tab.
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- -
Customize
| Toolbars | Tools 0 phions ..-i'-.pplicatinn Wizual St_l,lle| K.eyboard
Categony: Set Adccelerator for: 2
I T I r
| File |v] | Default |vJ r::'.j
Commands: Current Keps:
T (] Besien
Active Script = :
Cloge e
Cloze Project R emase

Cloze Verzion Contral Filrv;
Ml F ditar |

Press Mew Shortout Key: Reset Al

Dezcription:

Cloze

The Keyboard tab can be used to set keyboard shortcut hotkeys for all areas of Rapid SQL
functionality.

3 Close the Customize dialog.

REFERENCING MOST RECENTLY USED DATASOURCES

1 Select File > Recent Datasources and then select a datasource.

| Recentrgatasaurces l'*| | 1 TORLABSQLOS 1
= 2 TORLABSQLOS_ 2
3 SAMPLE_DATASOURCEL
4 TORLABSQLO5 9
L TORLABSQLOB_ 1
6 TORLABSY15_ 2
7 DALLASS
8 ROMLABSQLO5_1

| Recent Projects

Recent Eiles [ 4

Exit

This will automatically place you on the datasource within the Navigator, ready to work with
active connection.

SESSION 3: SCRIPTING

This session looks at Rapid SQL's development environment:
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Generating Code

Right-click feature

Automated error detection and coding assistance

Other coding aids

GENERATING CODE

By providing several code generation and assistance options, Rapid SQL makes cross-platform
development easy for developers of all experience levels.

NOTE: The following examples build on the SAMPLE_DATASOURCE registered earlier in this
Evaluation Guide. These examples can be applied to any registered datasource for any
of the supported platforms.

CODE GENERATION FACILITY

The Code Generation Facility can be used to create complete procedures, functions or
packages revolving around views or tables.

1 From the menu, open Tools > Code Generation Facility.

2 Select the SAMPLE_DATASOURCE datasource, the AdventureWorks database, and the
Purchasing schema from the dropdown list boxes.

| 8 SAMPLE_DATASOURCE (SOL Server 09 | =

| ] adventurewaorks -

= |
! Purchasing il

3 Select the Vendor table, Name as the input column and all columns for output.
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DEIECT | 07 pMOre WRere LIause LOoIumns

Productfendor —
PurchaseQrderDetail Nam:j T |_T-'t"pe |rrju"at"l't-"' |
endor i o
EE{;;Z?E?HHEME[ AccountNumber Accounthlum... Mo
T ¥ :Name Name No
nnrdress | CreditR ating tinint Ho
PreferedvendarsStatus Flag Mo
WendorLontact ActiveFlag Flag Hao
PurchazingwebSericelRL  rvarchar[1024) Yes
ModifiedDate datetime Mo

Select 1 or Maore Output Columns

M arme | Tope | Hullability |
v YendorlD int Ho
v AccountNumber AccountM... No
v Mame Hame Ho
v| CreditR ating tinyint Mo
v| Preferred¥endorStatus Flag Mo
v ActiveFlag Flag Mo
¥ PurchazingwebServic... nvarchar[l... Yes
v ModifiedD ate datetime Mo

4 Select Select as the code option.

Generate
Obiject Type;

¥ Select

| Inzert
| Update
| Delete

5 Select a file to save the generated script and check Open.

Provide an Output File M ame

File: |:|

[“]0pen [ ]Execute lmmediately

6 Click OK and the DDL to create the procedure will be generated and displayed in an
editable window, called the DDL Editor. You can edit the name of the new procedure and
any of the generated code at this time. Name the new procedure sample_select_vendors.

7 Click on the Execute button to submit the DDL and create the procedure.

b
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The indicated file will be saved on the selected directory.

NOTE: No SQL statement coding is required to generate complete stored procedures and
packages. If applicable, Rapid SQL allows all generated code to be previewed and
edited to fit any development need.

RIGHT-CLICK FEATURE

Similar to the Code Generation Facility, the “right-click” code generation feature can be used to
create complete procedures, functions or packages revolving around views or tables.

1 From the Datasource Navigator tree, expand the SAMPLE_DATASOURCE >
AdventureWorks > Tables sub-node.

2 Right-click on the Vendors table.

: Purchasing.Wendaor

: Purchasing.Mendord, e,

- Purchasing.WendorC Triggers...

» Sales ContactCreditd Generate - ProTedi v —
; Sales.CountryReqion &4 Liscoppedt SR § -
; Sales. CreditCard

- Sales.Currency Refresh Update...
; Sales.CurrencyRate Eilter... Delete..,

3 Select Generate > Procedure > Select.
4 Select Name as the input column, and leave all output columns selected.

5 Click OK and the DDL to create the procedure will be generated and displayed in the DDL
Editor. You can edit the name of the new procedure and any of the generated code. Name
the new procedure sample_select_vendors2.

6 Click on the Execute or Step Execute button to submit the DDL and create the procedure.

b

AUTOMATED ERROR DETECTION AND CODING ASSISTANCE

Rapid SQL provides a range of features that detect or help you avoid errors and save keystrokes
in developing your scripts.

To enable these features:
1 On the File menu, select Options. The Options dialog opens.

2 Inthe left-hand pane, expand the ISQL node and then select Code Assist.
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3 On the Code Assist panel:
e Ensure that Enable Code Complete is selected.
® Ensure that Severity levels for semantic validation problems has Warning selected.

e Ensure that Enable Real-time syntax checking is selected.

4 Click OK.

To see these features in action:
1 On the File menu, click New, and then SQL.

Rapid SQL opens the SQL Editor window. You can add SQL code via your method of choice
(free-form typing, retrieve from a file, paste copied code, etc.).

=% - b O & h-O >k AaRal A
1 SELECT * FROM Purchasing. Vendor
2
tAuto Commit Off CUA WTORLABORCLIOQ 2system
D Explorerl %EE] S0L1 * - \TORLABORCL10g Nsystem X ﬂ

2 Type SELECT * FROM and stop typing.

Note the error condition.
1 SELECT * FROM

Rapid SQL can run a syntax check any time there is an interval of 1.5 seconds between
keystrokes. You can also disable automatic syntax checking and only run a check when you
manually initiate it. Syntax error annotation persists until you correct the problem.

3 This time type a fragment that includes the name of a nonexistent object, SELECT * FROM
NON.OBJECT, for example. For now, ignore any popups. The warning condition is a result
of on-the-fly semantic validation.

1A SELECT * FROM NON.OBJECTl

Rapid SQL notifies you when a script contains a reference to an object that Rapid SQL
cannot resolve.

4 Type SELECT * FROM followed by a space and then stop typing. If no popup appears, press
CTRL+SPACE. The Code Complete suggestion box lets you select from objects or object
name components such as databases or schema. This feature saves keystrokes and
minimizes typing errors. See the online Help for full descriptions of these features.

5 Close the current SQL Editor window.
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SESSION 3: SCRIPTING

1 On the File menu, select Options. The Options dialog opens.

2 On the Code Assist panel, click the Restore defaults button.

3 Click OK.

OTHER CODING AIDS

Rapid SQL provides extensive, easy-to-use coding aids for all of the supported DBMS platforms,
throughout the application. Aids are provided in the form of ready-to-use code templates and

blocks of syntactically correct code

PASTE SQL

1 From the Datasource Navigator tree, expand the SAMPLE_DATASOURCE >

AdventureWorks sub-node.

2 Select File > New > SQL to open an SQL Editor window.

3 Select Edit > Paste SQL Statement to open the Paste SQL window.

4 On the Paste SQL dialog, select Sample_Datasource from the Datasource dropdown,
AdventureWorks from Database, All Owners from Owner, and an Object Type of Tables.

B Paste 3L

Dbiect Type | Tables

Datssource | SAMPLE_DATASOURCE | - |
[

Databasze |.ﬁ.dventure'-.-'-.-'|:|rks = |

Carier !.ﬁ.ll Cuaners o |

fo e |

Tablez

Purchasing. PurchaseQrderHead:
Purchasing, ShipMethod
Purchasing, Yendar

Purchasing. YendorAddress
Purchasing. Yendor Contact
Sales, ContactCreditCard

Sales, CountryRegionCurrency
Sales. CreditCard

Sales, Currency

Sales. CurrencvRate
4| 11}

s

Cancel
Help
i@ Select ) Update ) Inzertt (0 Delete
SELECT Statement
1

Faste Tables AL
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In the Tables list, select Purchasing.Vendor.

5
6 Under the Columns list, click ALL.
7 Click the Select radio button.

8 Click Paste Statement to copy the generated code to the SQL Editor window.

You can use the statement as is, or modify the code as needed.

PASTE SQL SYNTAX
1 Select File > New > SQL to open a fresh SQL Editor window.

2 Select Edit > Paste SQL Syntax to open the SQL Syntax for SQL Server window.

X 0L Syntax for 30L Server = | [=] |%
SOL Statements: Suntas: .

= 5QL Syntax « |1 1 IF Boolean_expression

= = 50L Commands . 2 {sg_statement | statement_block’

. :|.1'|

alter database

alter table

beqgin distributed transaction
Case expression

checkpairk

beqin...end

gato Label

iF...else v

2 [ELSE [Boolean_expression]
4 {sqg_statement | statement_block} ]

Paste LCancel Help

3 Select a template and click Paste to copy the code template into the SQL Editor window.

4 Add your own code to complete the needed operation.

SESSION 4: WORKING WITH CODE WORKBENCH

The Code Workbench lets you configure resources for two SQL Editor features:
e Code Templates
e Auto Replace

Code templates are complete code blocks that can be easily added to open windows or scripts
with a few keystrokes. When you type CTRL+SPACE, the Code Assist menu opens, letting you
select a code template for insertion in the editor window.
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Loop - Loop expression
EEF_ELSIF - If ElzelF Statement §
curzar_far - Cursor Far Loop %
for_loop - For Loop E=pression

s | E3
e | -l bbb @G & -6
1 @ HIF <condition» THEN
2 “gtatementsl;
Z® | ELSIF <condition>
4 <gtatementsl:;
5@ “ELSE <statements>;
= END IF;:

Auto Replace lets you define shortcuts consisting of a few characters that represent longer
character strings. Instances of these Auto Replace expressions are automatically replaced by the
replacement string on activation events such as typing SPACE, TAB, or RETURN. This feature is
useful for creating shortcuts for one-line commands or SQL statement subsets, or even to detect
and fix common typographical errors such as teh for the.

For example, consider an Auto Replace definition with an expression of sel to represent
Select * From:

1® zeal

If the associated activation event includes a SPACE, then on typing sel followed by pressing
SPACE, the following replacement occurs.

=T L b b O

1® select * from

Rapid SQL loads a default set of Auto Replace and Code template definitions at startup, but you
can also add, edit, and delete definitions. In addition, you can save sets of definitions to file and
subsequently load specific sets of definitions, allowing you to customize your templates to
different platforms or development projects.
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To invoke Code Workbench settings:
1 Select Tools > Code Workbench.

Code Warkbench

Settings | Auto Replace  Code Templates

Auto Replace

[VEnable futo Replace [ | Replace substings

Code Templates

[¥]Enable Code Templates Edit Hat Keys

Impart Settings Export S ettings Fiestore Setting: - F, . Cancel Help

The Settings tab lets you enable the Auto Replace and Code Template features.
2 Inspect the Code Templates and Auto Replace tabs.
3 Click OK.

SESSION 5: BUILDING A DATABASE PROJECT

Rapid SQL provides an excellent team development environment by allowing you to reverse
engineer live database objects into off-line SQL source code files. You can subsequently
perform tasks such as distribute the files or add them to a Version Control System (VCS). This
example will reverse engineer the table objects from the Microsoft SQL Server AdventureWorks
database into a Rapid SQL project

1 Select File > New > Project to open the wizard.

2 Enter sample_project as the name, and accept the default target directory. Select From
Database and click OK.

3 On the Connection page, select SAMPLE_DATASOURCE and click Next.
4 On the Catalogs page, select AdventureWorks and click Next.

5 Click Schemas to open the Schema Selection dialog. Select Human Resources,
Purchasing, and Sales, and then click OK. The Object Selection page opens.

6 Under Object Types, select Tables. Then, under Objects, expand the Tables node and
select the Purchasing.Vendor, Sales.SpecialOffer, and HumanResources.Employee
tables. Click Next.

7 On the Options page, leave the default selections and click Finish.
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8 When the Execute page shows that reverse engineering is complete, click Continue.

The Project tab displays the results of the reverse engineering.

Project B

i[2] sample_project epj
=HE Table
HumanResources. Employes sgl
Purchasing . Vendor sgl
Sales. SpecialOffer.sgl
[—]ﬁ User Datatype
~[2] dbo.AccountNumber sql
dbio.Hag.sql
| dbo.MName sql

g

S

HumanResources AK_Employee _LoginlD sgl
HumanResources AK_Employee MNationallDMumber sql
HumanResources AK_Employee _rowaguid sgl
HumanResources . [¥_Employee_ManagerlD sql
HumanRegources. [X_Humanregources _vacantionshours.sgl
Sales. AK_SpecialOffer_rowguid sgl
Purchasing AK_Vendor_AccountMumber sql

reign Key Constraint
HumanResources FK_Employee_Contact_Contact|D .sgl
HumanResources FK_Employee_Employvees_ManagerlD sql

R I N Y R

o
-l

e

Before closing the Project tab, investigate the individual project elements. In addition, check
the File and Project menus for project and version control options.

SESSION 6: VISUuAL QUERY BUILDER

Rapid SQL gives you the ability to construct complex SQL statements with point-and-click ease
using the Visual Query Builder.

1 From the Navigator tree, right-click on the HumanResources.Employee table and select
Build Query.

The table is automatically added to the Query Builder workspace.
2 On the Tables/Views tab, right-click on the Department table and select Add.

3 Similarly, on the Tables/Views tab, right-click on the EmployeeDepartmentHistory table
and select Add.

4 Rearrange the contents of the window to look like the following graphic.

5 Select the columns indicated in the graphic.

RAPID SQL 8.7.2/XE6é6 USER GUIDE 70



SESSION 6: VISUAL QUERY BUILDER

Al alx| -
=] EmployeeID & _IEmployeelD &
_INationallDNumber _|DepartmentID P
_IContactiD _IShiftiD 2| |_|
_lLoginID ~StartDate Al
_IManagerID FE[E ~|EndDate

A Title _IModifiedDate

—_IBirthDate x|

_IMaritalStatus “IDepartmentld 2

Jngder A name

_|H|reD_ate —IGroupName

—ISalariedFlag _IModifiedDate

_IvacationHours

_ISickLeaveHours

I CurrentFlag

lrowguid

_IModifiedDate

P 1 P

Note that the tables are automatically identified as being joined by any columns with the

same name and datatype. Also, note that the query is being built in the lower pane.

6 Click on the DML tab to expose the visual query building clauses and options. You can right-
click on any clause to easily add the code to the query.

TablesNiewsTDMLW

+[F5 HumanResources.Emplo =

> HumanResources.Emplo

> HumanResources.Emplo

HumanResources.Depar

-7  WHERE

= & ;
7 b % Mew..
w7 B Delete

-5 ORDER &Y !

% GROUPBY

m

7 Experiment with adding, deleting, and modifying clauses.

8 Click the Execute button to execute the query.

b

The results will display in the lower window.
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Before closing the Query Builder, experiment with additional options. Try selecting a different

statement type, such as Insert or Update, from the dropdown at the top of the Query Builder
window. Use the different clauses on the DML tab.

NOTE: Any visual query builder session can easily be saved to a file for later use.

SESSION 7: LIVE DATA EDITOR

1 From the Navigator, right-click on the Purchasing.Vendor table and select Edit Data.
2 In the Data Editor Filter dialog, click Add All to add all columns to the editing session.

At this point, you can add a WHERE clause that will filter for only the desired data. Note that
Rapid SQL builds the SQL to retrieve the data to be edited in the Select Statement area.

3 Click OK. A Data Editor opens.

&0 | e bSO AN Y HEIESS S
|c;-'5‘ VendorID Accountumber Hame CreditRa “
4 1 INTERNATOO001 International
2 2 i ELECTRONOOOZ Electronic Bike Repair & Supplies
3 3 : PREMIEROOOL FPremier Sport, Inc.
4 4 | COMFORTOO01 Comfort Road Bicycles |
; _ rrr S Y = = = = T = E
1 - Initial Select Statement 7/24/2012 14:08:45.881
2 —r +r t+t + + ¢+ + +r+ +r+ +r+ ++ +r+r+r++r+ ++r+&¥r+ ¢+ +r+++r &+ +r+4++++ + 4+ 5 H
3 SELECT T.VendorID, T.AccountNumber, T.Name, T.CreditRating, T.PreidV:
P F— .

Note the dropdown at the left of the toolbar. The editing window has LIVE and BATCH modes:

¢ LIVE mode commits your changes each time you move to a new row.

e BATCH mode will allow you to move within the window and commit your changes when
ready. Changes made in BATCH mode can be cancelled by selecting the Reload Data icon.

At any time during the session, you can change the filter parameters by selecting the Filter Data
icon.

by
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SESSION 8: CODE ANALYST

The Code Analyst allows you to capture run-time statistics on executable database objects,

including stored procedures and functions. Not only can you capture statistics for single objects,
but you can group more than one object.

To get started
1 Select Tools > Code Analyst.
NOTE: In order for Code Analyst to run, 5 repository tables will be created on the database.

Select the database you would like the tables to be installed on and press OK. Once
the tables are installed, you're ready to start defining a session.

2 On the Code Analyst toolbar, click the Create New Collection button.

3 On the Code Analyst Object Selection dialog, provide a Session Name, locate and select
the objects to be executed, and click Next.

P

Code Analyst Object Selecticn | 28 |

Session Mame

@ Select by Owner () Select by Object

= |Databases
- adina |__
|:| adina_smoke o
&-[adinuta
-] AdventureWorks
- alex_mig
- alexb
-[alexbf
|:| alexbfdsf
&-[C]aNA_FO3
&[] aMAFO2
=[] aMAFO4
-] ANAFO465 -

< Back MNeset > Cancel Help
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SESSION 9: SOQL DEBUGGING AND PROFILING

Use the Code Analyst Object Initialization dialog to initiate providing input parameters as
required, change the order of execution, and when ready, click Finish.

Once the session has been run, the total time for the execution is displayed in the Run
Summary tab.

Select the other tabs to view the tabular and graphical representation of the execution
details on your selected objects. For example:

e The Run Detail tab shows a breakdown of the different objects that make up the session.

® The Unit Detail tab contains the specific time measurements for individual SQL
statements.

Close the Code Analyst window.

SESSION 9: SQL DEBUGGING AND PROFILING

Rapid SQL offers the following facilities that help you test and optimize code:

e SQOL Debugging

e SQL Profiling- Oracle Only

SQL DEBUGGING

The SQL Debugger is another database productivity tool that lets you debug SQL Server,
Oracle, Sybase ASE or DB2 stored procedures, as well as Oracle functions. SQL Debugger
simplifies the task of finding coding errors.

1
2
3

In the Navigator, expand the Procedure or Function node.
Right-click the object and select Debug from the context menu.

If the procedure or function takes input parameters, the Procedure Execution window
prompts you to enter values.
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CTrrocetare s

écﬂﬁﬁﬁ?ﬂﬂ’bﬁ%ﬁyﬁﬁw |lw

et Frocedure:
dho Ehyrossalty
Farameter:

Name |Type | NULLI Defﬂult| Yalue

Input Values
@  Open ‘ | H Sawe ‘ | ) Beset ‘
‘X Cancel ‘ ‘? Help ‘ ‘Bﬁ Continug

4 Enter input values and press Continue.

TIP: Rapid SQL allows the user to save the input variable values to a file for later use. This

is very helpful for procedures/functions with many input variables that need to be run
repeatedly.

The application opens the SQL Debugger Interface.
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0

|63 &l

1 g» Procedure PARSE SAME IS
2 ro integer default 0O;
3 1 cursor integer default 0O;
4 E! BEEGIN
5 = FOR i IN 1..1 LOOF
& 1 cursor:=dbkm=z =gql.cpen cursor;
7 dbmz =gl.parze (1l cursor,
a "@ELECT * FROM DUAL' ,dbms =ql.native);
9 FOR j IN 1..400000 LOOP
10 ro:=dbmzs =ql.execute (1l cursor);
11 rc:=DEMZ SQL.FETCH ROWS (1l cursor);
1z END LOOF;
13 dbms sgl.close cursor(l curscr):
14 END LOOP;
13 END;
Debugger - Wakch and Wariable Windows ¥ Debugger - Dependency and Call Stack Windows x
Name [ Value | Type | [ TCODRUTAPAFSE, GAMED Line:
= (NULL  linteger
|_curgor |[MULL  |integer
4 \\\ -@ Wariables I @ ‘Wakch ] B4 . @ Callstack [ fg Dependency | e
Awka Cammit COFF \TORLABORCLL1g. i

The Debugger features basic execution, line-by-line execution, breakpoint support, and other
common debugging features. For details, refer to the relevant online Help topics.

SQL PROFILING- ORACLE ONLY

The SQL Profiler within Rapid SQL provides the ability to capture the metrics of various PL/SQL
programmable objects as they are executed in the database. It quickly identifies performance
bottlenecks by first calculating the overall runtimes of objects like Oracle packages, and then
computing the amount of time each line of PL/SQL code spends executing. Information is
presented in an easily viewed, drill-down format.

1 To start a profiling session, use the Tools menu option and select SQL Profiler > Start.

2 Enter a name for the profiling session or select an existing name from the dropdown. Press

OK. The Profile session is now active.
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-

ﬁQL Profiler - Start

Frofile Comment:

|

]

W

¥ Cancel ‘

"’? Help ‘

3 Execute the programmable object (i.e. Stored Procedure) you wish to capture metrics on.

4 When finished, select Tools > SQL Profiler > Stop. The SQL Profiler — Stop dialog window

prompts you to select an option.

5QL Profiler - Stop

X

-

Do wou now wish to end the
current profiling session and
record any unrecorded data
collected sofar in this session in
the database?

otop & Analyze

Stop

Cancel

Help

5 Press Stop.

6 On the Navigator, expand the PL/SQL Code Profiling node.

» Explorer- By Object Type

--': Fackage Bodies
E FL/S0L Cade Profiling (3)

|~

e ym
N al Add Bookmark
@ tes

118 Prima! B | Start

23 Proce Il Run Summary

W
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Right-click on the profile session and select Run Summary. The Run Summary window
opens.

Comment:

My Profils v

-Bun Summary

Comment Run ID | Run Date Total Time (ms) |
Mhy_Profile 60 :01/09/2009 12:00:43 PM : 47261
Mhy_Profile Al ;DIHDQEDDQ 12:01:52 P S84 |

Select a session and select Run Detail from the right-click menu. The Run Detail screen
appears allowing you to view the metrics for this execution in both a graphical and text
format.

Comment Rur Unit Type: Urst Owner.
[create_admiston) | [Runtt @NI003025605PM | [[aITypes] «| [ERaDMN
l§
Time Unst 0 e Urit Execution Time (m2) Unt Time % of Run Totw
* Milieconds [ma] B 32 SYS DBMS_OUTPUT 300
™ Seconds [tec) 5 16 SvS DBMS_PROFLER 250
C Mirdes fnin) 11 «anonymOuss «anOny Mo 200
B0 7 canorymouss cancnmymouss 150
[ 7 concerymous» sanofrymhous» 100
| | [ 7 canorvymouss <anofrymouss 0
B € <ancoymouss <anciymouss 0
Unit Owner | Unit Hame | Unit Type |  TotstTime(ms) | % of Total |
ERADMEN CREATE_ADMISSION PROCEDURE 02 00
SYsS DBMS_OUTPUT PACKAGE BODY 2 o
SYS DEMS_PROFLER PACHACE BODY 16 0005
CAMOCTYTROUS > ATy IO > ANONYMOUS BLOCK 1" 0003
AN Ty TR B e TR ANOHYMOUS BLOCK 7 0002
T <RGNS ANONYMOUS ELOCK 7 0002
AT TR AN ANONYMOUS BLOCK 7 0002
AT TR S Ty IOLU = ANONYMOUS BLOCK 1] 0002
AT TS » BNy ANONTMOUS BLOCK 5 0002
AT AT AMON Y IS Pl O W n n

To drill down further into the data, highlight a unit and select Unit Detail from the right-click
menu. Scroll through the Source window to view the times for each statement.

To compare 2 cases, select the 2 cases you wish to compare (shift-click to select the second
case) from the Run Summary screen and select Compare from the right-click menu. The
SQL Profiler Run Comparison screen appears.

See the relevant online Help topics for more information on profiling.
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The following topics show you how Rapid SQL lets you customize the application configuration

for your specific needs:

e Configuring Feature Options

e | ocking Down Rapid SOL Features Using the Reqistry

CONFIGURING FEATURE OPTIONS

All Rapid SQL application settings are available in the Options Editor, which is organized in a
tabular format based on feature sets.

To specify options for the Rapid SQL application or a particular feature

1 On the File menu, select Options.

Rapid SQL opens the Options Editor.

2 Click the tab corresponding to the feature you want to customize:

Browsers Options
Code Analyst Options

Data Editor Options

Data Editor Options

Data Transfer Options

Explorer Options - Main

Tab

Datasource Options

DBMS Java Options
DB2 Utilities Options

DDL Extract Options

Debug Options

Directories Options

General Options

Grid Properties (Results

window) Options

Lets you specify appearance of browser windows.

Lets you set dependency profiling level, alarm and threshold, and oracle options for
Code Analyst.

Specifies the timeout parameters, packet size for a connection, and ANSI to OEM
settings.

Specifies settings for Data Editor.

Sets default directories when performing data unload and load and data export and
import operations.

Sets defaults for the organization of objects in the Datasource Navigator.

Specifies general datasource management options and Datasource Navigator
preferences.

Specifies load Java files and drop Java files.
Sets default directories for executables used by DB2 LUW.

Specifies whether or not Rapid SQL should include DROP statements when extracting
the schema of different database object types.

Sets the duration of your debug initialization and debug session, enable or disable
DBMS_OUTPUT, and enable the refresh option.

Sets the default directories for placing the output of different operations such as HTML
reports or schema extractions.

Sets defaults for automatic login, restoring the last session, and other general application
options.

Dictates the physical appearance of the results window grid.
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ISQL Options

Java Options

LDAP Configuration
Options

Logging Options
MySQL Utilities Options

Oracle Utilities Options

Query Builder Options
Results (ISOL) Options

SMTP Mail Options

Team Server Options

Version Control Options

Warnings Options

Sets defaults for the maximum allowable errors before aborting the execution of a SQL
script, executing selected text, and the position of Query and Results tabs.

Lets you specify Java Virtual Machine options.

Sets preferences for LDAP Server usage

Sets defaults for SQL Logging.

Specifies paths to MySQL utilities.

Specifies the location of the Oracle Utilities.
Specifies global settings for Query Builder.

Specifies auto format result sets, sets the display and format of Result Windows, and the
mail file type and default fonts.

Lets you specify defaults for your outgoing mail notifications.

Lets you integrate with the Embarcadero DB Team Server data governance matadata
repository.

Lets you select which version control system you want Rapid SQL to use as the
underlying version control system

Activates specific warnings when undesirable actions are attempted against a database.

3 Set feature options on the tab and then click OK.

NOTE:

If there is an open document, Rapid SQL opens the Update Document Statement

Properties dialog. The Update Document Statement Properties dialog lets you
override changes you made to a current document or documents with new setting you
made in the Options Editor.

CONNECTION OPTIONS

The Connection tab of the Options Editor lets you specify common connectivity options and
provides access to DBMS-specific options.

NOTE:

For Rapid SQL system requirements and details on DBMS product support, see the

Read Me at http://docs.embarcadero.com/products/rapid _sgl/.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SOL

application and feature options" on page 79.

The table below describes the options and functionality on the Connection tab:

Option

Description

Default

Login Timeout

Specifies the number of seconds that the application should wait for a response toa | 30
connection request from server. If server does not respond within the specified period,
the application aborts the connection and returns an error message.

Query Timeout

Specifies the number of seconds that the application should wait for a responsetoa |0
query from the server. If the server does not respond within the specified period, the
application terminates its query process and returns an error.

80
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Option Description Default
Host Name Name of the client computer. Local
name

See the following topics for DBMS platform-specific options:

e Connection Options - Sybase

e Connections Options - Sybase |Q

e Connections Options - SQL Server

e Connections Options - Oracle

CONNECTION OPTIONS - SYBASE
The Connection > Sybase tab of the Options Editor lets you select an installed client other than
the active/default client version for Embarcadero driver connections. It also lets you override

default client/server settings.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.
NOTE: For more general connectivity options, see "Connection Options" on page 80.
Group Setting Description
Use Quoted If you plan to use delimited identifiers, select this option.
Identifiers

Client Selection

This group of controls apply only to use of the Embarcadero drivers with native Sybase clients.

Enable Client
Selection

Selecting this check box lets you override the default/active Sybase
client specified by the SYBASE, SYBASE_OCS, and/or SYBROOT

environment variables.

This control enables and disables the Client Home Directory and
Client OCS Directory controls.

Client Home

Browse to the root directory of the client to be used.

Directory
Client OCS Select the OCS- directory corresponding to the client version that you
Directory want to use.
Connection SQL INI File Browse to locate and select the specific, SQL.INI-formatted file
Settings containing server-configuration information. The file does not have to

be named SQL.INI.

Packet Size, Max
Connections, and
Client Character
Set

These settings let you create a set of default parameters used in
setting up connections to Sybase ASE datasources.

These settings can be overridden when registering a Sybase ASE
datasource. For details, see "Providing Sybase ASE Connection
Information When Registering Datasources" on page 130.
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CONNECTIONS OPTIONS - SYBASE 1Q

The Connection > Sybase 1Q tab of the Options Editor lets you specify DBMS-specific
connection options.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

NOTE: For more general connectivity options, see "Connection Options" on page 80.

Setting Description

Use Quoted Identifiers | If you plan to use delimited identifiers, select this option.

CONNECTIONS OPTIONS - SQL SERVER

The Connection > SQL Server tab of the Options Editor lets you specify DBMS-specific
connection options.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL
application and feature options" on page 79.

NOTE: For more general connectivity options, see "Connection Options" on page 80.

Setting Description

Use Quoted Identifiers | If you plan to use delimited identifiers, select this option.

Packet Size This control lets you specify a default packet size parameter used with SQL Server
connections.

This setting can be overridden when registering a SQL Server datasource. For details,
see "Providing SQL Server Connection Information When Registering Datasources" on
page 129.

CONNECTIONS OPTIONS - ORACLE

The Connection > Oracle tab of the Options Editor lets you select an installed client other than
the active/default client version for Embarcadero driver connections. It also lets you override
default client/server settings.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

NOTE: For more general connectivity options, see "Connection Options" on page 80.

Group Setting Description

Hide time portion of DATE datatype if zero | If selected, the time portion (HH:MM:SS) of DATE datatype results
are suppressed in the ISQL Editor’s Results window, if the time
portion is all zeroes.
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Group Setting Description

Client Selection This group of controls apply only to use of the Embarcadero drivers with native Oracle clients.

If no client is specified using these controls, Rapid SQL will use the following sequence in
determining the client to use for Oracle connections.

- The driver specified in the ORACLE_HOME environment variable
- The first driver found in the PATH environment variable
- The Oracle Instant Client driver (v. 11) bundled with DBArtisan

Enable Client Selection | Selecting this check box lets you override the default/active client
specified by Oracle environment variables.

This control enables and disables the Oracle Home control.

Oracle Home Select the directory of the Oracle client you wish to use.
TNSNAMES.ORA Directory Path of Browse to locate and select the directory containing the

Oracle configuration TNSNAMES.ORA file to use. Ensure that no file name is included

files with the path.

If no file is specified using this control, Rapid SQL will use the
following sequence in determining the TNSNAMES.ORA file to
use for Oracle connections.

-The directory specified in the TNS_ADMIN environment variable

- The directory specified in the TNS_ADMIN key at the top level in
HKLMASOFTWARE\ORACLE

- The directory specified in the TNS_ADMIN key in the client
subkey (HOME or KEY_ prefixed) corresponding to the value of
the ORACLE_HOME (if there is a particular client specified by the
user, its TNS_ADMIN subkey will be used if present)

- The directory ORACLE_HOME\NETWORK\ADMIN (if there is a
particular client specified by the user, ORACLE_HOME is the
client's full path)

- The directory ORACLE_HOME\net80\ADMIN (if there is a
particular client specified by the user, ORACLE_HOME is the
client's full path)

- All directories in PATH environment variable

BROWSERS OPTIONS

The Browsers tab of the Options Editor lets you set a number of options for your browser
windows, including browser appearance, mail file type options, and default object owner.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQOL
application and feature options" on page 79.

NOTE: For information on Browser features, see "Browsers" on page 26.
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The table below describes Browser options:

Interface
Element

Option

Description

Default

Window

Show Toolbar

Toggles the Browser window toolbar. Commands can also be
activated from the shortcut menu that displays when you right-
click in an open Browser window.

Selected

Show Status
Bar

Toggles the status bar at the bottom of the Browser window. The
status bar displays the cell location of the current focus and the
number of rows in the Browser window itself.

Selected

Detailed
Listing

Toggles detail columns for a given object type. Each object
contains object specific details, such as creation date, segment,
and so on. When Detailed Listing is turned off, only the names of

objects and the numbers of rows of data for a table are displayed.

Not
selected

Appearance

Text Color

Sets the text color for all Browsers of that object type. Select the
row appropriate to a particular object type, then click a color in
the Text column. Remember that text colors appear best against
contrasting background colors, such as black on white.

Available

Background
Color

Sets the background color for all Browsers of that object type.
Select the row appropriate to a particular object type, then click a
color in the Background column. Remember that text colors
appear best against contrasting background colors, such as black
on white.

Available

Browser File

Mail File Type

Specifies what file type you want the browser file saved as when
sent as e-mail to another user on a MAPI compliant mail system.
The valid types are the proprietary Rapid SQL Results type, Tab
delimited, Comma separated, and HTML, which formats the
results in a simple HTML table.

Results

Default Owner

All Owners

Indicates that the Browser Window should default to displaying
database objects in the browsers for all owners in the database.

Not
Selected

Current User

Indicates that the Browser Window should default to displaying
database objects owned exclusively by the current user.

Selected

Specific Owner

Indicates that the Browser Window should default to displaying
only the database objects owned by a specific owner. If you select
this option, you must provide an owner name in the box.

Not
Selected

CODE ANALYST OPTIONS

Code Analyst is a utility that helps you identify time-consuming lines of code. The Code Analyst
tab of the Options Editor lets you specify Code Analyst operational parameters.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SQL

application and feature options" on page 79.

NOTE:
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For information on using Code Analyst, see "Code Analyst (Rapid SOL)" on page 973.
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The table below describes Code Analyst options:

Group

Options and descriptions

Dependency profiling
level

All Dependencies Code Analyst will use all levels of dependencies when
profiling the session.

Dependencies up to Lets you specify how many levels of dependencies the Code
level Analyst will use when profiling the session.
Oracle List Package objects Code Analyst lists the procedures within a package and

functions that are found in the Oracle database.

Use SQL Profiler Code Analyst uses Oracle's DBMS_Profiler package to
collect time metrics.

Code Analyst displays the actual run time on the database,
and does not include the time it takes to get to the server.

Alarms and Thresholds

Lets you set an alarm for each type of object that is collected. For each supported
Object Type (procedure, function, package, trigger, type), you can provide the following
settings:

Alarm % - lets you specify the percentage of total run time a line of code takes when an
alarm appears. If the object took more than specified percent of total time, Code Analyst
alerts the user by changing the color of the text

Ignore 100% - lets you ignore lines of code that take all of the total run time

Show Code Analyst
Confirmation Dialog

When you create or execute a session, Code Analyst displays a message that the Code
Analyst will run longer than the actual code. You can also select the Please do not show
me this dialog again option in the dialog.

DATA EDITOR OPTIONS

The Data Editor tab of the Options Editor lets you provide preferences that dictate behavior of
Rapid SQL's table data editor.

NOTE: Option parameters set in the Options Editor override options set within Query Builder
and Data Editor.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

NOTE: For information on using the Data Editor, see "Data Editor" on page 904.

The table below describes the options and functionality on the Data Editor tab:

sub-options: Ignore errors-continue processing, Prompt on Error, and
Stop after error(s) (number of errors allowed before stopping execution)

Interface Element | Option Description Default
Default Execution | Live Mode lets you execute changes one row at a time. Batch Mode lets Live Mode
Mode you make unlimited changes prior to execution. Batch Mode offers three

Data Editor File Mail File Type Sets the default mail output style as Results, Tab Results

Delimited, Comma Separated, or HTML.
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Interface Element | Option Description Default
Include column titles | Includes column titles when saving. Not selected
when saving

Grid Font Customizes font style, and size for the Data Editor and the Results Grid. Available

Printer Font Sets font style, and size for printing output. Available

Auto Format Fits formatting to match your desktop. Selected

(Best Fit)

Begin and End Adds a beginning and ending transaction on each statement. Selected

Transaction

Statements

Default Date/ Displays the current date/time format and lets you customize the date/time | Results

Time Format display.

Use Calendar If selected, Rapid SQL uses the Calendar Control Not selected
Control as default window.

2 digit year system | If selected, Rapid SQL sends a warning when you Selected
setting warning use a two digit year system setting.

Confirmation Enabling Show Delete Confirmation Dialog, Show Update Confirmation | Selected

Dialog Options Dialog, or Show Update LOB Confirmation Dialog lets you display a
confirmation dialog when you use a delete command, update a row, or
update a LOB, respectively.

DATA TRANSFER OPTIONS

After opening the Options editor (see Specifying Rapid SOL application and feature options),
you can make changes to the Data Transfer tab.

You can configure Rapid SQL to use default directories when performing data unload and load
and data export and import operations. Setting a default directory saves time because it
describes a single reference point for loading or unloading, exporting and importing table or

view data files.

The table below describes the options and functionality on the Data Transfer tab:

Option Description

Data Unload Specifies the name and location of the default directory in the Data Unload
box.

Data Load Specifies the name and location of the default directory in the Data Load box.

Oracle Export (for Oracle)

Specifies the name and location of the default directory in the Oracle Export
box.

Oracle Import (for Oracle)

Specifies the name and location of the default directory in the Oracle Import
box.
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DATASOURCE OPTIONS
The Datasource tab of the Options Editor lets you provide datasource categorization and

storage preferences.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL

application and feature options" on page 79.

Option

Description

Default

Datasource Storage
Management

Rapid SQL offers both registry-based and file-based datasource catalog
management. Prior to changing methods, see "Specifying a Datasource
Catalog Storage Option" on page 122/

The following options are offered:

Windows Registry datasource catalog - The datasource catalog is stored
and managed locally, in the Windows registry. This user can add and delete
datasources and edit the registration details of existing resources. Any
changes are retained across startups of Rapid SQL.

File based datasource catalog - The datasource catalog is stored locally
and is file-based (%APPDATA%\Embarcadero\Data Sources\ in a default
installation). This user can add and delete datasources and edit the
registration details of existing resources. Any changes are retained across
startups of Rapid SQL.

Network shared datasource catalog - The datasource catalog is file-
based, and obtained from the location specified in the Location of shared
datasources file control. Changes such as new datasources, deleted
datasources or edited datasource registrations are lost as soon as this user
shuts down Rapid SQL.

Changing methods does not delete datasource definitions stored using the
current method. When you change methods, Rapid SQL does not
automatically convert existing catalog definitions to the new method

Windows
Registry

Recent Datasource List
Contains

Lets you specify number of datasources to display when you select Recent
Datasources from the File menu.

Default to Alias Usage
When Defining New
Datasources

For DBMS that support alias usage, defaults the Connection Information
tab to alias usage selection.

Unselected

Datasource Category
Settings

Lets you select the optional user interface elements that are to be color-
coded or labelled for datasources that have been assigned a category:

Color the status bar using the datasource’s category color
Color the tabs using the datasource’s category color
Include category short name in the datasource toolbar combo

For an introduction to datasource categorization, see "Categorizing
Datasources using Color-coding and Labeling" on page 157.

N/A

NOTE: For information on using Embarcadero Team Server repository-based datasource
definitions, see "DB Team Server Support" on page 167.
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DBMS_JAvA OPTIONS
The DBMS_JAVA tab of the Options Editor lets you choose between use of the DBMS_JAVA
package and the loadJava.bat batch file when loading or dropping Java classes.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL
application and feature options" on page 79.

The table below describes the options and functionality on the DBMS_Java tab:

Interface Option Description Default

Element

Load Java files | Use the DBMS_JAVA package Lets you schedule your SQL. Selected
Use batch file (oracle_home/bin/ Uses batch file (oracle_home/bin/ Not
loadJava.bat) loadJava.bat) selected
Default Encoding option Leave blank to use the default. Default

Drop Java files | Use the DBMS_JAVA package Lets you schedule your SQL. Selected
Use batch file (oracle_home/bin/ Uses batch file (oracle_home/bin/ Not
dropJava.bat) dropJava.bat) selected

For related information, see the following object actions:

e "Drop Java" on page 636
e "L oad Java" on page 656

DB2 UTILITIES OPTIONS
Some Rapid SQL functionality against DB2 LUW datasources makes use of native DB2 utilities.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

The table below describes the options and functionality of the DB2 Utilities tab:

Option Description

db2cmd.exe Use this control to specify the location of the directory containing the db2emd.exe
utility.

db2.exe Use this control to specify the location of the directory containing the db2.exe utility.
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DDL EXTRACT OPTIONS

The DDL Extract tab of the Options Editor lets you specify results-handling preferences for use
of the Extract object action.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL
application and feature options" on page 79.

NOTE: For information on using the Extract object action, see "Extract" on page 647.

Common options

The table below describes the options and functionality on the DDL Extract tab, main view, of

the Options Editor:

Option

Description

Extract to multiple
windows

Select to extract the schema for each object into separate DDL windows.

NOTE: This option only works when you extract DDL for multiple objects.

Extract in dependency
order

This is the default.

When you select a number of objects as part of an extraction job, this option ensures
objects will be extracted in the proper dependency order.

If the option is not selected, errors may result when you execute the script.

It's also true, however, that loading the dependencies can add significant overhead when
you are extracting numerous objects.

Script Use Statement

This option is for Sybase. Optimizes extraction through generating Use statements in the
generated script.

Grouping Extracted
DDL

There are two option as to how the DDL is generated for an extract operation:

Group the Drop and Create DDL for each object together - Objects are extracted one
at a time. In the DDL generated by the extract, the Drop statement for a selected or
referenced object is followed by the Create statement for that object.

Group DDL statements by type - all Drop statements, then all Create statements - In
the DDL generated by the extract, Drop statements for all selected or referenced objects
are grouped to precede Create statements for those objects. This method ensures that
all dependencies are respected.

For more information on DROP options and dependencies, see DBMS-specific DDL
Extract Options.

DBMS-specific DDL Extract Options
The DBMS-specific views of the DDL Extract tab let you specify:

® The object types to include DROP statements for

e The default dependent object types for each object type included in extraction/migration

operations
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You can choose to include DROP statements before you perform ad hoc DDL extractions. You
can use this feature to modify and to re-compile database objects. To recompile a database
object, drop it before recreating it. This option drops any existing objects of the same name
before recreating the object. The data in the existing table is not saved when you specify a
DROP statement for extracted DDL.

CAUTION: Because dropping an object is a destructive action, you should carefully
consider including drop statements before activating this option.

You can also specify dependent object types included in extraction/migration operations. Each
DBMS-specific view of the DDL Extract tab lets you specify the object dependencies for each
object type. Dependent object types selected on that view are by default selected when you run
an extraction/migration operation and can be overridden using those wizards. For more
information see Extract.

DEBUG OPTIONS

The Debug tab of the Options Editor lets you specify operational preferences for the Rapid SQL
Debugger.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.
NOTE: For information on using the Rapid SQL Debugger, see "Embarcadero SOL

Debugger" on page 917.

The table below describes the options and functionality on the Debug tab:

Tab Option Description Default
General | Dependency Tree Lets you specify pre-fetch levels. Pre-Fetch All
Option Dependencie
s
Profiler | Profiler Time Unit Lets you select a unit of milliseconds, seconds or minutes. Milliseconds
Save Profiler Reports Lets you save profiler reports and type or browse for the Not Selected
report path.
Oracle | Initialization Timeout Specifies the point at which the application stops trying to 60
(seconds) initialize the debugger. If it cannot initialize the debugger in
the specified time, it displays message in the Debug Output
window.
Debug Session Timeout | Specifies the point at which the application terminates your | 7200
(seconds) debug session due to idle time.
Enable DBMS Output Enables the Oracle built-in package, DBMS_OUTPUT, letting | Selected
you send messages from stored procedures, packages, and
triggers.
Refresh Dependencies | Refreshes the dependencies each time you run the debugger. | Not selected
for each run
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Tab Option Description Default
Compile with Debug When debugging a procedure against an Oracle datasource, | Compile
Option Rapid SQL performs a compilation before debugging. During | dependent
a compilation, Oracle invalidates referencing objects. For options
example, if procedures A2 and A3 both reference procedure
A1, debugging procedure A1 in Rapid SQL, will result in
procedures A2 and A3 being marked as invalidated.
The Compile with Debug Options settings let you control
compilation of dependent objects while debugging.
DB2 Debug Session Timeout | Specifies the point at which the application terminates your | 300
(seconds) debug session due to idle time.
Compile with Debug Lets you specify options. Prompt
Option before Debug Always
Session

DIRECTORIES OPTIONS

The Debug tab of the Options Editor lets you configure default directories when performing
certain operations. You can set the default directories for:

¢ Wizard operations
® Report generation
e Schema extraction
e HTML templates for customizing reports

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SQOL
application and feature options" on page 79.

The table below describes the options and functionality on the Directories tab. The
%APPDATA%, %MYDOCS%, and %PROGFILES% placeholders represent the location of the
Application Data, My Documents, and Program Files folders relevant to your operating system :

Option Description Default
Wizard Specifies the name and location of the default directory for %APPDATA%\Embarcadero\RapidS
Definitions | saving wizard operations. This option applies to wizard QL\DefFiles

operations in which you have the option to save the definition

file, such as data unload/load or schema migration

operations.
HTML Specifies the name and location of the default directory for %APPDATA%\Embarcadero\RapidS
Reports the output from generated HTML reports. QL\Report

For information on generating reports, see "Report" on

page 694.
Schema Specifies the name and location of the default directory for %MYDOCS%\Embarcadero\RapidSQ
Extraction | placing the output from schema extraction operations. L\Extract
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Option Description Default

HTML Specifies the name and location of the default directory %PROGFILES%\Embarcadero\RSQL
Template | where Rapid SQL can find the HTML template on which to <version identifier>\HtmITpl
base HTML reports. This feature lets you customize your

HTML reports.
User SQL | Specifies the name and location of the default directory for %MYDOCS%\Embarcadero\RapidSQ
Scripts SQL Scripts. L\UserSQLScripts

Job Config | Specifies the location of any ETSQLX job configuration files | %$MYDOCS%\Embarcadero\RapidSQ
Files you have set on your local machine. L\Directories\ETSQLXJobCfg

For more information, see ETSQLX Command Line Utility.

#include Specifies the name and location of the directory searched for | $#MYDOCS%\Embarcadero\RapidSQ
Files files specified by a #include directive in the ISQL editor, L\Directories\IncludeFiles

Procedure Object Editor, or Package Body Object Editor if
there are no paths specified on the Datasource Properties tab
of the Datasource Registration Editor. For more information,
see "Registering Datasources" on page 121.

For more information on compiler directives, see "SQL

Preprocessing: #define and #include" on page 729.

EXPLORER OPTIONS
The Explorer options are available on the following Options Editor tabs:

e Explorer Options - Main Tab

e Explorer Options - Organization Tab

e Explorer Options - Limits Tab

e Explorer Options - Browsers Tab

EXPLORER OPTIONS - MAIN TAB

The Options Editor’'s Explorer tab controls the appearance and behavior of the Rapid SQL
Datasource Navigator.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQOL
application and feature options" on page 79.

NOTE: For related information, see "Using the Datasource Navigator" on page 146.

Use the following table as a guide to modifying settings on this tab

Setting Description
Refresh after Object Refreshes the Explorer automatically after an object has been modified or created.
Commands
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Setting

Description

Retain View Setting on
Close

Select to retain the current state of the Datasource Explorer so that it opens the same
way the next time you start Rapid SQL.

Column filters use
regular expressions by
default

Display Explorer on
startup

Activates the Datasource Explorer on Rapid SQL startup. For more information, see
"Using the Datasource Navigator" on page 146.

Landing Page View

Enables landing page views on a DBMS-by-DBMS basis. Landing pages display
informative metadata that gives you a quick overview of your server/database.

EXPLORER OPTIONS - ORGANIZATION TAB

The Options Editor's Explorer > Organization tab controls the appearance and behavior of the
Rapid SQL Datasource Navigator.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SQOL

application and feature options" on page 79.

NOTE:

For related information, see "Using the Datasource Navigator" on page 146.

Use the following table as a guide to modifying settings on this tab

Setting

Description

Explorer organization

Lets you select a default grouping option of Organize by Object Owner (groups
objects, by object type, for each user) or Organize by Object Type (groups objects by
object type for all users in the same list). Grouping by object owner is most efficient if you
are working with databases containing a high number of objects.

You can change the organization manually during a Rapid SQL session.For details, see
"Basic Viewing Options in the Navigator" on page 152.

Show System Objects
and Show Only My
Obijects (available if you
are organizing the
Datasource Explorer by
object type)

Lets you select a default Datasource Explorer tree display options for system objects and
objects that you own. Available options in the two groups are:

Never - the relevant objects are not displayed by default.
Always - the relevant objects are always displayed by default.

Use datasource filter - The relevant default datasource filter is enabled. For more
information, see "Filters Explorer Node" on page 148.

You can change the Show System Objects and Show Only My Objects settings
manually during a Rapid SQL session. For details, see "Using the Default Filters" on
page 163.
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EXPLORER OPTIONS - LIMITS TAB

The Options Editor’s Explorer > Limits tab controls the appearance and behavior of the Rapid
SQL Datasource Navigator..

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

NOTE: For related information, see "Using the Datasource Navigator" on page 146.

While Rapid SQL queries the DBMS as necessary when you navigate the node hierarchy, it also

caches nodes for the purpose of quickly repopulating if you move away from and then back to a
node. For example if you open a Tables node and then an Indexes node and then again select
the Tables node, the cached Tables sub-nodes are displayed.

The following settingis are available

EXPLORER OPTIONS - BROWSERS TAB

The Options Editor's Explorer > Browsers tab controls the appearance and behavior of the
Rapid SQL Database Navigator

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

Use the following table as a guide to modifying settings on this tab

Interface Element | Setting Description

Default Owner All Owners Indicates that the Browser Window should default to displaying
database objects in the browsers for all owners in the database.

Current User Indicates that the Browser Window should default to displaying
database objects owned exclusively by the current user.

Specific Owner Indicates that the Browser Window should default to displaying only
the database objects owned by a specific owner. If you select this
option, you must provide an owner name in the box.

Mail File Type Specifies what file type you want the browser file saved as when sent as e-mail to another user
on a MAPI compliant mail system. The valid types are the proprietary Rapid SQL Results type,
Tab delimited, Comma separated, and HTML, which formats the results in a simple HTML
table.

Browser colors Lets you specify foreground and background colors for object types displayed in the Browser

GENERAL OPTIONS
The General tab of the Options Editor lets you specify general application options.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.
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The table below describes the options and functionality on the General tab:

Output Window

appear in the Output Window before the contents are
flushed. This option conserves memory resources. You can
clear the Output window or raise the maximum number
allowed at any time.

Tab Option Description Default
Main tab Confirm on Exit Instructs Rapid SQL to issue a message confirming the Selected
operation before exiting the application.
Max Editors in a Specifies the maximum number of editors allowable froma | 5
Single Open single Open operation.
Operation
Max Entries in Specifies the maximum number of messages that can 1500

The General tab also offers the following DBMS-specific aub-tabs:
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Oracle sub-tab

Option

Description Default

Data Dictionary View
Usage

Lets you synchronize Rapid SQL use of the Oracle Data Dictionary DBA and ALL/USER
views with the privileges associated with the role used in creating and using the
datasource.

Role-based Views - Rapid SQL will use views based on the user’s role. That is, users
with DBA privileges will use DBA views.

DBA Views - Rapid SQL always uses DBA views.
All Views - Rapid SQL always uses ALL views.

Use Datasource Configuration for Views - lets you set up Data Dictionary usage on a
view-by-view basis when editing or registering a datasource. For more information,
see "Registering Datasources" on page 121.

Preserve Case in Object
Identifiers

Preserves case of the database object. Not selected

Sybase and SQL Server sub-tabs

Option Description Default
Rename action Lets you specify whether user-defined objects or datatypes are extended alter
style renamed using an extended ALTER or using the sp_rename

procedure.

InterBase/Firebird sub-tab

Option Description Default

Object Identifiers

Preserve Case in Preserves case of the database object. Not selected

GRID PROPERTIES (RESULTS WINDOW) OPTIONS

The Grid Properties tab of the Option editor lets you set preferences for the layout and
appearance of the grid in an Results window.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

The table below describes the options and functionality on the Grid Properties tab:

Interface Element | Options and descriptions Default
Titles and Gridlines | 3D-Buttons Enables or disables a 3-D appearance on row and column | Set
headings in the grid.
Horizontal Enables or disables ruling between rows of the grid. Set
Gridlines
Vertical Gridlines Enables or disables ruling between columns of the grid. Set

96

RAPID SQL 8.7.2/XE6 USER GUIDE




SPECIFYING RAPID SQL APPLICATION AND FEATURE OPTIONS

Interface Element

Options and descriptions Default

Mark Headings

Enables or disables highlighted row and column headings. | Set

Preview

group.

Displays a preview of the settings currently selected in the Tltles and Gridlines

ISQL OPTIONS
The ISQL options are available on the following Options Editor tabs:

ISOL Options - Main Tab

ISOL Options - Oracle Tab

ISOL Options - DB2 Tab

ISOL Options - Sybase Tab

ISOL Options - Sybase |Q Tab

ISOL Options - Sybase IO Tab

ISOL Options - MySQL Tab

ISOL Options - DB2 OS390 Tab

ISOL Options - InterBase Tab

ISOL Options - Editor Tab

ISOL Options - Auto format Tab

ISOL Options - Code Assist Tab

ISQL OPTIONS - MAIN TAB

The Options Editor’s ISQL tab and its sub-tabs control the appearance and behavior of the
Rapid SQL SQL Editor.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL
application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on

page 717.

Use the following table as a guide to modifying settings on this tab:

Max Errors Before
Aborting Execution

Sets the maximum number of errors allowed before aborting the execution of a script. A
zero indicates that the option is inactive and that you recognize no limit to the number of
errors allowed. Rapid SQL refers to this value when step executing SQL scripts.

Execute Selected Text

Executes a portion of a selected SQL script.
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Check Syntax When
Executing

For DB2, required to execute DB2 call statements in the ISQL Window.

Automatically lock
connection

When disabled, a prompt to commit or rollback the transaction is displayed when you
close the ISQL editor window. Enabling this options disables the prompts and locks the
connection automatically.

Prompt to lock
database connection

Locks the database connection on execution.

Tabs

Sets the appearance of the ISQL Window tabs to either the top or bottom of the ISQL
Window.

File Association

Specifies whether the application should open an unknown file type automatically into an
ISQL Window or prompt you with a message that Rapid SQL does not recognize the file

type.

Query Plan Layout

Sets the default orientation of a graphical query plan.For more information, see "Setting
up the Execution Environment with Query options" on page 749.

ISQL OPTIONS - ORACLE TAB

The Options Editor's ISQL > Oracle tab controls the appearance and behavior of the Rapid SQL
SQL Editor when executing against an Oracle environment.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQOL
application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on

page 717.

Use the following table as a guide to modifying settings on this tab:

Option

Description

Enable DBMS Output

Lets you specify Buffer size. 0 is the default.

Auto-Commit changes

Applies auto commit status changes to all open windows.

View xmltype as clob

When enabled, xmltype columns are displayed as CLOBs in the Results grid and the Data
editor. Without this option selected, SELECT statements that qualify xmltype columns
produce an OciTypeBinder conversion error. With the option selected, the SELECT
submitted by Rapid SQL is modified to include a getclobval() method call.

Retain connection in
pool after use

This option determines what happens to a connection after it is unlocked by the ISQL
window. If selected, the connection will be returned to the application connection pool. If
unselected, the unlocked connection will be disconnected.

Default Query Plan

Lets you select the default display, tree-based or graphical, when you generate a query
plan. For more information, see "Viewing a Tree-based or Graphical Query Plan (Oracle)"
on page 765.
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Option Description

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that
customize your execution environment, and periodically sends those settings to the
server. Enabling this option and specifying an XML file, forces Rapid SQL to load a
previously saved query options file each time an ISQL windows opens against this DBMS
platform. This lets you override Rapid SQL's default query options.

You can also enable this option when saving a query options file. For information on
other load and save options, specific query options offered, manually updating query
options, and conditions for which query options are sent to the server, see "Setting up
the Execution Environment with Query options" on page 749.

ISQL OPTIONS - DB2 TAB

The Options Editor's ISQL > DB2 tab controls the appearance and behavior of the Rapid SQL
SQL Editor when executing against aDB2 LUW environment.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on
page 717.

Use the following table as a guide to modifying settings on this tab:

Option Description

Set Isolation Level Sets the default for the value of the Isolation Level option on the Query Options
dialog.For details, see "Setting up the Execution Environment with Query options" on
page 749.

Auto-Commit changes | Applies auto commit status changes to all open windows.

Create Explain plan If set to TRUE, Explain Plan tables are created, as necessary. If set to FALSE and you don't

tables if required manually create tables, Explain Plan operations will fail.

Create explain plan If set to TRUE, Explain Plan tables are created on the SYSTOOLS schema. If the tables

tables on the already exist in the user’s default schema, Rapid SQL continues to use those tables. Refer

SYSTOOLS schema to DB2 documentation for a listing of Explain Plan tables that must be deleted in order to

use the SYSTOOLS option. If set to FALSE, Explain Plan tables are created under the
user’s default schema.

Retain connection in This option determines what happens to a connection after it is unlocked by the I1SQL
pool after use window. If selected, the connection will be returned to the application connection pool. If
unselected, the unlocked connection will be disconnected.

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that
customize your execution environment, and periodically sends those settings to the
server. Enabling this option and specifying an XML file, forces Rapid SQL to load a
previously saved query options file each time an ISQL windows opens against this DBMS
platform. This lets you override Rapid SQL's default query options.

You can also enable this option when saving a query options file. For information on
other load and save options, specific query options offered, manually updating query
options, and conditions for which query options are sent to the server, see "Setting up
the Execution Environment with Query options" on page 749.
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ISQL OPTIONS - SYBASE TAB

The Options Editor’s ISQL > Sybase tab controls the appearance and behavior of the Rapid SQL
SQL Editor when executing against a Sybase ASE environment.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SOL

application and feature options" on page 79.

NOTE:

For information on using the SQL Editor, see "Coding Environments/Editors" on
page 717.

Use the following table as a guide to modifying settings on this tab:

Option

Description

Auto-Commit changes

Applies auto commit status changes to all open windows.

Retain connection in
pool after use

This option determines what happens to a connection after it is unlocked by the I1SQL
window. If selected, the connection will be returned to the application connection pool. If
unselected, the unlocked connection will be disconnected.

Load Query Options

If this option is not enabled, Rapid SQL loads a set of default query options that
customize your execution environment, and periodically sends those settings to the
server. Enabling this option and specifying an XML file, forces Rapid SQL to load a
previously saved query options file each time an ISQL windows opens against this DBMS
platform. This lets you override Rapid SQL's default query options.

You can also enable this option when saving a query options file. For information on
other load and save options, specific query options offered, manually updating query
options, and conditions for which query options are sent to the server, see "Setting up
the Execution Environment with Query options" on page 749.

ISQL OPTIONS - SYBASE 1Q TAB

The Options Editor's ISQL > Sybase 1Q tab controls the appearance and behavior of the Rapid
SQL SQL Editor when executing against aSybase 1Qr environment.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SOL

application and feature options" on page 79.

NOTE:

For information on using the SQL Editor, see "Coding Environments/Editors" on
page 717.

Use the following table as a guide to modifying settings on this tab:

Option

Description

Enable Set Query
Options

Sets the default value of the Send Set Options setting on the Query Options dialog. For
details, see "Setting up the Execution Environment with Query options" on page 749.
Changing this value does not affect ISQL sessions currently open.

Auto-Commit changes

Applies auto commit status changes to all open windows.

Retain connection in
pool after use

This option determines what happens to a connection after it is unlocked by the I1SQL
window. If selected, the connection will be returned to the application connection pool. If
unselected, the unlocked connection will be disconnected.
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Option

Description

Load Query Options

If this option is not enabled, Rapid SQL loads a set of default query options that
customize your execution environment, and periodically sends those settings to the
server. Enabling this option and specifying an XML file, forces Rapid SQL to load a
previously saved query options file each time an ISQL windows opens against this DBMS
platform. This lets you override Rapid SQL's default query options.

You can also enable this option when saving a query options file. For information on
other load and save options, specific query options offered, manually updating query
options, and conditions for which query options are sent to the server, see "Setting up
the Execution Environment with Query options" on page 749.

ISOL OPTIONS - SQOL SERVER TAB

The Options Editor’s ISQL > SQL Server tab controls the appearance and behavior of the Rapid
SQL SQL Editor when executing against aSQL Server environment.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on

page 717.

Use the following table as a guide to modifying settings on this tab:

Option

Description

Enable Set Query
Options

Sets the default value of the Send Set Options setting on the Query Options dialog. For
details, see "Setting up the Execution Environment with Query options" on page 749.
Changing this value does not affect ISQL sessions currently open.

Auto-Commit changes

Applies auto commit status changes to all open windows.

Retain connection in
pool after use

This option determines what happens to a connection after it is unlocked by the 1SQL
window. If selected, the connection will be returned to the application connection pool. If
unselected, the unlocked connection will be disconnected.

Load Query Options

If this option is not enabled, Rapid SQL loads a set of default query options that
customize your execution environment, and periodically sends those settings to the
server. Enabling this option and specifying an XML file, forces Rapid SQL to load a
previously saved query options file each time an ISQL windows opens against this DBMS
platform. This lets you override Rapid SQL's default query options.

You can also enable this option when saving a query options file. For information on
other load and save options, specific query options offered, manually updating query
options, and conditions for which query options are sent to the server, see "Setting up
the Execution Environment with Query options" on page 749.
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ISQL OPTIONS - MYSQL TAB
The Options Editor's ISQL > MySQL tab controls the appearance and behavior of the Rapid
SQL SQL Editor when executing against a MySQL environment.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on
page 717.

Use the following table as a guide to modifying settings on this tab:

Option Description
Retain connection in This option determines what happens to a connection after it is unlocked by the 1SQL
pool after use window. If selected, the connection will be returned to the application connection pool. If

unselected, the unlocked connection will be disconnected.

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that
customize your execution environment, and periodically sends those settings to the
server. Enabling this option and specifying an XML file, forces Rapid SQL to load a
previously saved query options file each time an ISQL windows opens against this DBMS
platform. This lets you override Rapid SQL's default query options.

You can also enable this option when saving a query options file. For information on
other load and save options, specific query options offered, manually updating query
options, and conditions for which query options are sent to the server, see "Setting up
the Execution Environment with Query options" on page 749.

ISQL OPTIONS - DB2 OS390 TaAB
The Options Editor’s ISQL > DB2 OS390 tab controls the appearance and behavior of the
Rapid SQL SQL Editor when executing against a DB2 z/OS environment.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on
page 717.

Use the following table as a guide to modifying settings on this tab:

Option Description

Retain connection in This option determines what happens to a connection after it is unlocked by the I1SQL

pool after use window. If selected, the connection will be returned to the application connection pool. If
unselected, the unlocked connection will be disconnected.
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Option

Description

Load Query Options

If this option is not enabled, Rapid SQL loads a set of default query options that
customize your execution environment, and periodically sends those settings to the
server. Enabling this option and specifying an XML file, forces Rapid SQL to load a
previously saved query options file each time an ISQL windows opens against this DBMS
platform. This lets you override Rapid SQL's default query options.

You can also enable this option when saving a query options file. For information on
other load and save options, specific query options offered, manually updating query
options, and conditions for which query options are sent to the server, see "Setting up
the Execution Environment with Query options" on page 749.

ISOL OPTIONS - INTERBASE TAB

The Options Editor’s ISQL > InterBase tab controls the appearance and behavior of the Rapid
SQL SQL Editor when executing against an InterBase/Firebird environment.

NOTE: Forinform

ation on opening the Options Editor, see "Specifying Rapid SOL

application and feature options" on page 79.

NOTE: Forinform
page 717.

ation on using the SQL Editor, see "Coding Environments/Editors" on

Use the following table as a guide to modifying settings on this tab:

Option

Description

Retain connection in
pool after use

This option determines what happens to a connection after it is unlocked by the I1SQL
window. If selected, the connection will be returned to the application connection pool. If
unselected, the unlocked connection will be disconnected.

Load Query Options

If this option is not enabled, Rapid SQL loads a set of default query options that
customize your execution environment, and periodically sends those settings to the
server. Enabling this option and specifying an XML file, forces Rapid SQL to load a
previously saved query options file each time an ISQL windows opens against this DBMS
platform. This lets you override Rapid SQL's default query options.

You can also enable this option when saving a query options file. For information on
other load and save options, specific query options offered, manually updating query
options, and conditions for which query options are sent to the server, see "Setting up
the Execution Environment with Query options" on page 749.

ISQL OPTIONS - TERADATA TAB

The Options Editor’s ISQL > Teradata tab controls the appearance and behavior of the Rapid
SQL SQL Editor when executing against a Teradata environment.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQOL

application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on

page 717.

RAPID SQL 8.7.2/XEé6 USER GUIDE 103




SPECIFYING RAPID SQL APPLICATION AND FEATURE OPTIONS

Use the following table as a guide to modifying settings on this tab:

Option Description
Retain connection in This option determines what happens to a connection after it is unlocked by the I1SQL
pool after use window. If selected, the connection will be returned to the application connection pool. If

unselected, the unlocked connection will be disconnected.

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that
customize your execution environment, and periodically sends those settings to the
server. Enabling this option and specifying an XML file, forces Rapid SQL to load a
previously saved query options file each time an ISQL windows opens against this DBMS
platform. This lets you override Rapid SQL's default query options.

You can also enable this option when saving a query options file. For information on
other load and save options, specific query options offered, manually updating query
options, and conditions for which query options are sent to the server, see "Setting up
the Execution Environment with Query options" on page 749.

ISQL OPTIONS - EDITOR TAB

The Options Editor's ISQL > Editor tab controls the appearance and behavior of the Rapid SQL
SQL Editor window.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQOL
application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on
page 717.

The table below describes the options and functionality on the Editor tab:

Group Option Description Default
Window Show Toolbar | Enables/disables these ISQL Window user interface elements. Selected
and Show
Status Bar
Maximize on Indicates that Rapid SQL should maximize the ISQL Editor. If you Selected
new or open already have an active MDI Window that is maximized, the default

behavior is to maximize a new child window. To deactivate this
option, ensure you do not have any active MDI Windows, such as the
Explorer.

File Tracking Indicates that the ISQL Editor should use the File Tracking Facility to | Selected
monitor the status of a file. If a file has been modified and saved
outside the application, the application loads the most current
version of the file into the [ISQL Editor based on the options set for
Auto-Reload File (see above.)

Auto-Reload If File Tracking is enabled, indicates that the application should Not

File automatically reload a file that has been externally modified without | selected
prompting you. If you turn this option off, Rapid SQL prompts you
before reloading your file if external changes have been saved.
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Group Option Description Default
Auto-Save File | Indicates that files in the ISQL Editor should automatically be saved | Selected
at the indicated time interval. Backup files are saved to: (5
In Rapid SQL, %APPDATA%\RapidSQL\Backup\. minutes)
Backup files use a naming convention of the form ~ETxxxx.tmp.. For
a listing of backup file names and the path of the file to which they
correspond, see the registry key:
In Rapid SQL,
HKEY_CURRENT_USER\Software\Embarcadero\RapidSQL\versio
n\Backup
Command Save File Specifies the action you want the application to take when selecting | Ask First
History Before a command from the Command History box. You have the option to
Overwriting be reminded to save a file before overwriting (Ask First), to
automatically save a file before overwriting (Always), or to
automatically overwrite the file with the command (Never).
Save Most Specifies the number of commands you want to save in the 15
Recent Command History list in the top of the ISQL Window toolbar. The
maximum value is 99.
Printing Lets you select common printer options.
Appearance | Enable Syntax | Sets syntax highlighting on so that all keywords and comments are | Selected
Highlighting colored for easier reading and debugging.
Show Line Places line numbers in the left column of an ISQL Window. Selected
Numbers
Enable Enables and disables outlining. Selected
Outlining
Enable Text Enables and disables a typical text wrap feature. Selected
Wrapping
Editor Font Sets the font face, style, and size displayed in the editor. Available
Syntax Colors | Sets syntax coloring for keywords, comments, quotes, and default Available
text for various file types and scripts from the Syntax Coloring
dialog.
Formatting Auto Indent Sets automatic indentation for each carriage return, new line in your | Selected
SQL script.
Expand Tabs Sets tabs as the specified number of spaces in result sets. Selected
and Tab Size 4)
Clipboard None When copying text from the editor, no substitution is made for end- | Selected
Line Endings of-line characters. This provides the fastest cut and paste operation.
Line Endings When copying text from the editor, end-of-line characters are

replaced with platform-specific equivalents (Windows - CR LF, UNIX -
LF, Macintosh - CR). This lets you copy text into environments such as
Notepad, that require platform-specific end-of-line characters.

This option avoids unnecessary characters and incorrect display, but
cut-and-paste operations take more time to complete.

ISQL OPTIONS - AUTO FORMAT TAB
After opening the Options editor, you can make changes to the Auto Format tab. of the ISQL

pane.
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The Options Editor's ISQL > Auto Format tab lets you specify the style and spacing of SQL
statements in an ISQL window when you choose to auto format SQL in the ISQL editor.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SQL

application and feature options" on page 79.

NOTE:

For information on using the SQL Editor, see "Coding Environments/Editors" on

page 717.

On opening, the Preview area shows an SQL statement formatted according to the current
Auto Format settings. Click Edit to open the Auto Format Options dialog. Use the following
table as a guide to understanding and modifying the settings in this dialog:

Setting Description

Keywords Lets you select a character case (UPPERCASE, LOWERCASE, INITIALCAPS, or NOCHANGE)
formatting treatment for SQL keywords.

Right Margin Specifies the maximum number of characters per line.

New line before

If enabled, a new line is forced before every SQL keyword. If disabled, lines are only forced for

keyword statement type and clause type keywords.
BEGIN..END block | If enabled, empty BEGIN..END blocks occupy a single line.
Stack lists If enabled, a new line and indenting is forced for each item in comma-separated list such as

argument lists.

List indent size

If Stack lists is enabled, this control lets you specify the number of spaces each list item will
be indented from the current offset.

Parenthesis indent
size

Lets you specify the number of indenting spaces for forced lines following an open
parenthesis.

Conditions format
style

Specifies how conditions in clauses are formatted:
CONDITIONS_WRAPPED - lines are not forced before conditions.

CONDITIONS_STACKED_WITH_LEADING_OPERATORS - a new line is forced for each
condition in a clause, with logical operators, if present for a line, displayed at the start of the
line.

CONDITIONS_STACKED_WITH_TRAILING_OPERATORS - a new line is forced for each
condition in a clause, with logical operators, if present for a line, displayed at the end of the
line.

Conditions stack
threshold

For Conditions format style selections that specify stacking, this value specifies the minimum
number of conditions that must appear in a clause before conditions are stacked.

THEN statements

If enabled, simple THEN clauses are kept to a single line.

ISQL OPTIONS - CODE ASSIST TAB
Code assist options are available on the following tabs:

e |SQOL Options - Code Assist - Main Tab

¢ |SOL Options - Code Assist - Advanced Tab
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ISQL OPTIONS - CODE ASSIST - MAIN TAB
The Options Editor's ISQL > Code Assist tab lets you activate and select options for coding
assistance and error-detection features available from the ISQL editor:

Code Complete - lets you insert or replace object names, selected from suggestion lists, as
you edit a script. For more information, see "Code Complete" on page 737.

Semantic validation - detects object name references to objects not present in the
datasource index. For more information, see "Semantic Validation" on page 736.

Real-time syntax checking - on-the-fly syntax checking is performed as you type. For more
information, see "Syntax Checking" on page 735.

Hyperlinks - lets you invoke object actions against objects referenced in a script. For more
information, see Hyperlink Object Actions.

Object metadata display - lets you view Connect server metadata for referenced objects.
For details, see "Viewing Embarcadero Team Server Model Metadata in the SOL Editor" on
page 175.
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The ISQL - Code Assist tab has the following settings:

Group/Option

Description

Code Complete

Enable Code Complete

Lets you enable or disable the Code Complete feature.
When disabled, Code Complete cannot be invoked
automatically or manually.

Because of the overhead in maintaining internal resources
used in implementing this feature, a slight performance
increase can result from disabling the feature.

Enable auto-activation and
Auto-activation delay

When auto-activation is disabled, the Code Complete
feature must be invoked manually. When auto-activation is
enabled, the Code Complete feature is invoked
automatically each time the interval between keystrokes
exceeds the specified Auto-activation delay.

Insert single proposals
automatically

Specifies that if a Code Complete suggestion list would
contain only a single suggestion, that suggestion is inserted
automatically.

Fully qualify completions
automatically

Specifies that Code Complete results are returned fully
qualified, rather than the minimum required to identify the
object.

Code Validation

Enable Real-time syntax
checking

If enabled, syntax-checking is performed as you type. If
disabled, syntax checks must be initiated manually.

Severity levels for semantic
validation problems

Lets you select the severity level (ERROR, WARNING, or
IGNORE) associated with detected semantic errors. The
WARNING option provides a contrast to syntax errors,
which are always flagged with a severity level of ERROR.The
IGNORE setting disables the feature. For more information,
see "Semantic Validation" on page 736.

Perform syntax and
semantic validation on files
smaller than

Places an upper limit on the size of files for which automatic
syntax checking and semantic validation are active.

DB Action Menu

Enable DBAction menu in
the editor

Enables the Hyperlinks feature.

Show DB Actions in
submenu

If unselected, Hyperlink menu actions are available as first
level options in the context menu. If selected, Hyperlink
menu actions are available as a DB Actions submenu.

Key used in conjunction
with right-mouse

Lets you select the key (CTRL, SHIFT, or CTRL+SHIFT) used
in conjunction with right-clicking, that activates the object
action menu against a supported object type reference in a
script.

The default keystroke combination is CTRL+right-click.

Restore defaults

Restores all settings on the tab to the original defaults.

Metadata

Enables display/use of metadata for referenced objects, obtained from a Connect server
repository, in the following user interface elements: tooltips, window gutter, code and
complete proposals. You can also have metadata added as comments when formatting

code.

For detailed information on setting up and using this feature, see "Viewing Embarcadero
Team Server Model Metadata in the SOL Editor" on page 175.

NOTE:
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application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on
page 717.

ISQL OPTIONS - CODE ASSIST - ADVANCED TAB
Coding assistance and error detection features such as Hyperlink object actions, Code
Complete, and Semantic Validation rely on:

e Parsing of SQL entered in the SQL Editor into keywords, object name references, data, and
so on

e A database object index that Rapid SQL generates for a connected datasource. On the first
connection to a datasource, Rapid SQL generates an index of specified object types, with an
imposed, configurable, upper limit on the number of objects contained in the index. On
each subsequent connection, Rapid SQL updates the index to reflect any additions or
changes on the datasource.

NOTE: The object index is stored in a persistent database with a database path of %TEMP%.
With that in mind, the index may be deleted by the system administrator or automated
administration-related processes.

When coding assistance and error detection features are enabled, Rapid SQL queries the
index for the names of objects referenced in your scripts queries. This information is then
used for tasks such as recognizing object types, detecting misspelled object names, and

populating suggestion lists.

The Options Editor’'s ISQL > Code Assist > Advanced tab lets you force parsing, if required,
and customize how the index is generated. Since there is performance overhead associated with
generation and usage of the index, you can control the properties and usage of the index.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

The table below describes the options and functionality on the ISQL > Code Assist >
Advanced Tab of the Options Editor:

Option Description

Scan entire file for context This control is enabled only if the ISQL > Code Assist tab’s Enable
Real-time syntax checking check box is deselected and the Severity
levels for semantic validation problems is set to IGNORE.

When this control is enabled, Rapid SQL will continue to parse SQL
Editor content. That is, if you have disabled real-time syntax checking
and effectively disabled semantic validation, you can still use the
Hyperlinks feature.

Limit scanning to files smaller than Lets you place an upper limit on the size of files parsed for Code Assist
features.
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Option

Description

Obiject types to be indexed

Lets you select specific object types (aliases, synonyms, functions,
packages, procedures, tables, or views) that will be included in the
object index. While this can be used to reduce the index size and
therefore improve performance, Hyperlinks, Semantic Validation, and
Code Complete functionality associated with object types not
included in the index will not be available.

Recycle cache space when index size
exceeds

This imposes a soft ceiling on the number of objects stored in the
index. After updating the index on connection to a datasource, the
total number of objects in the index is compared to this value. If the
value is exceeded, Rapid SQL deletes the oldest definitions.

The maximum number of results to
return when querying the object index

Specifies the number of results when querying against the cache
databases, to improve performance when working with large
databases. This limit is applied per object type.

Refresh

Each time you open an ISQL editor window, Rapid SQL obtains
schema information for the object types supported for the Code
Complete and Semantic Validation features. That information is
updated with any modifications that you make and persists until the
window is closed. The Refresh button ensures that the information is
current in case other users or applications are modifying the schema
while the current SQL editor session window is open.

JAava OPTIONS

Rapid SQL requires a JDBC connection. The Options Editor's Java tab lets you set or change
options that apply to the Java virtual machine (JVM) that is running on the client.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

The table below describes the options and functionality of the Java tab:

Option Description Default
JVM Options:
Initial Heap Size Set the size, in MB, for the repository where live and dead objects comingle with | 64 MB
free memory. If memory runs out, JVM executions stop so the garbage can be
collected and expunged. Each platform responds differently, so trial and error
can help you maximize performance.
Maximum Heap Size | Set the upper limit for your heap size. 64 MB
Maximum Perm Gen | Set the upper limit for the permanent generation size. Version-
specific
Additional Options Add options here ONLY in consultation with Embarcadero Technical Support. N/A
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LDAP CONFIGURATION OPTIONS

When using the Discover Datasources feature, Rapid SQL can search an LDAP Server for
datasources. Similarly, when manually registering a datasource, you can select from server names
obtained from an LDAP Server. The LDAP Configuration tab of the Options Editor lets you
provide the information required to establish a session with the LDAP Server and obtain the
required datasource information.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SOL

application and feature options" on page 79.

The table below describes the options and functionality on the LDAP Configuration tab:

Group Option Description
Enable LDAP Enables LDAP lookup. This check box must be selected in order for the
Discover Datasources feature to search an LDAP Servers or for server
names obtained from an LDAP server to be available when manually
registering datasources.
Server Host Port The FQDN or IP address of the LDAP server.

Search Base DN and
Suggest

Lets you provide the distinguished name to be used as the search
base.

The Suggest button is only enabled after you select an authentication
type and provide details, as required. It queries the server for possible
DNs and populates the combo box with the results.

Authentication

Anonymous Login

Selecting this check box directs Rapid SQL to send LDAP requests
without performing a bind. This also disables the other Authentication
controls.

User, Password , and
Remember

Let you provide the credentials used when sending LDAP requests.

Options

Size Limit and Time
Limit

Lets you specify the maximum number of entries returnable and the
maximum time, in seconds, to wait for the search to complete.

Protocol Version

The LDAP protocol version.

For more information, see:

o Manually Reqistering or Editing Datasources on page 123

e Automatically Discovering Datasources on page 136

LOGGING OPTIONS

After opening the Options editor (see Specifying Rapid SQL application and feature options),
you can make changes to the Logging tab. The Logging tab lets you set defaults that specify the
behavior and placement of SQL Logging and Output Logging.
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The table below describes the options and functionality on the Logging tab:

Option Description Default
Log all SQL | Indicates that the application should log all of the SQL that it executes to a file. SQL Not
Statements logging provides an audit trail for Rapid SQL. You can examine this log to determine the | selected
to a File SQL executed to complete a task.
Logfile Path | If you choose to log the SQL generated by the application, specify the drive, directory, | None
and file name.
Max File Size | Specifies the maximum size for the logfile. When the lodfile reaches this threshold, it 1024 KB
automatically starts deleting lines in the lodfile (starting with the oldest statements) to
remain within the specified size limit.
Truncate Empties the entire contents of the lodfile. Not
available
Log all Indicates that the application should log all server messages sent to the Output window. | Not
Output This type of logging lets you monitor only messages issued by the server versus all SQL | selected
Messages to | logged by the application. You can examine this log to determine all messages the
a File server issued.
Logfile Path | If you choose to log the server messages generated in the Output window, specify the | None
drive, directory, and file name.
Max File Size | Specifies the maximum size for the output logfile. When the output logfile reaches this | 1024 KB
threshold, it automatically starts deleting lines in the file (starting with the oldest
statements) to remain within the specified size limit.
Truncate Empties the entire contents of the output lodfile. Not
available

MYSQL UTILITIES OPTIONS

Rapid SQL integrates with MySQL utilities. For Rapid SQL to access these utilities, you need to
specify their location in the MySQL Utilities tab of the Options Editor. You can use the MySQL
Dump and Import Utilities.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SQL
application and feature options" on page 79.

The table below describes the options and functionality on the MySQL Utilities tab

Option

Description

mysqldump

in the C:\mysql\bin directory.

Specifies a path for the MySQL dump utility, mysgldump.exe. By default, MySQL installs this utility

mysqlimport

utility in the C:\mysgl\bin directory.

Specifies a path for the MySQL import utility, mysglimport.exe. By default, MySQL installs this

RAPID SQL 8.7.2/XE6 USER GUIDE




SPECIFYING RAPID SQL APPLICATION AND FEATURE OPTIONS

ORACLE UTILITIES OPTIONS

Rapid SQL integrates with multiple Oracle utilities. For Rapid SQL to access these utilities, you
need to specify their location on the Oracle Utilities tab of the Options Editor. You can use the
Oracle Export, Import Utilities, and SQL * Loader.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

The table below describes the options and functionality on the Oracle Utilities tab:

Option Description

Data Pump Export Specifies a path for the Oracle expdp.exe utility.

Data Pump Import Specifies a path for the Oracle impdp.exe utility.

Export Specifies a path for the Oracle Export utility. By default, Oracle installs to C:\Orant\Bin
directory.

Import Specifies a path for the Oracle Import utility. By default, Oracle installs to C:\Orant\Bin
directory.

SQL*Loader Specifies a path for the SQL * Loader utility. By default, Oracle installs to C:\Orant\Bin
directory.

Default Bind Size Specifies the bind size. Default is set to 70KB.

QUERY BUILDER OPTIONS

The Options Editor's Query Builder Options tab lets you specify operational and execution
preferences for the Query Builder. Option parameters set on the Options Editor elicit a prompt if
there are different options set on an open individual session. Global options override properties
set within individual Query Builder sessions.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL
application and feature options" on page 79.

NOTE: For information on using the Query Builder, see "Query Builder" on page 838.

The table below describes the options and functionality on the Query Builder tab:

Interface Option Description Default
Element

Code Generate Use Database | Adds a line of SQL code indicating which database or Selected
Generation statement instance is used in the statement.

Generate owner names | Adds a line of SQL code showing the table owner name | Selected
as part of the query.

Include Row Count Includes the output row limit set in the Execution Not
limits settings. selected
Generate SQL/92 if SQL/92 is a standard for relational database Not
supported by DBMS management systems. selected
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Interface Option Description Default

Element

Execution To set the maximum number of rows in your result set, type the number in the 1000
dialog. This lessens congestion of server processes when queries execute by setting | rows

row count limits.

General Show Column Data Reveals the data type in each column for tables in the Not
types in Query Diagram | SQL Diagram pane. selected

Confirm on Item delete | Opens a Confirm Delete dialog when an item is deleted. | Selected

Auto Populate Views Checks syntax every time an execute statement, refresh | Not
or copy statement begins. Selected

Auto Format Automatically sets style and spacing of display. Selected

Auto Join Run Automatically Automatically detects names and data types, and create | Selected
joins for multiple tables.

Require Indexes Joins only indexed columns. Requires an indexed Selected
column for joins.

Require same data type | Automatically joins columns with the same data type. Selected

Syntax Checker | Automatic Syntax Automatically checks SELECT and CREATE VIEW Selected

Check statements for errors.

Warn on non index join | Returns a warning when it detects a join against a non- | Not
indexed column, or a column not participating in a selected
primary key

Display Lets you sets the style, size, and color of Column Font and Title Font. Also lets you | Available
set the background Table Color for the SQL Diagram Pane.

REPORTS OPTIONS
The Options Editor's Reports tab lets you:

* Append a date and timestamp to report file names. This prevents existing reports from
being overwritten.

e Save reports in date-specific folders.

e Save reports in PDF format as opposed to HTML.

e Letyou include a provided image and title to reports.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SQL

application and feature options" on page 79.

NOTE:

For information on generating reports, see "Report" on page 6%94.
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RESULTS (ISQL) OPTIONS

The Options Editor’s Results tab lets you specify operational and appearance details for Rapid
SQLl's SQL Editor.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SQL
application and feature options" on page 79.

NOTE: For information on using the SQL Editor, see "Coding Environments/Editors" on
page 717.

The table below describes the options and functionality on the Results tab:

Interface Element | Options and descriptions

Results Option Result Window | Single Window - Displays all results in one tabbed result window. Multiple
pane result sets together in the window. Single Window and Multiple Windows
options are mutually exclusive.

Multiple Windows - Displays multiple result sets one result set per window.

Attached to Editor - Sets results as tabbed windows attached to the I1SQL
window. Used in conjunction with Single Window option or Multiple
Window option. Attached and Unattached options are mutually exclusive.

Unattached - Sets results appear separate from the ISQL Window. Used in
conjunction with Single Window option or Multiple Windows option.

Reuse Window - Sets new result sets to overwrite any current result sets in
an open Result Window. Only valid for Single and Attached to Editor
combination.

Results File Mail File Type - Selects the file type to use when sending result sets via a
MAPI-compliant mail package. Valid formats include the proprietary Results
type, Tab delimited, Comma separated, and HTML.

Schedule File Type - Selects the schedule file type. Valid formats include
Tab delimited, Comma separated, and HTML.

Include column titles when saving - Includes column titles when saving a
result set. If this option is turned off, column titles Rapid SQL does not save

result sets.
Result Set Default Rowcount - Lets you limit the number of rows returned to the
Options result window of the ISQL window (default 0).
Sybase ASE and SQL Server: Text Size (bytes) - Lets you specify the text
size (default 8192).

Oracle:LONG Size (bytes) - Lets you specify the LONG size (default 8192).

LOB Preview: Text Size (bytes) - Specifies the length of the preview of
LOB column data (default 4096).

Sort Type Lets you select a result sorting: Alphameric or Lexicographic.
Format pane Column Auto Format (Best Fit) - Sets column widths automatically to
Formatting accommodate the longest piece of data in a column. Large queries
depend on the longest row formatting, so activating this option can affect
performance.

Use pre-defined column - Lets you select column type and character
length
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Interface Element

Options and descriptions

Enable Date/
Time Format

Lets you select the date/time format.

Format

that are already open.

already open.

already open.

formatted according to the C locale.

Standard Grid - Displays all result sets in a standard grid format. Rapid
SQL displays result sets in grid format in [ISQL Editors that are opened after
you have selected this option. Rapid SQL does not display IISQL Editors

HTML - Displays all result sets as HTML tables. Rapid SQL displays result
sets in HTML format in ISQL Editors that are opened after you have
selected this option. Rapid SQL does not display ISQL Editors that are

ASCII Text - Displays all result sets as ASCII Text. Rapid SQL displays result
sets in ASCII Text format in ISQL Editors that are opened after you have
selected this option. Rapid SQL does not display ISQL Editors that are

Grid Font and Printer Font buttons - Open a Font dialog, letting you
select the font, style, and size for the result sets grid or printed result sets.

Enable Locale - If selected, numbers are formatted (thousands separator,
decimal separator) as locale-specific strings. If unselected, numbers are

SMTP MaAIL OPTIONS

The Options Editor's SMTP Mail Options tab lets you specify outgoing notification e-mail

message options.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SQOL

application and feature options" on page 79.

The table below describes the options and functionality on the SMTP Mail tab:

Option

Description

Default

Send messages through
SMTP

Enables SMTP messaging and makes the other controls
on this tab available.

Unselected

Name

Name that appear as the e-mail sender.

Name you specified
during installation.

E-mail Address

Address to send e-mails from Rapid SQL.

E-mail address you
specified during
installation.

Authentication

Lets you specify authentication options.

None

Outlook, select Tools, and then Accounts. On the Mail
tab, select target account, and then click Properties. On
Servers tab, copy the Outgoing Mail(SMPT) and paste.

User Name User name for authentication. Not available
Password Password for authentication. Not available
Host Name SMTP server for outgoing messages. For Microsoft Host Name you specified

during installation.
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Option Description Default
Port Number Port number you connect to on your outgoing SMTP 25
server.
Test Opens an SMTP Configuration Test e-mail addressed to | Available
your e-mail address. Click Send Mail to send the e-mail.
Bind to Your IP address the message is bound to. ANY_IP_ADDRESS
Encoding E-mail encoding. Western Europe (ISO)
Send messages Mime Messages encoded using Multipurpose Internet Mail Selected
encoded Extensions (MIME) support enriched content and
attachments.
Send all messages as HTML | Messages include text formatting. Selected
Auto Connect to the Rapid SQL connects to internet at launch. Selected
Internet

TEAM SERVER OPTIONS

The Team Server tab of the Options Editor integrates Rapid SQL with Embarcadero Team
Server, a data governance metadata repository.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

The table below describes the options and functionality on the Team Server tab:

Option Description
Use Team Server Enables use of the Embarcadero Team Server repository.
Connect URL The login URL of the Team Server repository.

NOTE: These controls can be set or disabled using registry entries. For details, see "Locking
Down Rapid SOL Features Using the Registry" on page 119.

For more information on repository-based resources, see "DB Team Server Support" on
page 167.

VERSION CONTROL OPTIONS

The Options Editor’'s Version Control tab lets you select which version control system you want
Rapid SQL to use as the underlying version control system.

NOTE: For information on opening the Options Editor, see "Specifying Rapid SOL
application and feature options" on page 79.

NOTE: For information on version control in Rapid SQL, see "Version Control" on page 803.
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The table below describes Version Control options:

SourceSafe database unless you override this setting by entering the
path for the SourceSafe file associated with the desired database. To
use a SourceSafe database other than the default, provide a user
name, password, and the location of a scrsafe.ini file.

Option Description Default
Specify Version Lists the Version Control systems that integrate with Rapid SQL. Select | None
Control System the option button for the product you want Rapid SQL to use.

Optional Fields If you select Microsoft Visual SourceSafe, Rapid SQL uses your default | Optional

WARNINGS OPTIONS

Rapid SQL lets you issue warning messages to users whenever improper operations are
attempted in a database. Warning messages differ by platform. The Options Editor's Warnings
tab lets you select the DBMS-specific events that generate warnings.

NOTE:

For information on opening the Options Editor, see "Specifying Rapid SQL

application and feature options" on page 79.

The tables below describes the options of the Warnings tab:

or temp tablespace as the
SYSTEM tablespace

temp tablespace on the SYSTEM tablespace.

Option Description Platform
Create an index on the Issues a warning message whenever a user does not create an index | DB2
same tablespace as the on a different tablespace than the table. This makes it possible for

associated table the server to read the index and table data in parallel.

Create an index on the Issues a warning message whenever a user does not create an index | Oracle
same tablespace as the on a different tablespace than the table. This makes it possible for

associated table the server to read the index and table data in parallel.

Create an object in the Issues a warning message whenever a user tries to create or place | Oracle
SYSTEM tablespace an object on the SYSTEM tablespace.

Create a user with default | Issues a warning message when a user is created with a default or | Oracle

Create an object in the

Issues a warning message when an object is created in the master

Microsoft SOL

master database database. Server and
Sybase ASE
Create a table or index on | Issues a warning message when a table or index is created on the | Microsoft SQL
the default segment default segment. Server and
Sybase ASE
Create a non-clustered Issues a warning message when a non-clustered index is created on | Microsoft SQL
index on same segment as | the same segment as the associated table. Server and
the associated table Sybase ASE
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LOCKING DOWN RAPID SQL FEATURES USING THE REGISTRY

Administrators can restrict certain Rapid SQL features on individual machines through registry
settings. Those settings are stored in the following location:

* In Rapid SQL, HKLM\Software\Embarcadero\Rapid SQL optional version identifie\Admin

The following general datasource and connection settings are available:

Name (and Type) Description and Supported Values

RestrictedPlatforms (REG_S?) A comma-separated list (db2=0,mssqlserver=1 , for
example) dictating DBMS platform support on the
machine. Valid names for the name=value pairs are db2,
0s390, mssqlserver, mysql, oracle, sybase, interbase,
mssqlazure, odbc, jdbc, and sybaseiq. Any non-zero value for a
name=value pair results in that platform not being unavailable to
Rapid SQL on that machine. A zero value (the default) results in
the platform being available on that machine.

DisableAutoConnect (REG_DWORD) When set to any non-zero value, users cannot use the auto-
connect feature when registering or logging in to a datasource.

SharedDatasourceCatalogPath (REG_SZ) Providing a path to the network shared datasource catalog forces
Rapid SQL to use that datasource catalog storage option.
Registry-based and file-based catalog storage will be unavailable
on this machine.

The following settings control configuration options on the Team Server page of the Options
Editor and the Embarcadero Team Server Log In dialog. For details, see "Team Server
Options" on page 117 and "Setting up and Connecting to DB Team Server" on page 168.

Name (and Type) Description and Supported Values

ConnectURL (REG_S?7) The full Embarcadero Team Server URL that the user must use if
Team Server is enabled.

If a value is specified, the Team Server URL control on the Team
Server page of the Options Editor is set to read-only.

UseConnect (REG_DWORD) If a value of 1 (TRUE) is specified, use of Embarcadero Team Server
is enabled. If a value of O (FALSE) is specified, use of Team Server

is disabled.

If either value is specified, the Use Team Server control on the
Team Server page of the Options Editor is disabled.

AllowKeepMeSignedin (REG_DWORD) If a value of 1 (TRUE) is specified, the Keep me signed in control
on the Embarcadero Team Server - Log In dialog is is set to an
unchecked state and the control is disabled.

UseConnect and AllowKeepMeSignedin is type REG_DWORD (legal values for both are O for
FALSE and 1 for TRUE).

Administrators not wanting to use these settings from the HKLM root key, can use the same
options in HKCU root key:

¢ In Rapid SQL, HKCU\Software\Embarcadero\Rapid SQL optional version
identifie\Admin
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If the option is specified in both locations, HKLM takes precedence over HKCU.
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DATASOURCE AND SERVER MANAGEMENT

After installing Rapid SQL, you must set up datasource definitions to establish reusable
connections to your database servers. The following topics describe the function of datasources,

the process of establishing datasource connections, and the related options provided by Rapid
SQL:

Registering Datasources Provides instructions on how to set up datasource definitions, manually
and automatically.

Connecting to Datasources Provides instructions on how to how to connect to datasources,
manually and automatically.

Trouble-shooting Client Setup Provides advice on solving common connectivity problems.

Using the Datasource Navigator Describes the user interface mechanism that lets you browse among

datasources, drill down to the database object level, and initiate
datasource or object actions.

Using the Manage Datasources Utility Describes a utility offering shortcuts to Rapid SQL datasource options.

REGISTERING DATASOURCES

A datasource is the connection profile that lets you have access to a database, and, therefore, to
your data. So, when you register a datasource, you're telling Rapid SQL how to get at the
database(s) you want to operate on. In fact, all database activities are performed through
datasources, so you need a datasource profile for each database instance (or database server) in
your enterprise. Each connection profile consists of basics such as unique name, DBMS-specific
connection parameters, and user credentials.

Collectively, datasource definitions are stored in a datasource catalog. The catalog can be
registry-based, local file-based, or network shared file-based, with each method addressing
particular advantages. For details, see "Specifying a Datasource Catalog Storage Option" on
page 122.

Rapid SQL offers the following options for registering datasources:

Manual registration You can register datasources individually. For details, see "Manually Registering or
Editing Datasources" on page 123.

Automatic discovery You can have Rapid SQL search computers or your network for datasources. For
details, see "Automatically Discovering Datasources" on page 136.

Import/Export Rapid SQL lets you export and import sets of datasource registrations. For details,
see "Importing and Exporting Datasource Definitions" on page 139.

Embarcadero DB Team Integrating with DB Team Server lets you work with datasource definitions on a data

Server governance metadata repository. For details, see "DB Team Server Support” on
page 167.

As an aid in maintaining your datasource registrations, Rapid SQL lets you quickly view basic
registration details of a datasource. For details, see "Viewing Datasource Properties" on
page 141.
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Lastly, when a datasource registration becomes obsolete, you can remove the registration from
Rapid SQL. For details, see "Unregistering Datasources" on page 141.

SPECIFYING A DATASOURCE CATALOG STORAGE OPTION

A Datasource Catalog is a collection of defined datasources. On startup, Rapid SQL loads a
Datasource Catalog using one of three methods, specified using the Options editor:

¢ Windows Registry datasource catalog - The datasource catalog is stored and managed
locally, in the Windows registry. This user can add and delete datasources and edit the
registration details of existing resources. Any changes are retained across startups of Rapid
SQL.

This method is compatible with other Embarcadero products using registry-based
datasource definition storage. If more than one of those products is installed on the same
machine, they can share the same Datasource Catalog.

e File based datasource catalog - The datasource catalog is stored locally and is file-based.
Each datasource definition included in the catalog is stored in a single file (. dsd file suffix) in
the %$APPDATA%\Embarcadero\Data Sources\ folder, in a default installation. This user can
add and delete datasources and edit the registration details of existing resources. Any
changes are retained across startups of Rapid SQL.

This method is compatible with other Embarcadero products using file-based datasource
definition storage. If more than one of those products is installed on the same machine with
Rapid SQL, all can share the same Datasource Catalog.

e Network shared datasource catalog - The datasource catalog is file-based, and obtained
from a user-specified location such as a network share. At each startup, Rapid SQL imports
definitions from the network shared file (.etsds file suffix).

Changes such as new datasources, deleted datasources or edited datasource registrations
are lost as soon as this user shuts down Rapid SQL. This method allows centralized
maintenance of the Datasource Catalog and sharing of a single catalog among multiple
users across a network.

NOTE: The definition files used in both the File based datasource catalog and Network shared
datasource catalog methods do not store user ID and password credentials.

Credentials, links to definition files in the current user’s catalog, and folder structure are
stored in the %YAPPDATA%\Embarcadero\Data Sources\metadata\dsuri.xml file.

NOTE: On individual computers, administrators can force use of the network shared option.
For details, see "Locking Down Rapid SOL Features Using the Registry" on page 119.

For information on choosing a method and specifying the network location of a Shared
Datasource Management definition file, see "Datasource Options" on page 87.

Regardless of the catalog storage method, the Datasource Catalog can be built manually by
explicitly registering datasources or using automated methods such as the Discover Datasources
feature. For details, see "Registering Datasources" on page 121.
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Keep in mind that changes made with Network shared datasource catalog in effect, are lost on
shutdown of Rapid SQL.

In order to set up a Network shared datasource catalog scheme, you can build a catalog first
using the File based datasource catalog or Windows Registry datasource catalog method. You
can subsequently use the Manage Datasources facility to export your Network shared
datasource catalog file to the location that others will use to load the file. For details, see
"Importing and Exporting Datasource Definitions" on page 139.

More generally, the Manage Datasources facility’s import/export functions can be used to
exchange datasource definitions between users employing the different storage methods. Even
more simply, these functions save time in allowing datasource definitions to be defined once
and then shared with multiple users.

MANUALLY REGISTERING OR EDITING DATASOURCES

Each database instance must be registered. Whether you are registering a new datasource,
registering a new datasource based on an existing datasource definition, or editing preexisting
connection information, you use the Datasource Registration dialog box.

To register a new datasource or edit an existing datasource
1 Use one of the following actions:
* To register a new datasource, from the Datasource menu, select Register Datasource.

e To register a new datasource based on an existing definition, select the existing
datasource in the Navigator and then from the Datasource menu, select Register Like.

¢ To edit registration information, on the Navigator, right-click a datasource and select Edit.

2 Use the following topics as a guide to providing the information required to register or edit
the datasource:

e Selecting Database Type/Connectivity Options When Reqgistering Datasources

® Providing Connection Information When Registering Datasources

Providing Security Parameters When Registering Datasources

Providing Custom Driver Properties When Registering Datasources

Specifying Datasource Properties When Registering Datasources

Specifying Oracle Views Configuration When Registering Datasources

¢ Specifying Group and Category Details When Registering Datasources

3 When ready, click Finish and respond to the prompt to connect immediately.

NOTE: The Test Connection button can be used when creating or editing a datasource to
verify that a connection can be established. Keep in mind that the information currently
provided in the wizard is used to test the connection and therefore connection
information, credentials, and custom JDBC driver properties if appropriate, must be
valid.
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SELECTING DATABASE TYPE/CONNECTIVITY OPTIONS WHEN REGISTERING
DATASOURCES

The Datasource Registration Wizard’s Database Type panel lets you specify the basic
connectivity method for the datasource you are creating.

Prior to registering datasources, you should be familiar with the connectivity options available
for each DBMS platform.

e For Rapid SQL system requirements and details on DBMS product support, see the Read
Me at http://docs.embarcadero.com/products/rapid sql/.

NOTE:

NOTE:

The Options Editor lets you indicate preferences, select options, and provide details
not available with the Datasource Registration Wizard. For details, see "Connection

Options" on page 80.

On individual computers, administrators can restrict the available DBMS platforms
available to Rapid SQL using registry settings. For details, see "Locking Down Rapid
SOL Features Using the Registry" on page 119.

To use Embarcadero’s default drivers requiring dedicated client software installed on the
client machine

1 From the Available database types list, select one of the following:

¢ |IBM DB2 Universal Database
® Microsoft SQL Server
e MySQL

¢ Oracle

* PostgreSQL Servers

¢ Sybase Adaptive Server
¢ Sybase 1Q
¢ Teradata

¢ InterBase/Firebird (Rapid SQL only)

If there is currently a DBMS node selected in the Navigator, that database type is
automatically selected.

NOTE:

124

If you are connected to an Embarcadero Team Server installation, you can select an
entry of the selected database type from the Related Team Server Data Source list.
This prepopulates the wizard with definitions/settings from the Connect server for that
datasource and sets up the new datasource definition to be attached to the Team
Server datasource. When an item is selected from the Related Team Server Data
Source list, clicking Unrelate removes the Team Server settings/definitions from the
current definition and cancels attachment to the Team Server datasource. When no
item is selected from the Related Team Server Data Source list, clicking Relate uses
the (alphabetically) first matching Team Server datasource of the selected database
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type to populate/attach, and if there are no matching definitions, opens a dialog to let
you select a definition from Team Server. For more information on Team Server
datasources, see "DB Team Server Support" on page 167.

2 Click Next.

To specify a custom JDBC driver
1 From the Available database types list, select Generic JDBC.

2 Click Next.

To specify a generic ODBC driver or to use an ODBC connection
1 From the Available database types list, select Generic JDBC.

2 Click Next.

PROVIDING CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

Connection information is provided on a DBMS platform basis. The following topics describe
platform-by-platform descriptions of the required and optional connection information:

® Providing DB2 Connection Information When Registering Datasources

e Providing InterBase/Firebird Connection Information When Registering Datasources

® Providing MySQL Connection Information When Registering Datasources

® Providing Oracle Connection Information When Registering Datasources

e Providing PostgreSQL Connection Information When Registering Datasources

® Providing SQOL Server Connection Information When Registering Datasources

® Providing Sybase ASE Connection Information When Registering Datasources

e Providing Sybase |IQ Connection Information When Registering Datasources

® Providing Teradata Connection Information When Registering Datasources

® Providing Connection Information When Registering a Generic JDBC Datasource

e Providing Connection Information When Reqistering a Generic ODBC Datasource

PROVIDING DB2 CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Connection Information panel lets you provide details
required to establish a connection to a DB2 datasource. Available options depend on the
Registration Type value selected.
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The following table describes these settings:

Registration Type

Option/Description

Simple

Host/Instance - The network name of the machine hosting the datasource.
Port - This defaults to 50000 but can be overwritten.
Database - The name of the database this user should connect to.

Datasource Name - This is the name of the datasource as it will appear in the Navigator or
Explorer.

client

Use alias from IBM

Server - Select from the names of servers defined in the IBM client.

Datasource Name - This is the name of the datasource as it will appear in the Navigator or
Explorer.

LDAP Server

Use Data from the

This option is only enabled if LDAP is enabled and configured on the Options Editor's LDAP
Configuration tab. For details, see "LDAP Configuration Options" on page 111.

Server - Select from the names of servers obtained from the LDAP server
Host/Instance - The network name of the machine hosting the datasource.
Port - This defaults to 50000 but can be overwritten.

Database - The name of the database this user should connect to.

Datasource Name - The datasource as it will appear in the Navigator or Explorer.

Keep the following in mind when registering a DB2 datasource:

* The Options Editor lets you indicate preferences, select options, and provide details not
available with the Datasource Registration Wizard. For details, see "Connection Options" on

page 80.

e Consult DB2 documentation for detailed information on general LDAP support, supported
LDAP servers, and client configuration before trying to use Rapid SQL to register LDAP-
specified datasources.. For assistance, see Accessing Third Party Documentation.

® For more general information on registering datasources, see "Manually Registering or
Editing Datasources" on page 123.

PROVIDING INTERBASE/FIREBIRD CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Connection Information lets you provide details
required to establish a connection to an InterBase or Firebird datasource. The following table
describes these setting:

Option Description
Host name The name of the machine where the database resides.
Port Optionally, provide a port number.

Character Set

The default character set used for this connection.

Database file path

The full path to the database file, a .gdb file for Interbase or a .fdb file for Firebird.

Datasource Name

Optionally, override any value in this field with a value to be displayed in the Rapid SQL
Datasource Navigator tree.
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For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.

PROVIDING MYSQL CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Connection Information lets you provide details
required to establish a connection to a MySQL datasource. The following table describes these
setting:

Option Description

Server Enter the name of the host, for example doctest01.

Port (optional) The default port is 3306. You do not need to enter this information.

Default Database You must enter the name of the default database.

Datasource Name This field is automatically populated with the server name, but you can rename it to
whatever you want.

NOTE: The Options Editor lets you indicate preferences, select options, and provide details
not available with the Datasource Registration Wizard. For details, see "Connection

Options" on page 80.

For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.

PROVIDING ORACLE CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard’'s Connection Information lets you provide details
required to establish a connection to an Oracle datasource. Available options depend on the
Registration Type value selected.

The following table describes these setting:

Registration Type Options/Description

Simple Host - Manually enter the name of the host machine.
Port -The default is 1521, but you can change it to wherever the Oracle listener is set up.

SID/Service Name -Enter the SID or Service Name to correspond with the option you
select.

Instance Name- The specific name used to identify the Oracle instance (the SGA and the
Oracle processes).

Datasource Name - The field is automatically populated with the host name, but you can

change it.
Use Connection Connect Descriptor - provide a TNS Connect String, a connect identifier that defines
Descriptor the parameters that need the Oracle Net Service to connect to a database service.

Datasource Name - The field is automatically populated with the host name, but you can
change it.
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Registration Type Options/Description

Use TNS Names alias You can specify a non-default TNSNAMES.ORA file using the Options editor. For details,
see "Connections Options - Oracle" on page 82.

Oracle Alias - The dropdown is populated with server names from the TNSNAMES.ORA
file. Select an Oracle alias.

Connect Descriptor - A read-only field that displays the TNS Connect String obtained
from the alias definition from the TNSNAMES.ORA file.

Datasource Name - The field is automatically populated with the host name, but you can

change it.
Use Data from the This option is only enabled if LDAP is enabled and properly configured on the Options
LDAP Server () Editor's LDAP Configuration tab. For details, see "LDAP Configuration Options" on
page 111.

Oracle Alias - The dropdown is populated with the names of servers obtained from the
LDAP server specified on the Options Editor's LDAP Configuration tab.

Connect Descriptor - A read-only field that displays the TNS Connect String obtained
from the alias definition from the LDAP server.

Datasource Name - The field is automatically populated with the host name, but you can
change it.

Keep the following in mind when registering an Oracle datasource:

® You can register an Oracle ASM instance directly using the Datasource Registration Wizard.
No Datasource Navigator tree is available when connecting to the ASM instance. The ISQL
Editor is available with this type of connection.

e Consult Oracle documentation for detailed information on general LDAP support,
supported LDAP servers, and client configuration before trying to use Rapid SQL to register
LDAP-specified datasources.. For assistance, see Accessing Third Party Documentation.

e For more general information on registering datasources, see "Manually Registering or
Editing Datasources" on page 123.

PROVIDING POSTGRESQL CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Connection Information lets you provide details
required to establish a connection to a PostgreSQL datasource. The following table describes
these settings:

Option Description

Host The host name for the PostgreSQL Server.

Port The port that the PostgreSQL server is listening on.

Database The name for the database to connect to.

Datasource Name This field automatically populates with the host name. You can change it to whatever you
want.

NOTE: The Options Editor lets you indicate preferences, select options, and provide details
not available with the Datasource Registration Wizard. For details, see "Connection

Options" on page 80.
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For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.

PROVIDING SQL SERVER CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Connection Information lets you provide details
required to establish a connection to a SQL Server datasource. The following table describes
these setting:

NOTE: If you are registering a named instance on a server, you are restricted to use of the Use
Network Library Configuration/Alias method below. Prior to registering the
datasource in Rapid SQL, use the SQL Server Configuration Manager to create an alias
to the instance, making it available as an Alias selection on the Connection
Information panel.

Option Description

Simple Protocol (TCP/IP or Named Pipes) - You need to select one or the other to register a
SQL Server database.

Host - the host name.

Port - Depending on your section, you can optionally indicate the port for TCP/IP or the
pipe name depending on your means of connection.

Default DB - Optionally give the default name for the database.

Datasource Name - The field is automatically populated with the host name, but you can
rename to whatever you want.

Use Network Library Use Encryption - enables multiprotocol encryption.
Configuration Alias - Select an alias

Protocol (TCP/IP or Named Pipes) - You need to select one or the other to register a
SQL Server database.

Host - Displays the host name.

Port - Depending on your section, you can optionally indicate the port for TCP/IP or the
pipe name depending on your means of connection.

Default DB - Optionally give the default name for the database.

Datasource Name - The field is automatically populated with the host name, but you can
rename to whatever you want.

NOTE: The Options Editor lets you indicate preferences, select options, and provide details
not available with the Datasource Registration Wizard. For details, see "Connection

Options" on page 80.

For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.
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PROVIDING SYBASE ASE CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard’'s Connection Information lets you provide details
required to establish a connection to a Sybase ASE datasource. The following table describes

these settings:

Registration Type

Option/Description

Simple

Use SSL Encryption - If this option is selected, the JDBC connection will be established
using SSL encryption

Host - Manually enter the name of the host.
Port - There is no default for this optional field.
Default DB - Optionally give the default name for the database.

Datasource Name - This field automatically populates with the server name. You can
change it to whatever you want.

Use alias information
from the SQL.INI FILE

Sybase Server - Select a server from the dropdown

Host - Automatically populated when you select an alias.

Port - There is no default for this optional field.

Default DB - Optionally give the default name for the database.

Datasource Name - This field automatically populates with the server name. You can
change it to whatever you want.

Use data from the
LDAP server

Use SSL Encryption - The connection will be established using SSL encryption.
Sybase Server - Select a server from the dropdown

Host - Automatically populated when you select an alias.

Port - There is no default for this optional field.

Default DB - Optionally give the default name for the database.

Datasource Name - This field automatically populates with the server name. You can
change it to whatever you want.

NOTE: The Options Editor lets you indicate preferences, select options, and provide details
not available with the Datasource Registration Wizard. For details, see "Connection

Options" on page 80.

For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.
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PROVIDING SYBASE 1Q CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard’'s Connection Information lets you provide details
required to establish a connection to a Sybase 1Q datasource. The following table describes
these settings:

Option Description

Host The host name for the Sybase 1Q Server.

Port The port that Sybase 1Q is listening on.

Database The name for the database to connect to.

Datasource Name This field automatically populates with the host name. You can change it to whatever you
want.

NOTE: The Options Editor lets you indicate preferences, select options, and provide details
not available with the Datasource Registration Wizard. For details, see "Connection

Options" on page 80.

For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.

PROVIDING TERADATA CONNECTION INFORMATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Connection Information lets you provide details
required to establish a connection to a Teradata datasource. The following table describes these
settings:

Option Description

Host The host name for the Teradata Server.

Port The port that the Teradata server is listening on.

Database The name for the database to connect to.

Datasource Name This field automatically populates with the host name. You can change it to whatever you
want.

NOTE: The Options Editor lets you indicate preferences, select options, and provide details
not available with the Datasource Registration Wizard. For details, see "Connection

Options" on page 80.

For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.

PROVIDING CONNECTION INFORMATION WHEN REGISTERING A GENERIC JDBC DATASOURCE

The Datasource Registration \Wizard's Connection Information lets you provide basic
information details required to establish a connection to a generic JDBC datasource.

NOTE: For requirements and Rapid SQL functionality restrictions for generic JDBC
connections, see "Generic JDBC and ODBC Support" on page 12.
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The following table describes the settings on this panel:

Option Description

JDBC driver to use

Connection URL If you are defining a datasource using a custom JDBC driver, this field is automatically

populated with the value you entered in the Template Connect URL for new data
source field. For more information. see "Providing details for a new custom JDBC driver"
on page 132.

Type a valid connection URL or edit the URL template to provide a valid connection URL.

Datasource Name This is the name that will appear in Rapid SQL's Navigator.

3

NOTE: In addition to basic connection properties, you can also specify provider-specific JDBC
properties. For details, see "Providing Custom Driver Properties When Registering
Datasources" on page 134.

Take one of the following actions:

a To specify a JDBC driver that you have not used with Rapid SQL before, click Manage to register a new driver
with Rapid SQL. For more information, see "Providing details for a new custom JDBC driver" on page 132.

b To use a custom JDBC driver you have already registered with Rapid SQL, select that driver from the JDBC
driver to use dropdown.

PROVIDING DETAILS FOR A NEW CUSTOM JDBC DRIVER

When registering a datasource, if you select a generic JDBC connection, you must specify the
installed JDBC driver to be used. If you have not used that driver with Rapid SQL, you can
register that driver with Rapid SQL while defining a datasource.

NOTE: Before setting up a custom driver, consult the documentation for that driver to obtain
details such as the driver class and connection URL for that driver type.

To specify a new custom JDBC driver

1

B~ w N

132

Open a datasource registration dialog. For details, see "Manually Registering or Editing
Datasources" on page 123.

From the Available database types list, select Generic JDBC.
On the Connection Information page, click Manage. The JDBC Driver Editor opens.
In the Name field, type a name or description for the new driver.

Click the Add button associated with the Driver Archives list and use the Open dialog to
locate and select the library or archive for the driver.

In the Class field, type the driver class.
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6 Inthe Template Connect URL for new data source field, provide a connection URL
template. There are no constraints on the value that you enter. When providing details on
the Datasource Registration Wizard’s Connection Information panel, the template will
automatically be entered in the Connection URL field, letting you provide actual values for
any placeholders you provide in the URL template entered here.

PROVIDING CONNECTION INFORMATION WHEN REGISTERING A GENERIC ODBC DATASOURCE

The Datasource Registration Wizard's Connection Information lets you provide details
required to establish a connection to a generic ODBC datasource.

NOTE: For requirements and Rapid SQL functionality restrictions for generic ODBC
connections, see "Generic JDBC and ODBC Support" on page 12.

The following table describes the settings on this panel:

Use Connect String Option/Description

Unselected Datasource Name - Provide the name that will appear in the Rapid SQL Navigator for
this datasource.

DSN - Provide the DSN for the datasource.

Selected Datasource Name - Provide the name that will appear in the Rapid SQL Navigator for
this datasource.

Connect String - Provide the full connection string for the datasource.

NOTE: Consult the documentation for the ODBC driver and the datasource you are
connecting to for details on DSN and connect string requirements.

PROVIDING SECURITY PARAMETERS WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Security Parameters panel lets you provide user
credentials and specify other DBMS-specific security settings. The following table describes
these settings and their DBMS availability:

Option Description

User ID The User ID that DBArtisan will use to connect to the datasource.

Password The password associated with the User ID.

Connect As (Oracle) When relevant, choose the appropriate user/administrator level: NORMAL,
SYSDBA, or SYSOPER).

Domain (SQL Server) For MS SQL only. Identify the domain if the user has restricted access.

Auto connect? Spares the user from reentering the password every time you connect.

On individual computers, auto connect can be disabled by administrators.
For details, see "Locking Down Rapid SQL Features Using the Registry" on
page 119.

Omit User ID and Password (Generic | Selected, no user ID or password are passed when connecting to the
JDBC and Generic ODBC only) datasource.
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Option Description

Connect using Windows Login to the server is verified using Windows/OS authentication
Authentication or Connect using OS
Authentication (IBM DB2 for
Windows, Unix, and Linux, MySQL,
Oracle, SQL Server)

Connect using Kerberos If this option is selected, login to the server is verified using Kerberos
Authentication (Sybase ASE) authentication.

NOTE: This is only available of the Use alias information in the SQL.INI file/
Sybase Server option on the Connection Information tab is selected. For
details, see Data Editor Options.

For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.

PROVIDING CUSTOM DRIVER PROPERTIES WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Custom Driver Properties panel lets you specify
optional, provider-specific connection string keywords or properties beyond those offered on
other panels of the wizard.

NOTE: Consult driver/client documentation for details on supported driver properties. For a
listing of supported DBMS drivers and clients, see the ReadMe.htm file for this release
(View > Release Notes).

To add a driver property for this datasource connection
1 Click New. An Add Driver Property dialog opens.

2 Select a property name from the Name dropdown or type the name of the property. The
dropdown is automatically populated with the most commonly-used properties for a
platform driver. However, all properties (name/value pairs) supported for that driver can be
specified.

3 Type the property value in the Value field.
4 Optionally, provide a Description.
5 Click OK.

The dialog closes and the new property’s name and value are displayed in the Property Name/
Property Value list.

Use the Edit button to initiate editing of a selected property name/value pair. Similarly, use the
Delete button to remove a selected property name/value pair from the list.
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SPECIFYING DATASOURCE PROPERTIES WHEN REGISTERING DATASOURCES

The Datasource Registration \Wizard’s Datasource Properties panel lets you specify properties
used in conjunction with Rapid SQL features. The following table describes these settings and
their DBMS availability:

Setting Description

#Include Search Directories Enter one or more paths on this datasource, which will be searched for files in
conjunction with use of the #include directive in the ISQL editor, Procedure
Object Editor, or Package Body Object Editor. Separate multiple paths using
semicolons. For example:

c:\myscripts;c:\Program Files\Scripts

For more information on use of the #include directive, see SQOL Preprocessing:
#define and #include.

Note that if there are no entries specified here, the directory specified on the
Directories tab of the Options editor will be searched. For more information,
see Directories Options.

Database device default path The database device default path is used when creating a new database device.

(Sybase ASE)

View in Team Server If there is an attached datasource on a connected Embarcadero DB Team Server
installation, this control opens a browser on the Team Server with the definition
displayed.

View Related ER Models Opens a dialog displaying models related to the current datasource and letting

you create and delete relationships.

Edit Related Data Source Opens a Registration Editor that will let you modify the associated DB Team
Server datasource definition.

For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.

SPECIFYING ORACLE VIEWS CONFIGURATION WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Oracle View Config panel lets you manually configure
Rapid SQL access to Oracle Data Dictionary DBA or ALL/USER views to conform to the view
privileges associated with a specific role.

NOTE: In order to enable manual configuration of Oracle Data Dictionary views for Oracle
datasources and make this panel available, you must select Use Datasource
Configuration for Views in the Options Editor (File > Options > General > Oracle).
For more information, see General Options.

RAPID SQL 8.7.2/XEé6 USER GUIDE 135



REGISTERING DATASOURCES > REGISTERING DATASOURCES

Only DBA views with an ALL/USER equivalent are offered on this panel. You can use the
following methods to select DBA or ALL/USER type views on a view-by-view basis:

Option Description

Manual selection using the Use DBA View | Selecting the Use DBA View check box associated with an individual

check boxes view makes the DBA group version of that view available to Rapid SQL.
Deselecting the Use DBA View check box associated with an individual
view makes the ALL/USER group version of that view available to Rapid

SQL.

Reset to All Deselects all Use DBA View check boxes, making only ALL views
accessible to Rapid SQL.

Reset to DBA Selects all Use DBA View check boxes, making DBA views accessible
to Rapid SQL.

Resolve Automatically (only available Queries the datasource and selects the Use DBA View check box for

when editing a connected datasource) each DBA view to which the current user has access.

Changes take effect as soon as you click the Finish button.

For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.

SPECIFYING GROUP AND CATEGORY DETAILS WHEN REGISTERING DATASOURCES

The Datasource Registration Wizard's Datasource Group panel lets you specify properties that
help you organize your datasources. The following table describes these settings and their
DBMS availability:

Select the datasource group Select the folder that is to contain this datasource.
folder
Select a category If you want to use category-based user interface item color-coding and labeling

for this datasource, this dropdown lets you select an existing category to assign
this datasource to that category. You can also select Customize to manage your
categories. For details, see "Customizing Datasource Categories" on page 159.

For an introduction to datasource categorization and related tasks, see
" Categorizing Datasources using Color-coding and Labeling" on page 157.

For more general information on registering datasources, see "Manually Registering or Editing
Datasources" on page 123.

AUTOMATICALLY DISCOVERING DATASOURCES

Rapid SQL lets you automate registration of datasources by importing datasource definitions
from the following locations:

e DBMS configuration files/registry entries
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e | DAP Servers

e TOAD product datasource definitions (specifically from TOAD for Oracle, TOAD for
Microsoft SQL Server, TOAD for MySQL, TOAD for Sybase (both ASE and 1Q))

e An Embarcadero DB Team Server repository. For detailed information, see "DB Team Server
Support" on page 167/

For example, if you have a multiple DBMS platform license, the Discover Datasources feature
finds all unregistered datasources that Rapid SQL is licensed for. If you have an Oracle only
license, Discover Datasources finds all unregistered Oracle datasources.

Use the information in "Setting up to Automatically Discover Datasources" on page 137 to
ensure that you are ready to use the Doscover Datasources feature.

There are two relevant scenarios for this feature. For details, see the following topics:

e Discovering Datasources on First Application Startup

o Manually Discovering Datasources

In addition to Auto-Discovering your database servers, Rapid SQL automatically places the
datasource within a DBMS-specific database group folder in the Navigator. For more
information, see "Categorizing Datasources using Color-coding and Labeling" on page 157.

For related information, see "Connecting to Datasources" on page 142.

SETTING UP TO AUTOMATICALLY DISCOVER DATASOURCES

Some search targets used by the Discover Datasources feature rely on customer-provided
information. The Options Editor lets you provide the following:

e The names and locations of configuration files such as the Oracle TNSNAMES.ORA file and
the Sybase ASE SQL.INI file. For details, see "Connection Options" on page 80.

e |dentification and authentication details of an LDAP Server that can publish datasources. For
details, see "LDAP Configuration Options" on page 111.

e Enabling and configuration of an Embarcadero DB Team Server connection. For details, see
"DB Team Server Support" on page 167. In addition, you must be logged in to the
Embarcadero DB Team Server. For details, see "Setting up and Connecting to DB Team
Server" on page 168.

In addition, there are environment details that can impact this feature. For details, see "Trouble-
shooting Client Setup" on page 143.
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DISCOVERING DATASOURCES ON FIRST APPLICATION STARTUP

The first time you run Rapid SQL a dialog box displays, giving you the option to Auto-Discover
all configured datasources. If you click Yes, the Rapid SQL Auto-Discover feature searches the
DBMS configuration files on your computer and automatically discovers all the datasources that
you are licensed for.

NOTE: Microsoft SQL Server datasources are registered through a Windows system call to
your network. Provide login information (user name and password) the first time you
connect to a datasource. For more information, see "Disconnecting from a
Datasource" on page 143.

NOTE: [IBM DB2 for Linux, Unix, and Windows databases use ODBC/CLI or DB2 (attach) to
connect. Therefore, you need the proper ODBC/CLI Connection established in order
for the auto-discover feature to find your IBM DB2 for Linux, Unix, and Windows
databases, including registering the DB2 datasource to ODBC as a system datasource.
Although your datasources are auto-discovered, provide login information (user name
and password) the first time you connect to a datasource.

MANUALLY DISCOVERING DATASOURCES

Rapid SQL discovers datasources residing on your system that are not currently registered
datasources. Rapid SQL can retrieve a list of discovered datasources, which includes the name of
the server or instance, the type of DBMS, and source (DBMS configuration files/registry entries,
LDAP Servers, TOAD datasource definitions, Embarcadero DB Team Server) of all unregistered
datasources found on your network or local machine. Once discovered, you have the option to
register datasources.

Completing the Discover Datasources Dialog Box
1 On the Datasource menu, click Discover Datasources.

Rapid SQL opens the Discover Datasources dialog box and when the search is complete,
displays all discovered datasources. The source (Local alias, Network, LDAP, or Toad) and
status of each is displayed.

2 Select the check box next to any datasources you want to register.
3 Click Register.

Rapid SQL registers the datasource or datasources selected.
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IMPORTING AND EXPORTING DATASOURCE DEFINITIONS

On startup, Rapid SQL loads a datasource catalog, a collection of datasource definitions that the
user can work against. How the catalog is stored and whether changes to the catalog are
temporary or permanent, depends on the datasource storage method used. For an introduction,
see "Specifying a Datasource Catalog Storage Option" on page 122.

NOTE: On individual computers, administrators can restrict the available DBMS platforms
available to Rapid SQL using registry settings. For details, see "Locking Down Rapid
SQL Features Using the Registry" on page 119.

Regardless of the storage method used, Rapid SQL lets you add datasources to the currently
loaded catalog by importing datasource definitions from the following sources:

e Windows Registry - if you previously used the Windows Registry datasource catalog storage
method but are now using one of the file-based methods

e File-based datasource catalog storage method files (.dsd file suffix)
* Network-shared datasource catalog storage method files (.etsds file suffix)

Similarly, you can export the currently loaded datasource catalog definitions to a file-based
datasource catalog or network-shared datasource catalog storage method files.

The ability to export and import datasource definitions provides a number of practical
advantages. For example:

e Simple sharing among users - if you have a large number of datasources to register, you can
have one user walk through the process of registering each datasource and then export
those definitions. Other users can then import the resulting datasource definition files.

e Sharing definitions among users employing different datasource storage methods -
datasource definitions or entire catalogs created using the Windows Registry datasource
catalog or File based datasource catalog methods can be exported for use by users
employing any of the three methods.

To export one or more datasource definitions
1 On the Datasource menu, select Manage Datasources.

Rapid SQL opens the Manage Datasources dialog box.

2 Select a single datasource, multiple datasources, or a default or custom datasource group
folder.

NOTE: Datasource group folder information is not exported. Datasources are exported as
individual files with no higher level grouping.

3 Click Export. An Export Data Sources Folder dialog opens.
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4 Take one of the following actions:

* To export datasource definitions to individual files that can be imported on a datasource-
by-datasource basis, select Export Data Sources to Individual Data Source Files and
use the associated control to locate and select a target folder.

¢ To export datasource definitions to a single file for use by installations employing the
Shared Datasource Managed catalog storage method, select Export Data Sources To a
Shared Data Source Management File and use the associated control to locate and
select a target folder and provide a file name. For information on how to designate a user
as a shared datasource managed catalog storage method, see "Datasource Options" on
page 87.

5 Click OK.

NOTE: User ID and password credentials are not exported to the datasource definition file.

After export, other users can then import the datasource definitions.

To add one or more datasource definitions to a catalog
1 On the Datasource menu, click Manage Datasources.

Rapid SQL opens the Manage Datasources dialog box.
2 Select the datasource group folder where the files or files are to be imported.
3 Click Import. An Import Data Sources dialog opens.
4 Take one of the following actions:

e |f you previously used the Windows Registry catalog storage method but are currently
using the Locally Managed or Shared Datasource Managed method, select Import
Previously Registered Embarcadero Data Sources From Registry to load any
datasources registered when you were using the Windows Registry catalog method.

¢ To import datasource definitions from individual datasource definition files (. dsd file
suffix), select Import Previously Registered Embarcadero Data Sources From File(s),
click Add, and use the Select datasource definitions to import dialog to locate and
select the files to be added.

e To import datasource definitions from a single Shared Datasource Managed storage
method file (. etsds file suffix) file, select Import Data Sources From a Shared
Datasource Management File and use the associated control to locate and select the
target file.

5 Click OK.

After importing a datasource definition file, you can either edit the datasource registration to
provide security parameters or provide credentials when connecting to the datasource.
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VIEWING DATASOURCE PROPERTIES

Rapid SQL lets you view the name, type, version, status and mode of a connected datasource.
The Datasource Properties dialog also lets you view the middleware or connectivity software
that is being used to establish a particular datasource connection. You can use this information
to troubleshoot connectivity problems, determining vital information such as the server version,
connectivity library used, and library version and date.

NOTE: Forinformation on establishing a datasource connection, see "Connecting to
Datasources" on page 142.

To view key properties of a connected datasource

1 On the Datasource Navigator or Datasource Explorer, select a datasource with an
established connection. For more information, see "Using the Datasource Navigator" on
page 146.

2 On the Datasource menu, select Properties.

Rapid SQL opens the Datasource Properties dialog box.

UNREGISTERING DATASOURCES

Rapid SQL lets you unregister datasources when you no longer need them.

NOTE: Removing a datasource from Rapid SQL does not delete the physical database. It
simply removes the datasource definition, and connection information, from the Rapid

SQL catalog.

1 In the Datasource Explorer or Datasource Navigator, right-click the target datasource and
select Unregister. For more information, see "Using the Datasource Navigator" on
page 146.

2  When prompted to confirm, click Yes.

NOTE: The datasource manager is shared across Embarcadero's database management
products. When you remove a datasource in any of Embarcadero's database
management tools the datasource is removed across all relevant products.

For related information, see "Registering Datasources" on page 121.
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CONNECTING TO DATASOURCES

Rapid SQL provides two general categories of methods for connecting to a datasource.

Automatic You can set datasources to automatically connect each time you open the application. You
can do this when registering a datasource or as an option when explicitly connecting to a
datasource. For details, see "Registering Datasources" on page 121 and "Manually
Registering or Editing Datasources" on page 123

Explicit If you do not use the automatic connection option for a datasource, you must explicitly
connect to a datasource before you can use Rapid SQL against that datasource.

The following topics provide instruction on explicit connection and disconnection options:

e Disconnecting from a Datasource

e Connecting to Datasources from an Alphabetical Listing

e Disconnecting from a Datasource

For related information, see "Registering Datasources" on page 121

CONNECTING TO A DATASOURCE FROM THE NAVIGATOR

The first time you start the application, Rapid SQL prompts you to register your datasources.
During this process, you can select the Auto Connect check box, which automatically connects
all registered datasource each subsequent time you open the application. For details, see
"Moving Datasources Between Groups" on page 154.

If you did not check the Auto Connect box, or if you clicked No when prompted to connect to a
database after registering, you must connect manually, each time you want to access that
datasource.

If you later want to automatically connect your datasources, you can edit the datasource to make
that change.

TIP:  To configure your datasource to login automatically, refer to "Registering
Datasources" on page 121.

To manually connect to a datasource

1 In the Datasource Explorer or Datasource Navigator, right-click a datasource and select
Connect from the context menu. For details on the Explorer or Navigator, see "Using the
Datasource Navigator" on page 146.

Rapid SQL opens a Login to... dialog box.
2 Type a Login ID and Password.

3 Optionally, and only if available, provide Login As, Default Schema ID, and Default
Function Path values.

4 Select Auto Connect to automatically connect to the datasource in the future.
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5 Click OK.

Rapid SQL connects to the datasource and expands the datasource display to show the top level
of nodes available on that datasource. For more information, see "Working with Bookmarks" on
page 149.

CONNECTING TO DATASOURCES FROM AN ALPHABETICAL LISTING

The Select Datasource dialog lets you sequentially connect to a set of datasources chosen from
a list.

To connect to one or more datasources
1 On the Datasource menu, select Select. Rapid SQL opens the Select Datasource dialog.

2 For each datasource that you want to connect to, select a datasource from the Datasource
list, and then click Connect to connect to the selected datasource.

3 If the last datasource you connect to supports multiple databases, you can optionally select
a database from the Database list, and then click OK to have that database selected.

Rapid SQL expands the datasource display to show the top level of nodes available on the
datasources you connected to. For more information, see "Working with Bookmarks" on
page 149.

DISCONNECTING FROM A DATASOURCE

When you disconnect from a server, the application immediately breaks the connection between
any open ISQL Windows, the servers, and databases. Although your ISQL Windows are still
visible, the connections are no longer valid. If you attempt to execute a script, Rapid SQL
attempts to reconnect to a registered datasource, if available.

To disconnect from a datasource

1 In the Datasource Explorer or Datasource Navigator, right-click a datasource and select
Disconnect. For information on the Explorer and Navigator, see "Using the Datasource

Navigator" on page 146.

NOTE: If necessary, Rapid SQL opens a dialog box asking if you want to commit all pending
transactions for that connection or to rollback all before disconnecting. You cannot
disconnect if there is an uncommitted transaction.

TROUBLE-SHOOTING CLIENT SETUP

If you are using native Embarcadero drivers to connect to a datasource, improperly configured
client software can lead to the following symptoms:
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Failure to Auto-Discover accessible datasources.

Inability to properly register a datasource

Failure to manually connect to a registered datasource
e Error messages indicating missing client software files

NOTE: For details on the various ways to register and connect to datasources, see
"Datasource and Server Management" on page 121.

Regardless of the DBMS platform, your first step in trouble-shooting client connectivity is to
ensure that your client is specified in the PATH environment variable.

For DBMS-specific help, see the following topics:

e Trouble-shooting Sybase Connectivity

¢ Trouble-shooting Oracle Connectivity

e Trouble-shooting DB2 LUW and DB2 z/OS Connectivity

e Trouble-shooting SOL Server Connectivity

TROUBLE-SHOOTING SYBASE CONNECTIVITY

A common cause of client connectivity issues against a Sybase DBMS is the client on the
workstation not being compatible with Rapid SQL or the Sybase environment on your
workstation not being configured properly.

Verify that your Sybase environment variables have been set properly on your workstation. If you
make any changes, restart DBArtisan

Ensure you at least have the following variables (Environment Variables accessible through the
Control Panel):

SCROOT
SYBASE
SYBASE_OCS
SYBROOT

LIB - ensure that the Sybase LIB directory is listed here

INCLUDE - ensure that the Sybase INCLUDE directory is listed here
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Verify that the PATH value has only ONE SET of Sybase directories listed. You can modify this
from the same Environment Variable window above in the PATH value:

%$SystemRoot%$\system32; $SystemRoot%; $SystemRoot%\system32\WBEM; C: \PROGRA~1\Serena\vm\wi
n32\bin; C:\PROGRA~1\Serena\vm\common\bin\win32;C:\oracle\ora92\bin;C:\oracle\orad92\jre
\1.4.2\bin\client;c:\sybase\OCS-15 0\1ib3p;c:\sybase\OCS-15 0\dll;c:\sybase\OCS-

15 0\bin;c:\sybase\DataAccess\ADONET\d11l;c:\sybase\DataAccess\OLEDB\d1l1l;c:\sybase\Data
Access\ODBC\dll;c:\sybase\Shared\Sybase Central 4.3;c:\sybase\ua\bin;C:\Program
Files\Internet
Explorer;C:\WINDOWS\system32;C: \WINDOWS; C: \WINDOWS\System32\Wbem; C:\Program

In order to use the Auto-Discover feature, a valid SQL.ini file must be located in the following
location:

C:\sybase\version_identifier_directory\ini

Where the version_identifier_directory is the name of the release-specific directory associated
with this purpose, such as OCS-15_0 or OCS-12_5.

TROUBLE-SHOOTING ORACLE CONNECTIVITY

An Oracle client must be installed on the workstation. It must be defined/specified in the
following locations:

e The ORACLE_HOME in the Windows Registry
¢ The Environment PATH value

In addition, in order for the Auto-Discover feature to work, there must be a valid Oracle
tnsnames.ora and sqlnet.ora file in the Oracle client installed. They must be installed in the
$0racle home\Network\Admin directory. As well, the sqlnet.ora file must have the
NAMES.DIRECTORY_PATH value of TNSNAMES.

A typical sglnet.ora file:
sglnet.ora Network Configuration File:

:\oracle\product\10.2.0\client 2\network\admin\sglnet.ora
Generated by Oracle configuration tools.

+ Q) **

# This file is actually generated by netca. But if customers choose to
# install "Software Only", this file wont exist and without the native
# authentication, they will not be able to connect to the database on NT.

SQLNET.AUTHENTICATION SERVICES= (NTS)

SQLNET . INBOUND CONNECT TIMEOUT = 30
SQLNET.SEND TIMEOUT = 30
SQLNET.RECV TIMEOUT = 30

TRACE FILENO SERVER=3

LOG FILE SERVER=svr.log

TRACE FILE CLIENT=clientsglnet.trc

NAMES.DIRECTORY PATH= (TNSNAMES)
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TROUBLE-SHOOTING DB2 LUW AND DB2 z/OS CONNECTIVITY
The client must be defined in the workstation PATH value.

In order to Auto-Discover or manually register DB2 datasources, they must be configured in the
DB2 Configuration Assistant. If Rapid SQL is not detecting DB2 datasources, have your DBA
provide a Configuration Assistant profile.

TROUBLE-SHOOTING SQL SERVER CONNECTIVITY

In general, SQL Server datasources rarely go undetected by Rapid SQL. Each database server
sends out a ping (via a service) to the network and Rapid SQL is usually able to find this. The
SQL Server client must be defined in the workstation PATH value.

USING THE DATASOURCE NAVIGATOR

The Datasource Navigator provides a visual method for browsing, accessing, and manipulating
objects. The Datasource Explorer contains a hierarchy consisting of groups, datasources, object
type, and object nodes:

e Groups organize the datasources available to Rapid SQL. A default set of groups
correspond to the DBMS platforms supported by Rapid SQL. You can also create custom
groups to organize your datasources. For more information, see "Categorizing Datasources

using Color-coding and Labeling" on page 157.

e Within groups are the datasources on your network that you have registered. You must
register datasources with Rapid SQL in order to work against them. For more information,
see "Registering Datasources" on page 121 and "Connecting to Datasources" on page 142.

e With the exceptions of the Filters node, nodes immediately below the datasource level
correspond to the object types supported on the DBMS platform. At the lowest level, are
the individual database objects on the datasource. For a listing of object types by DBMS
platform and detailed support summaries for each type, see "Supported Objects" on
page 179.

NOTE: For more information on the Filters node, see "Filtering in the Navigator" on
page 159.

Higher level nodes in the hierarchy have an associated Expand/Collapse icon, letting you drill
down through the hierarchy to expose lower level nodes and objects.
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Bookmarks provide another means to quickly navigate to specific Explorer object nodes. For

details, see "Working with Bookmarks" on page 149.

You can also initiate object type-specific actions and open object editors from the Explorer. For
details, see "Initiating Object Actions in the Navigator" on page 150.

Rapid SQL offers a number of viewing and organization options that let you optimize the

Explorer for your own purposes. These include:

¢ Basic viewing options that let you toggle between type-based or owner-based display, one-

step expansion and collapse of hierarchy elements, hiding or display of system objects,

saving of view option settings.

® Creating custom datasource groups to provide a deeper level of organization.

e Categorizing datasources using color-coding and labeling to quickly distinguish between
datasources used for different purposes in your organization.

e Filtering the Explorer tree to display only selected nodes and objects. Rapid SQL offers the
following filtering options. You can filter by name, schema or object type,

For detailed information on customizing the Explorer view, see "Customizing the Navigator

Display" on page 151.

RAPID SQL 8.7.2/XEé6 USER GUIDE

147



USING THE DATASOURCE NAVIGATOR > USING THE DATASOURCE NAVIGATOR

HIDING AND DISPLAYING THE DATASOURCE NAVIGATOR
Display of the Datasource Navigator can be toggled on and off.

To Toggle Display of the Navigator On and Off
¢ Select View > Datasource Navigator.

CONNECTED/SELECTED DATASOURCE OPTIONS

While you can connect to multiple datasources, at any one time only one connected datasource
is the currently selected datasource. The currently selected datasource is displayed in the
Datasource toolbar. For multiple-database datasources such as SQL Server and Sybase, a
currently selected database is also displayed.

| HE ROMLABSY1502_1 (Sybase Adaptive Serve = | [ master Ml
Certain features, to varying degrees, depend on the currently selected datasource or selected
datasource/database combination. On a fairly trivial level, availability of some features or the
initial state of a feature on being invoked is dependent on the selected datasource:

¢ In Rapid SQL, Browse menu object type availability is dependent on DBMS platform of the
currently selected datasource.

e Some features, Query Builder for example, have user interface controls for selecting a
datasource. On opening, these user interface items default to the currently selected
datasource.

More strongly dependent on the selected datasource is the SQL Editor. A SQL Editor window
not locked to a datasource, will direct all transactions to the currently selected datasource.

NOTE: Forinformation on how to lock and unlock a SQL Editor window, see "Locking a SOL
Editor Window to a Datasource” on page 748

With a Datasource Navigator active, while an unlocked SQL Editor window is open, the selected
datasource can be changed explicitly or automatically in response to Explorer navigation or
related user interface actions.

This can result in the following issues:

e Active session-specific features such as execution directives and query options being sent to
the wrong datasource

e Features such as Semantic Validation returning false errors
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How the selected datasource changes depends on the state of the Link button appearing at the
top of the Explorer pane:

Link Button State Description
f@ﬁ You can explicitly change the active datasource by selecting a datasource from the
Select Datasource dropdown. The active datasource changes automatically as

datasource-associated windows such as object editors become active in the
The Explorer is linked to the | Workspace or as you select nodes in the Explorer.

Select Datasource combo As a side effect, the associated datasource node in the Explorer tree is selected.

When linking is inactive, you can only explicitly change the active datasource when

@ an SQL Editor window is open. The active datasource still changes automatically as
datasource-associated windows such as object editors become active in the

The Explorer is NOT linked to | Workspace. And when linking is inactive, the change in the selected datasource has

the Select Datasource no effect on the selected node in the Explorer tree.
combo
Table Owner Table Mame Index Mame

MOVIESL CUSTOMER CUSTOMER_IE1
MOVIESL CUSTOMER CUSTOMER_IE2
[EElMOVIEST CUSTOMER CUSTOMER_IE3
MOVIESL EMPLOYEE EMPLOYEE_IE1

[EEMOVIESL  EMPLOYEE EMPLOYEE_IE2 WORK|NG WITH BOOKMARKS

Rapid SQL supports easy datasource navigation with the Bookmarks. You can right-click any
node of the Explorer tree and add a bookmark. After a bookmark is created, you can simply
select it from the Bookmarks menu, and be instantly positioned and connected to the resource
in the Datasource Explorer tree.

Up to 256 bookmarks can be created.

To create a bookmark

1 On the Navigator, right-click the target node, and then select Add Bookmark. Rapid SQL
opens the Add Friendly Bookmark Name dialog.

2 Type the Explorer bookmark name.
3 Click OK.

NOTE: Rapid SQL will not let you create multiple bookmarks referencing the same
node.
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To navigate to a bookmarked node

1 Select the Options menu (designated with a down arrow, above the Navigatortree), select
Bookmarks, select a DBMS platform, and then select the bookmarked node.

Editing Explorer Bookmarks

1 Select the Options menu (designated with a down arrow, above the Navigator tree), and
then select Bookmarks > Bookmark Manager. Rapid SQL opens Bookmark Manager

dialog.

® Rename a bookmark by selecting it and then clicking Rename. Then use the Edit

Bookmark Name dialog to provide a new name.

¢ Delete a bookmark by selecting it and then clicking Delete.

INITIATING OBJECT ACTIONS IN THE NAVIGATOR

In the Datasource Navigator, right-click options let you initiate object actions against object
types or against specific objects.

4 Indexes (1541)

3 CATAANAIYFE QUTPLT.AMAIYAE QOUTPUT

. [El CAT

. [B cTxs
. [El CTxs
S ERars
. [El CTxs

» [El CTX 4

. [E] CTxs
. [E] CTxs
. [E] CTxs
. [El cTxs
., [E] CTxs
. [E] CTXS
S ERars
» [El cTxs
. [E] CTxs
. [E] ExFS
. [E] ExFS
» [E] ExFS]
. [E] ExFS]
. [E] EXFST
. [E] ExFST
» [E] ExFs)
. [E] FF.D

]

%
x
[

SaL

HTHL

Create
Open
Drop
Extract
Report

Rename...
shrink...
Analyze...

Allocate Extent...

Deallocate Unused Space...

Rebuild...
Convert to Partitioned..,
Estimate Size...

Disconnect

Refresh
Filter...
Copy object name(s)

Add bookmark

b
b

AME

WOALID

Vs
1D

HRASE

EEIDX

LWCTAB
“TRVRSLK
MOTAG
INORDER
DEL3

x FIF. DEFERCIEMTCY_IRSSI0E_DEFERDERTY_INS3

For detailed instructions, see the following topics:
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e "Creating objects" on page 255

e "Modifying objects using editors" on page 453

e "Object actions" on page 585

For context information, see "Working with Bookmarks" on page 149.

WORKING WITH SUPPLEMENTARY ORGANIZER TABS
In addition to the commonly used Explorer tab, the Organizer window offers the following tabs:
® Project - when working with Rapid SQL's Project Management feature, this tab provides a

visual method for browsing, accessing, and manipulating your projects. For more
information on working with projects, see "Project Management" on page 781.

¢ VC Files - when working with Rapid SQL's Version Control feature, this tab provides access
to version control files. For more information on working with projects, see "Version
Control" on page 803.

¢ Favorites - lets you designate and access favorite scripts. This tab lets you view, navigate,
save, recall, and execute scripts. Sample Favorite Scripts are installed for Microsoft SQL
Server, Oracle, and Sybase Adaptive Server. For more information, see Favorite Properties

Dialog Box.

FAVORITE PROPERTIES DIALOG BOX

The table below describes the options and functionality on the Favorite Properties dialog box:

Option Description

Description Lets you enter a description.

File Name Lets you type or browse and locate a file.
Hot Key Lets you enter a Hot Key.

Hot Keys must begin with CTRL or be stand-alone function
keys. Rapid SQL automatically places the CTRL command in
front of any character.

File Type Lets you select a file type.

CUSTOMIZING THE NAVIGATOR DISPLAY

Rapid SQL offers flexibility in the elements displayed and in how elements are displayed in the
Datasource Explorer and Datasource Navigator.
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Basic Viewing Options in the Navigator

e Categorizing Datasources using Color-coding and Labeling

e Categorizing Datasources using Color-coding and Labeling

Filtering in the Navigator

BASIC VIEWING OPTIONS IN THE NAVIGATOR

The dropdown menu, available above the Datasource Navigator tree, provides basic
organization and display options.

+-[(3) DB2 Servers % rganize by Object Owner
M3 S0L S |

22 Gl Servers | Showe Syskem Objects k

-7 MySaL Servers | |
i |

+-[7) Cracle Servers ' Full Refresh |

+-[771 Svbase Servers | |
Expand all Groups

| Collapse All Groups .

:1 Collapse All Datasources

J : Retain Yiew Settings [
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To change basic organization and viewing options

1 From the Options dropdown menu, select an option. Use the following table as a guide to

your selection.

Option

Description

Organize by Object Owner or
Organize by Object Type

Toggling these options has the following effect:

Owner - the Navigator displays objects for each user, categorized by object
type. This display mode is most efficient if you are working with databases
containing a high number of objects.

Type - the Navigator displays all objects, categorized by object type, for all
users in the same list. This display mode speeds or slows performance in
databases that contain many objects.

Show System Objects and Show
Only My Objects

Lets you control display of system objects and objects that you own: NEVER,
ALWAYS, or USE DATASOURCE FILTER. For information on filter options, see
Simple, on-the-fly, Character-based Tree Filtering.

Full Refresh

Select to refresh.

Expand All Groups

Select to expand all groups.

Collapse All Groups

Select to collapse all groups.

Collapse All Datasources

Select to collapse all datasources.

Retain View Settings

Select to retain the current state of the Explorer so that the it opens the same
way the next time you start Rapid SQL.

Bookmarks Provides access to bookmark resources. For more information, see "" on
page 151.
TIP:  You can also set these options on the Explorer Options tab of the Options editor.

WORKING WITH DATASOURCE GROUPS

Rapid SQL lets you define datasource groups to organize the datasources in your enterprise.
Datasource Groups behave as folders in the Windows Explorer, allowing you to group related
datasources together. Anywhere that datasources are presented in a hierarchical tree format,
datasource group folders expand to display one or more contained datasources.

By default, the Datasource Navigator has one group per supported DBMS platform.
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— [ DB2 Servers
My_Custorn_DB2_Subgroup 1 4
My_Custom_DB2_Subgroup 2 +
Default e it [ﬁl Interbase-Firebird Servers

Database | [ MS 5QL Servers i ;'-r':‘u““: N
Groups — [ My50L Servers Sub P
My_Custom_Group + ubgroups
—+ Oracle Servers
5 ;h‘!] ROMLABORCU1g_2 (Oracle11.1.0.7) ) Contained
» g TORLABORCL11g 1 (Oracle) = Datasources

f %!] TORLABORCI11g 2 (Oracle11.1.0.5)
—* [ Sybase Servers

Rapid SQL lets you create custom groups or subgroups. This level of organization is useful if you
want to group large numbers of registered datasources or have another need to organize
datasources. For basic database group maintenance tasks, see the following topics:

® "Removing, Adding, and Renaming Datasource Groups" on page 155.

e "Changing the Level of a Datasource Group in the Hierarchy" on page 156.

When you manually register a datasource, you have the option of changing the default group to
which Rapid SQL will automatically assign the datasource. Subsequently, you can move a
datasource from one folder to another. For details, see "Moving Datasources Between Groups"
on page 154.

MOVING DATASOURCES BETWEEN GROUPS
Rapid SQL offers two ways change datasource groups:

¢ Dragging the datasource between groups
¢ Invoking the Change Group dialog box.

NOTE: You should always disconnect from a datasource before changing datasource groups.

To move a datasource between groups by dragging and dropping

1 If necessary, expand groups until both the datasource and the target datasource group are
visible.

2 Drag the datasource over the target folder and drop it there.
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i MyS0OL Servers
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. Hiw TORLABSY15_3 (Sybase 15.0.0.0)

To move a datasource using the Change Datasource Group dialog box
1 If necessary, expand groups until the datasource you want to move is visible.

2 Right-click the datasource you want to move, and select Change Group.
Rapid SQL opens the Change Datasource Group dialog box.

3 Use the select... tree to locate and select the target group.

4 Click OK.

For more general information on datasource groups and associated tasks, see "Categorizing
Datasources using Color-coding and Labeling" on page 157.

REMOVING, ADDING, AND RENAMING DATASOURCE GROUPS

Rapid SQL offers a set of datasource group maintenance tasks. You can remove database
groups that you no longer need to access, or that have otherwise become obsolete. Keep the
following in mind when removing datasource groups:

e |f a datasource group contains datasources or other datasource groups, those items are
deleted when you delete the containing group. You should move any contained datasources
or groups before preceding. For details on moving datasources, see "Moving Datasources
Between Groups" on page 154.

e The default datasource groups correspond to the DBMS platforms supported by Rapid SQL.
If you delete a default group, it will be recreated if you subsequently register a datasource
for the associated platform.

To remove a datasource group

1 If necessary, expand datasource groups in the Explorer until the datasource you want to
remove is visible.

2 Right-click the datasource group, and select Remove. Rapid SQL prompts you to verify.
3 Click Yes.

Similarly, Rapid SQL lets you define datasource groups to organize the datasources in your
enterprise.
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To create a new datasource group

1 If creating a folder within an existing folder, expand datasource groups in the Explorer until
the target group is visible.

2 On the Explorer tree take one of the following actions:

¢ To create a new folder at the top level, right-click in empty space and select New from the
context menu.

¢ To create a folder within an existing folder, right-click the target folder and select New
from the context menu.

Rapid SQL opens the New Datasource Group dialog.
3 Inthe Datasource Group Name box, type the name of the new datasource group.
4 Click OK.

Lastly, Rapid SQL lets you change the name of an existing datasource group.

To rename a datasource group

1 If necessary, expand datasource groups in the Explorer until the datasource you want to
rename is visible.

2 On the Explorer, right-click the datasource group folder, and select Rename. Rapid SQL
opens the Rename Datasource Group dialog.

3 In the Datasource Group Name box, type the new name of the datasource group.
4 Click OK.

For related information, see the following topics:

e See "Changing the Level of a Datasource Group in the Hierarchy" on page 156 for
information on changing hierarchy levels.

e See "Categorizing Datasources using Color-coding and Labeling" on page 157 for more
general information on working with datasource groups.

CHANGING THE LEVEL OF A DATASOURCE GROUP IN THE HIERARCHY

Rapid SQL lets you reorganize the datasource group tree by moving individual groups up and
down the hierarchy.

To move a datasource group to the top level of the hierarchy

1 If necessary, expand groups until the datasource group you want to move is visible.

2 Drag the target group to open space in the Explorer pane.
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To make a datasource group a subgroup within another group

1 If necessary, expand groups until the datasource group you want to move and the target
group are visible.

2 Drag the target group and drop it on the datasource group that is to be the new parent.
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For related information, see the following topics:

e See "Removing, Adding, and Renaming Datasource Groups" on page 155 for information
on basic datasource tree tasks.

e See "Categorizing Datasources using Color-coding and Labeling" on page 157 for more
general information on working with datasource groups.

CATEGORIZING DATASOURCES USING COLOR-CODING AND LABELING

Rapid SQL provides a means to visually distinguish between datasources used for different
purposes in your organization. You can assign a category, such as development or production,
when creating or editing a datasource. This color-codes or labels particular user interface
elements associated with that datasource.

When you assign a category to a datasource, the Navigator icons for the datasource show a
distinctive color-coded category indicator. Optionally, you can customize your categorization
scheme to include the following user interface elements:

¢ A short name label included in the Datasource toolbar combo/dropdown when a
categorized datasource is selected

e Color-coded tabs on windows associated with actions against a categorized datasource,
editor or ISQL windows for example
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e Color-coding of the status bar at the bottom of the Rapid SQL window
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The default categories [and short name labels] and the associated colors are as follows:

Default Category Short Name Label Color
Production PROD .
Development DEV .
QA QA .
Test TEST D

In addition to the defaults, you can create custom category/color code/label category
combinations.

To work with color-coded datasource resources, you must be familiar with the following tasks:

* Enabling the specific user interface items that can be color-coded or labelled. For details,
see "Datasource Options" on page 87.
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e Customizing your category scheme. For details, see Customizing Datasource Categories.

® Assigning a category to a datasource when creating or editing it. For details, see "Manually
Registering or Editing Datasources" on page 123.

CUSTOMIZING DATASOURCE CATEGORIES

Rapid SQL lets you customize your datasource category scheme. A datasource category has the
following configurable components:

e Category name - The name displayed as a selection in the Select a category dropdown

e Short Name - The abbreviation shown in the Datasource toolbar dropdown when a
categorized datasource is selected.

e Color - The color used to denote a categorized datasource in the Navigator tree icons and
window tabs.

NOTE: Display of specific user items used to denote categories is configurable. For more
information, see "Datasource Options" on page 87.

To customize your datasource categories

1 On the Datasource menu select Register Datasource and then select the Datasource
Group panel.

2 From the Select a category dropdown select Customize. The Manage Datasource
Categories dialogs opens.

3 Take one of the following actions:

¢ Create a new category by clicking New and selecting or providing a Full name, Short
name, and Color combination.

e Edit an existing category by selecting the category, clicking Edit and modifying the name
and color combination.

NOTE: The short name for a category cannot be edited.

¢ Delete an existing category by selecting the category, clicking Delete and verifying the
deletion at the prompt.

FILTERING IN THE NAVIGATOR
For ease of navigation, Rapid SQL lets you filter the Navigator tree to display only selected
nodes and objects. Rapid SQL offers the following filtering options:

® Real-time modification of the tree to show only nodes with names matching a typed
character string. For details, see Simple, on-the-fly, Character-based Tree Filtering.
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® Permanent object filters, enabled and disabled for individual datasources, that restrict
display based on object name and owning schema (and optionally, object type). For details,
see Object Name/schema Filtering.

* The ability to restrict object types displayed for each DBMS platform. For details, see Node
or Object Type, Filtering.

Two default filters applying to owned and system objects are available. For details, see Using the
Default Filters.

SIMPLE, ON-THE-FLY, CHARACTER-BASED TREE FILTERING
The Filter box at the top of the Navigator provides a quick, ad hoc way to restrict the nodes
displayed.

I x4

To restrict the Explorer tree display to only user-defined nodes whose name contains a
particular character string

e Type one or more characters in the Filter box.

The display is updated to show only nodes whose name contains the typed character string and
their parent nodes.

NOTE: The Clear button in the Filter box (X) deletes the contents of the Filter box and restores
the unfiltered tree display.

OBJECT NAME/SCHEMA FILTERING

Object filters let you restrict the Navigator tree display for a datasource by name, owning
schema, or name/schema combinations. These filters are defined at the DBMS platform level
and are enabled or disabled on a datasource by datasource level. Multiple object filters can be
created for a DBMS platform, letting you enable combinations of filters for a single datasource,
ad hoc enabling and disabling of individual filters depending on your requirements, and so on.

Each filter consists of one or more ANDed conditions based on name or schema. For example,
you could create a two-condition filter that restricts the Navigator tree for a datasource to
display only objects belonging to the Schema QA and whose name starts with the string Test.
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Each filter condition is a simple expression that tests object names for equality (Equals, Not
Equals), inclusion in a specified list (In, Not In), or using pattern matching (Like, Not Like).
Optionally, an object filter can also be used to restrict display of specified object types on a
datasource.

To create an object filter that can be enabled for all datasources for a DBMS platform

1 Right-click in the Navigator tree and select Filter from the context menu.

The Filters dialog opens. The Object Filters tab opens by default, letting you create an
object filter definition. The Node Filters tab, on the other hand, lets you perform real-time
filtering of object types for all datasources on a DBMS platform. For details, see Node, or
Object Type, Filtering.

2 Inthe View area, select By Filter.

NOTE: The current instructions create a filter at the DBMS level. To create a filter for a single
datasource, select the By Datasource view, select a specific datasource, and then
proceed to step 4.

3 Expandthe icon corresponding to the DBMS for which you want to create a filter and ensure
that the icon is selected.

4 Click New and type a name for the new filter.
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7

On the Predicates tab, create one or more name-based or schema-based conditions, all of
which must be satisfied when this filter is enabled. Objects that do not satisfy the conditions
will be filtered from view. Use the following guidelines in constructing conditions:

¢ The Like and Not Like operators take pattern-matching Values. Rapid SQL supports the
wildcard characters and conventions supported on the target DBMS.

e The In and Not In operators take a comma-delimited list such as CO,CA,CU, as a Value.
e Click the associated New button to add new predicates.

Optionally, on the Database Elements tab, select the check boxes for all object types to
which this filter is to be applied. The filter does not affect the display of any deselected
object types.

Click OK.

By default, when you create an object filter for a DBMS platform, it is enabled for each
registered datasource of that DBMS type.

To disable or enable an object filter for a datasource

1

Right-click in the Navigator tree and select Filter from the context menu. The Filters dialog
opens.

In the View area, select By Datasource.

Expand the icon corresponding to the target DBMS and then expand the icon
corresponding to the specific datasource for which you want to for enable or disable a filter.

Enable an object filter by selecting the associated check box or disable the object filter by
deselecting the check box.

Click OK.

NOTE: You can also enable and disable filters using controls found under the Filters node for
each datasource in the Navigator tree.

You can also use the Filters dialog to select and edit an object filter, rename or create a clone of
an existing object filter, and delete filters.

NODE, OR OBJECT TYPE, FILTERING

Node filtering lets you hide specified Navigator tree nodes for a DBMS platform. For example, if
you do not typically work with credential-related objects such as users, groups, profiles or logins,
you may wish to filter those out of the Navigator tree. You could either disable display of the
individual object types or if practical, disable display of the Security node for the DBMS.
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To change the hidden/displayed status of object types for a DBMS platform

1

Right-click in empty space in the Navigator tree and select Filter from the context menu.
The Filters dialog opens.

The NodeFilters tab opens by default, letting perform real-time filtering of object types for
all datasources on a DBMS platform. The Object Filters tab, on the other hand, lets you

create permanent, name-based or schema-based filters. For details, see "Object Name/
schema Filtering" on page 160.

Click the Node Filters tab.

Expand the icon corresponding to the DBMS for which you want to create a node filter, and
continue to expand nodes until all nodes for which you want to change the hidden/
displayed status, are visible.

Ensure that all nodes corresponding to objects types that are to be displayed, are selected.
Similarly, ensure that all nodes corresponding to objects types that are to be hidden, are
deselected.

5 Click OK.

Hidden/displayed status is retained for the DBMS until you explicitly open the Filters dialog and
change the current settings.

USING THE DEFAULT FILTERS

The Filters node for each registered datasource includes two default Navigator tree filters,
Ignore System Objects and Show Only My Objects. These filters can be enabled and disabled
for each datasource but cannot be edited or deleted.

USING THE MANAGE DATASOURCES UTILITY

The Manage Datasources dialog box lets you manage datasources throughout your enterprise
from a single vantage point. It provides concise, relevant information on your datasources in a
simple grid format. It provides centralized access to common datasource operations such as
adding, modifying, deleting, discovering, importing, and exporting datasources.

To open the Manage Datasources dialog box:

1

On the Datasource menu, click Manage Datasources.

Rapid SQL opens the Manage Datasources dialog box.
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The grid format lets you access and view datasource specifications. datasources are grouped
according to the default, DBMS-based folder structure and then within any custom datasource
groups you have set up. The table below describes information available for each datasource

entry:

Column

Description

Datasource Name

Uses an explorer-like interface to display all registered datasources and their groups. You
can navigate this column in the same manner as the datasource explorer, by clicking on
nodes to expand or collapse your view of the datasources.

Connect String

Displays the full connection string for the datasource.

Default User Id

Displays the Default User ID for the datasource.

Auto-Connect?

Indicates whether the Auto Connect feature is turned on or off.

Host Computer

Displays the name of the Host Computer if one has been configured.

Default Schema

Displays view default schemas for your DB2 datasources.

In addition, you can take the following actions:

e Click the New Datasource button to register a datasource. For more information, see
"Registering Datasources" on page 121.

e Select a datasource and click the Edit Datasource button to edit that datasource definition.

e Select a datasource and click the Remove Datasource button to unregister that datasource
definition. For more information, see "Categorizing Datasources using Color-coding and

Labeling" on
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page 157.
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e Click the Discover button to locate all configured datasources on your network and
automate the process of registering them. For more information, see "Moving Datasources
Between Groups" on page 154.

® Import or export datasource definitions. For details, see "Importing and Exporting
Datasource Definitions" on page 139.
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DB TEAM SERVER SUPPORT

DB Team Server is a data governance repository that can be used as an aid in managing
enterprise data. It centralizes data resources, aids in resource-allocation planning, and fosters
collaboration.

As an inventory, DB Team Server stores the following resources:
e Datasource definitions
e ER/Studio data models
¢ Glossaries and definitions
e User details.

Team Server is also a communications hub and information center. Activity streams provide the
following:

e Datasources are monitored for DBMS alerts on conditions regarding storage and
performance.

e Add, modify, and delete resource details are logged.
e Users can post comments on resources or to other users.
Common social media conventions such as Likes and Follows are supported.

Rapid SQL integrates with DB Team Server. The following options are provided:

Datasources Datasource definitions on DB Team Server can be viewed in a dedicated Team Server
Navigator. Local datasources created from the Team Server definitions can be permanently
synchronized with the definitions on Team Server. A set of options and actions let you manage
your local and DB Team Server datasource definitions and their relationships.

An advanced search mechanism is also provided. For details, see "Working with DB Team
Server Datasources" on page 168.

Data models If a database or schema of a synchronized datasource has associated model data in Team
Server, model data such as alerts and attribute/entity descriptions can be displayed in the
SQL Editor as Code Assist proposals, as comments automatically added to scripts, as tooltips,
and as the basis for warnings due to alerts. For details, see "Viewing Embarcadero Team
Server Model Metadata in the SQL Editor" on page 175.

Activity Streams Users can monitor their own activity stream or the activity stream for a datasource definition
on the Team Server. For details, see "Working with DB Team Server Streams" on page 175.

In addition, Rapid SQL lets you open a browser interface that lets you work directly with DB
Team server. For details, see "Working Directly with DB Team Server" on page 176.
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SETTING UP AND CONNECTING TO DB TEAM SERVER

Before you can make use of resources on DB Team Server, you must login to the server. See your
Team Server administrator for a login URL, credentials, and permissions setup.

1 Ensure that DB Team Server usage is enabled. For details, see "Team Server Options" on
page 117.

2 Select Tools > Team Server > Login and then use the Embarcadero Team Server - Log In
dialog to provide credentials and complete the login.

NOTE: Use the Keep me signed in check box to have logins persist across startups and
shutdowns of Rapid SQL. The Keep me signed control can be set and disabled using
a registry entry. For details, see "Locking Down Rapid SOL Features Using the
Registry" on page 119.

The Team Server Navigator opens. After logging in, you have access to resources on the DB
Team Server. For a general description of available functionality, see Using the Team Server

Navigator.

For related information, see the following topics:

* "Viewing Embarcadero Team Server Model Metadata in the SQL Editor" on page 175

e "Working with DB Team Server Streams" on page 175

e "Working Directly with DB Team Server" on page 176

WORKING WITH DB TEAM SERVER DATASOURCES

With Rapid SQL properly configured, and subsequent login to DB Team Server, a dedicated DB
Team Server Navigator shows the available datasource definitions on the DB Team Server. A
datasource definition on DB Team Server can be registered as a local datasource.

Registering a DB Team Server datasource as a local datasource creates a local copy of the
datasource definition, accessible in the existing Datasource Navigator.
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NOTE: For access to DB Team Server documentation, see docs.embarcadero.com.

By default, when you register a DB Team Server datasource as a local datasource, the local
definition is “attached” to the DB Team Server version. The local definition’s key connectivity
information is synchronized with the DB Team Server definition on each attempt to connect to
the datasource.

An attached datasource has a distinctive icon:
‘?‘J‘l!l

You can subsequently detach a local datasource definition from a DB Team Server definition.
Settings for the detached, local datasource definition are those that were active on the DB Team
Server definition when the datasource was detached. When no longer attached to a DB Team
Server datasource definition, a detached datasource is functionally no different than any locally
registered (manually registered or automatically discovered) datasource.

The Team Server Navigator lets you perform tasks such as attaching local datasources and
managing datasource definitions residing on DB Team Server.
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WORKING WITH DB TEAM SERVER DATASOURCES

Basic steps in getting started with DB Team Server datasources are as follows:

1 Enable and configure DB Team Server usage - For details, see "Team Server Options" on
page 117.

2 Login to DB Team Server from Rapid SQL - For details, on how to establish a session with
DB Team Server, see "Setting up and Connecting to DB Team Server" on page 168.

3 Register DB Team Server datasources definitions as local datasources - See "Using the
Team Server Navigator" on page 170 for information on how to use a simple Explorer
interface to manage your local/DB Team Server datasources.

NOTE: Key connectivity information, the Connection Information tab settings
(excluding Datasource Name) and a custom JDBC driver if supplied, is not
editable in the resulting local datasource definition. Security Parameters tab
information, such as User ID and Password) is not copied to the local
datasource definition.

4 Connect to a Team Server datasource that you have registered locally - See
"Connecting to Datasources" on page 142.

For related information, see "Viewing Embarcadero Team Server Model Metadata in the SOL
Editor" on page 175.

USING THE TEAM SERVER NAVIGATOR

The Team Server Navigator displays datasources on DB Team Server and lets you work with
relationships to local datasources.

Before working with the Team Server Navigator:

® Familiarize yourself with the Datasource Navigator. It offers comparable functionality. For
details, see "Using the Datasource Navigator" on page 146.

¢ Understand the basics of DB Team Server datasource support. For details, see "Working
with DB Team Server Datasources" on page 168.

To display the Team Server Navigator

1 Ensure that DB Team Server usage is enabled and that you are logged in. For details, see
"Setting up and Connecting to DB Team Server" on page 168.

2 Use View > Team Server > Navigator to toggle display of the Team Server Navigator.

At the topmost level, the Saved Searches folder contains search definitions you created using
the advanced search feature. For details, see "Searching DB Team Server for Datasources" on
page 172. The All Data Sources folder stores definitions for all available datasources on the DB
Team Server. The My Data Sources folder provides access to those datasources that you are
following, as set up on your DB Team Server account.

Within the two datasource folders, the next levels in the expandable tree are:
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® Datasource groups

WORKING WITH DB TEAM SERVER DATASOURCES

e Datasource definitions in the DB Team Server repository
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Using the Datasource Navigator and the Team Server Navigator displayed, you can then:

e Create a local datasource from a definition on the repository - Register a local datasource as
you would any static datasource but use the Relate Team Server Source control to attach

the local definition to a specified Team Server datasource definition. For more information,
see "Manually Registering or Editing Datasources" on page 123.

The icon for a datasource that is attached to a Team Server definition shows a green arrow
in the upper left.

'?J‘l!l

Detach a currently attached local datasource definition so that it is no longer synchronized
with the DB Team Server definition - right-click the attached datasource in the Datasource
Navigator and select Unrelate Team Server Data Source and select Yes when prompted to
verify.

Work directly with datasource definitions in DB Team Server - Right-click a repository
datasource definition in the Team Server Navigator, and select Manage in Team Server.

Filter displayed nodes by name - Type one or more characters in the filter box at the top of
the Explorer to show only nodes whose name contains the typed character string and their
parent nodes.
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Je!

e Display nodes by attached/unattached status - Use the Filter option on the dropdown menu
at the top of the Team Server Navigator to display all datasource definitions, only definitions
from which a local datasource has been registered, or only definitions from which no local

datasource has been registered.

e Work with multiple local and Team Server datasources. For details, see "Reconciling Local

and Team Server Datasources" on page 174.

SEARCHING DB TEAM SERVER FOR DATASOURCES

While the Team Server Navigator provides a useful browsing mechanism, Rapid SQL also lets
you perform an advanced search of datasources on DB Team Server. The Team Server Data
Source Search dialog lets you search for Team Server datasource definitions by name or by one

or more ANDed conditions:

Name Datasource Type
Definition Production Level
Application Affinity Status

Version, Space Used Space Used %
Space Free % Number of Cores
Host Ping Time Database Ping Time

Host Name

Location

Additional Notes

Space Free

Logins, Statements Executed

Query Response Time
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Haost name

MName

Type Wersion
Definition

Producdtion level

Location

Application affinity
Status

Additional notes
Wersion

Space used

Space used %
Space free

Space free %
Mumber of cores
Lagins

Statements executed Close

Host ping time =

Database ping time

Query response time

To initiate a name-based or criteria-based advanced search

1 Ensure that DB Team Server usage is enabled and that you are logged in. For details, see
"Setting up and Connecting to DB Team Server" on page 168.

2 Select Datasources > Team Server Data Sources. The Team Server Data Source Search
dialog opens.

To search by criteria
1 Use the expand/collapse control to expose the condition controls.

¥

This deactivates the Search box.

2 Use the criteria, operator, and value controls to create a condition.
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3 To add conditions, use the + control and repeat the previous step.

4 When ready, click Search.

For more general information on DB Team Server integration, see "DB Team Server Support” on
page 16/.

RECONCILING LOCAL AND TEAM SERVER DATASOURCES

While the Team Server Navigator provides separate, individual operations for working with the
relationships between local and Team Server datasource definitions, the Reconcile Team Server
Data Sources dialog lets you work simultaneously with multiple datasource definitions.

To reconcile multiple datasource definitions

1

Ensure that DB Team Server usage is enabled and that you are logged in. For details, see
"Setting up and Connecting to DB Team Server" on page 168.

On the Team Server Navigator dropdown, select Reconcile Data Sources. The Reconcile
Team Server Data Sources dialog opens.

Reconcile your Team Server and local datasources using the three list boxes as follows:

e Matching data sources - lists DB Team Server datasource definitions and local datasource

definitions with identical connection information details but that are currently not
attached. Selecting an entry from this list attaches the local datasource to the Team Server
datasource, ensuring that any changes to the DB Team Server definition will be copied to
the local datasource definition on the next attempt to connect to the datasource

NOTE: For more information on local, attached, and matching datasource definitions, see
"Working with DB Team Server Datasources" on page 168.

* Unmatched Team Server data sources - lists DB Team Server datasource definitions for

which there are no local datasource definitions with matching connection information.
Selecting an entry from this list creates a matching local datasource definition and
attaches the local definition to the matching Team Server datasource definition.

¢ Unmatched local data sources - lists local datasource definitions for which there are no

DB Team Server datasource definitions with matching connection information. Selecting
an entry from this list creates a matching Team Server datasource definition and attaches
the local definition to the DB Team Server datasource definition.

4  Click Reconcile.
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WORKING WITH DB TEAM SERVER STREAMS

Embarcadero DB Team Server activity streams include user Likes, user follows, and alerts
associated with users or datasources. Rapid SQL lets you open a window to view your
notification.

NOTE: Embarcadero DB Team Server is a licensed feature. For access to Team Server features
and to obtain credentials, contact your Team Server administrator. For access to Team
Server documentation, see http://docs.embarcadero.com/.

To view the activity stream for a Team Server resource

1 Ensure that Team Server usage is enabled and configured. For details, see "Team Server
Options" on page 117.

2 Select View > Team Server > Streams. The Team Server Streams window opens.

3 Use the controls in the Team Server Streams window to display the activity stream for the
current user or a DB Team Server datasource definition.

For more general information on DB Team Server integration, see "DB Team Server Support" on
page 167.

VIEWING EMBARCADERO TEAM SERVER MODEL METADATA IN
THE SQL EDITOR

Rapid SQL's SQL Editor integrates with Embarcadero Team Server. Specifically, if a database or
schema has associated model data in Team Server, model data such as alerts and attribute/entity
descriptions can be displayed/included in the SQL Editor in the following ways:

e Attribute/Entity descriptions can be included in Code Assist proposals

¢ On explicitly formatting a script, metadata for tables and views referenced in SELECT,
CREATE PROCEDURE, CREATE FUNCTION, CREATE TRIGGER, CREATE VIEW statements
are added in a single comment block above the referencing statement

® \When hovering the mouse over a table column name, table name or view name, a tooltip
showing the entity/attribute description is displayed

e Warning icons are displayed in the window gutter beside lines referencing objects whose
metadata includes alerts

e On execution of a script referencing objects whose metadata includes alerts, the error pane
opens with an entry for each referenced object.

NOTE: Metadata for view columns is not available.
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WORKING DIRECTLY WITH DB TEAM SERVER

To use model metadata in the SQL Editor

1 Ensure that Team Server repository usage is enabled and that you are logged in to the Team
Server. For details, see "Team Server Options" on page 117 and "Setting up and
Connecting to DB Team Server" on page 168.

2 Configure the Metadata features in the Options editor. For details, see "ISQL Options -
Code Assist Tab" on page 106.

For related information, see "DB Team Server Support” on page 167.

WORKING DIRECTLY WITH DB TEAM SERVER

You can open a browser interface on DB Team Server to access its full range of functionality. This
includes increased datasource and data model functionality, access to glossaries and terms,
reporting, and access to other Rapid SQL users.

To open a browser interface on DB Team Server

1 Ensure that access to DB Team Server has been enabled. For details, see "DB Team Server
Support" on page 167.

2 Select Tools > Team Server > View in Web browser.

For access to the full set of DB Team Server documentation, see http://docs.embarcadero.com/.
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DATABASE OBJECT MANAGEMENT

For each supported DBMS, Rapid SQL provides extensive object management facilities. Almed
at both Database Administrators and Developers, Rapid SQL provides support for the most
commonly used object types. The following sets of topics describe the major areas of support:

Supported Objects Describes the database objects and related elements supported by Rapid SQL.
In addition to a listing of all supported objects by DBMS platform, a support
summary is provided for each object type.

Creating objects Tells you how to create new objects using graphical wizards.

Modifying objects using editors Tells you how to edit existing objects.

Object actions Provides details on the actions and operations that Rapid SQL lets you perform
against database objects.
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SUPPORTED OBJECTS

Rapid SQL lets you manage database objects across different database platforms. The table
below indicates the objects that Rapid SQL supports by platform:

TERA

=

< | DB2 LUW

< | DB2 z/OS
ITB/EBD *
MysQL
ORCL
PSTGRS *

< | SYB ASE

B

Aliases

<| «|SQLSVR

Asymmetric Keys

Blob Filters v

Certificates v

Chains

Check Constraints v v v

Clusters

SIENEEN RN
<
<
<

Database Links

Database Triggers v

Databases v v v v

DBSpaces v

DBSpaces v

Defaults v v

Directories v

Domains v v v

Encryption Keys v

Events v

Domains v

Events v

Exclusion Constraints v

Extended Procedures v

External Functions v

Foreign Keys v v v v v v

Full-text Catalogs

Full-text Indexes

AN RN RN

Functions v v v v v

Generators v

AN
AN
AN

Groups v

Indexes v v v v

Instance v

AN N NN
AN
AN
AN

Java Classes
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DB2 LUW

DB2 z/OS

ITB/EBD *

ORCL

PSTGRS *

SQL SVR

SYB ASE
1Q

TERA

Java Resources

Java Sources

Job Queues

Jobs (Oracle)

AN N I NT AN

Join Indexes

Libraries

Logins

Macros

Materialized Query Tables

Materialized Views

Materialized View Logs

Outlines

Package Bodies

Packages

AN EAN NN BN

Partition Functions

Partition Schemes

Plans

Primary Keys

Procedures

Profiles

Programs

Recycle Bin

Roles

AN B Y RN BN BN

Rules

Schedules

Segments

Sequences

Shadows

Structured Types

Symmetric Keys

Synonyms

System Indexes

System Tables

AN RN NN

System Triggers

Tables

\
AIEN RN RN
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%) * *
N V;‘ %é‘ I R T [ 5‘
a) a) = s O 2 & & & |—
Tablespaces 4 v v v
Triggers v v v v v v v v
Type Bodies v
Types v
Unigue Keys v v v 4 4 4 v v
User Datatypes v v v v
User Messages v v v
Users v v v v v v
Views v v v v v v v v
ALIASES

Aliases let you assume the permissions of another database user without creating a separate

user identity. You can use an alias when a user requires only temporary access to a database. You
can also use an alias to mask a user’s identity.

Platform availability

x| g | 9 |y | w

O %)
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a) a) = = O a D 0 0 [
v v v

Creating and editing

See the following topics:

e "Aliases Wizard (DB2 LUW)" on page 260 and "Aliases Editor (IBM DB2 LUW)" on page 462

e "Aliases Wizard (DB2 Z/OS)" on page 287 and "Aliases Editor (IBM DB2 Z/OS)" on page 481

e "Aliases Wizard (Sybase ASE)" on page 430 and "Aliases Editor (Sybase ASE)" on page 567
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Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

n

o N

8 | 8 | 5
Drop v v v
Extract v v v
Report v v v
Transfer Ownership v

ASYMMETRIC KEYS

Asymmetric keys, in addition to symmetric keys and certificates, provide Rapid SQL support for

Public Key Encryption. Asymmetric keys consist of a private key and corresponding public key
and are used to secure symmetric keys.

Platform availability
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Creating and editing

e "Asymmetric Keys Wizard (SOL Server)" on page 333 and "Asymmetric Keys Editor (SQL
Server)" on page 511

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Report

Related information

e "Certificates" on page 183

* "Symmetric Keys" on page 234
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BLOB FILTERS

Rapid SQL provides support for blob filters, user-written programs that convert data stored in
Blob columns from one subtype to another.

Platform availability
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Creating and editing

See "Blob Filters Wizard (ITB/FBD)" on page 314 and "Blob Filters Editor (InterBase/Firebird)"
on page 498.

Object actions/operations supported
The following object actions are available for this object type. For an introduction to object

actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Rename Report

CERTIFICATES

Certificates, in addition to symmetric and asymmetric keys, provide Rapid SQL support for
Public Key Encryption. Certificates are digitally signed security objects containing a public key
and optionally, a private key.

Platform availability

2 | g |: O e | w
@) %)
3 N e (_jl 1 ?5 & Z Q <
09|29 |8 (d/e|¢e|¢8
a a = = O £ & & & =
v

Creating and editing

e "Certificate Wizard (SQL Server)" on page 335 and "Certificates Editor (SQL Server)" on
page 511
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Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Add Private Key Backup Certificate Drop Extract Report

Related information
e "Asymmetric Keys" on page 182

® "Symmetric Keys" on page 234

CHAINS

The following summarizes support for named series of tasks

Platform availability
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Creating and editing

Rapid SQL does not allow you to create or edit this object type against PostgreSQL data
sources.

Object actions/operations supported

No specific object actions are available for this object type/

Related Information
See details for the following, related object types:

e "Jobs (Oracle)" on page 209

e "Programs" on page 226
e "Schedules" on page 230

CHECK CONSTRAINTS

Check constraints are data values that are acceptable in a column. They are logical expressions
that verify column values meet defined acceptance criteria.
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Platform availability
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Creating and editing
See "Add or Modify Check Constraint” on page 592.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

< A p x o
> 9 e 2 > @
N I — o )| < <
808 |8 |22 |a |9 |8
&) &) = O & A & =
Change Status (check v v
constraints
DI’OQ v v v v v v v v
Extract v v
Hide Text v
Rename v v v v v v
Report v v v v v v
Transfer Ownership v
CLUSTERS

Clusters provide an optional method of storing table data. A cluster comprises of a group of
tables that share the same data blocks, and which are grouped together because they share
common columns and are often used together. The related columns of tables stored in a cluster
are known as the cluster key.

There are two types of clusters:
* Index

* Hash

Index clusters store the cluster data together and index the cluster key, which should make them
faster at retrieving a range of data rows.
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Hash clusters apply hashing functions to the cluster key to determine the physical location of a
data row, which should make them faster at retrieving specific data rows.

NOTE: To place a table on a cluster, 6 include the ON CLUSTER syntax within the CREATE
TABLE statement. Placing a table on a cluster precludes you from placing it on a
tablespace or defining the associated storage parameters.

Platform availability

= 3 . ; @ "
(@) 9]
2| X i S, . o |7 | Q|9 -
N N ~ N ) = _ o o &
Q Q = = n a > > L
) ) = = O a ! O 0 —
v

Creating and editing
e "Clusters Wizard (Oracle)" on page 378 and "Clusters Editor (Oracle)" on page 537.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Allocate Extent Analyze Deallocate Unused Drop Extract
Space
Report Truncate

DATABASE LINKS

Database links are named schema objects that describe a path from one database to another.
Database links are implicitly used when a reference is made to a global object name in a
distributed database. To use a database link, either it is public or you own it.

NOTE: Oracle syntax does not let you alter an existing database link. To change its definition,
drop and re-create it.
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Platform availability
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Creating and editing

e "Database Links Wizard (Oracle)" on page 381 and "Database Links Editor (Oracle)" on
page 539

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Rename Report

DATABASE TRIGGERS

A database trigger implements a database-scope DDL trigger. These triggers fire in response to
events associated with DDL statements.

NOTE: Before working with database triggers, consult Microsoft SQL Server documentation
for a general understanding of DDL triggers. For more information, see Accessing Third
Party Documentation.

Platform availability
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Creating and editing

e "Database Triggers Wizard (SQL Server)" on page 337 and "Database Triggers Editor (SOL
Server)" on page 514

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Change Status Drop Extract Report
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DATABASES

Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals
of a database system are straightforward but challenging. In general, a database aims to
manage large amounts of data in a multi-user environment. It should achieve high performance
while letting many users access the same information concurrently without compromising data
integrity. A database also must protect against unauthorized access and provide reliable
solutions for failure recovery.

Platform availability
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Creating and editing

e "Databases Wizard (DB2 LUW)" on page 260 and "Databases Editor (IBM DB2 LUW)" on
page 463

e "Databases Wizard (DB2 Z/QOS)" on page 288 and "Databases Editor (IBM DB2 Z/OS)" on
page 482

e "Databases Wizard (SQL Server)" on page 336 and "Databases Editor (SQL Server)" on
page 513

e "Databases Wizard (Sybase ASE)" on page 430 and "Databases Editor (Sybase ASE)" on
page 568

NOTE: Objects of this type cannot be created or edited against PostgreSQL or Teradata
datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

(p] *
2109 |4 |9 |4
— N o )| < <
3|8 /3|2 |8
a a 2 i o an—J
Attach Database v
Checkpoint v v
Copy Schema v
DBCC 4 4
Detach Database
Drop v v v v v
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Drop Automatic Storage Path(s) v

Extract v v v v

Hide Text v

Move Log

Quiesce (Database) v

Rename v v

Report v v v

Resynchronize v

Set Online/Offline v

Shrink v

Start Database v

Stop Database v

Unguiesce v

Update Statistics v

DBMS-specific information
¢ |BM DB2 for Linux, Unix, and Windows Instances

e Microsoft SOL Server Databases

e |BM DB2 for OS/390 and z/OS Instances

e Sybase ASE Databases

IBM DB2 FOR LINUX, UNIX, AND WINDOWS INSTANCES

Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals
of a database system are straightforward but challenging. In general, a database aims to
manage large amounts of data in a multi-user environment. It should achieve high performance
while letting many users access the same information concurrently without compromising data
integrity. A database also must protect against unauthorized access and provide reliable
solutions for failure recovery.
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MICROSOFT SQL SERVER DATABASES

Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals
of a database system are straightforward but challenging. In general, a database aims to
manage large amounts of data in a multi-user environment. It should achieve high performance
while letting many users access the same information concurrently without compromising data
integrity. A database also must protect against unauthorized access and provide reliable
solutions for failure recovery.

NOTE: Microsoft SQL Server recommends that you do not create any user objects, such as
tables, views, stored procedures, or triggers, in the master database. The master
database includes the system tables that store the system information used by SQL
Server, such as configuration option settings.

IBM DB2 FOR OS/390 AND 7/OS INSTANCES

Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals
of a database system are straightforward but challenging. In general, a database aims to
manage large amounts of data in a multi-user environment. It should achieve high performance
while letting many users access the same information concurrently without compromising data
integrity. A database also must protect against unauthorized access and provide reliable
solutions for failure recovery.

SYBASE ASE DATABASES

Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals
of a database system are straightforward but challenging. In general, a database aims to
manage large amounts of data in a multi-user environment. It should achieve high performance
while letting many users access the same information concurrently without compromising data
integrity. A database also must protect against unauthorized access and provide reliable
solutions for failure recovery.

DBSPACES

Rapid SQL offers support for these tablespaces made up of one or more operating systemfiles.
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Platform availability
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Creating, and editing
Rapid SQL does not offer support for creating or editing objects of this type.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585..

Drop Extract

DEFAULTS

Defaults promote data integrity by supplying a default value to a table column if the user does
not explicitly provide one. They are reusable objects that you can bind to table columns or user
datatypes.

Platform availability
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Creating and editing

e "Defaults Wizard (SQL Server)" on page 338 and "Defaults Editor (SQL Server)" on
page 514

e "Defaults Wizard (Sybase ASE)" on page 432 and "Defaults Editor (Sybase ASE)" on
page 569
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Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

Drop

< | <« |SQLSVR

Extract

Hide Text

Rename

<| & | «| «|SYBASE

Report v

DIRECTORIES

Directories create an alias to an external operating system directory to your database files, which
can be used for storing large binary object files. When you create a directory, provide the full
path name to the outside operating system where the BFILE's are stored. This object lets you
store large files, such as video, outside of the database. The directory object lets you provide a
simple alias to the full path name of an outside server's file system, which you can then use to
point to the files when creating procedural logic objects. This saves the developer from having
to type the full path name when coding.

To create a Directory object, you need CREATE ANY DIRECTORY system privileges. You also
create or have in place a corresponding operating system directory to store the file. This
directory must have the correct read permissions for Oracle processes.

Platform availability
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Creating and editing
e "Directories Wizard (Oracle)" on page 382 and "Directories Editor (Oracle)" on page 539

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Report
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DOMAINS
Rapid SQL provides support for domains, letting you work with these type definitions.

Platform availability
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Creating and editing

"Domains Wizard (ITB/FBD)" on page 315 and "Domains Editor (InterBase/Firebird)" on
page 499.

NOTE: Rapid SQL does not support creation or editing of this object type against Sybase I1Q
or PostgreSQL datasources.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585..

x
& e
o —_—
= m
v >
o (@]
Change Owner v
Change Schema v
Drop v v
Extract v v
Rename v v
Report v

ENCRYPTION KEYS

Rapid SQL provides support for encryption keys, used in encrypting and decrypting tables and
columns.
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Platform availability
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Creating and editing

See "Encryption Keys wizard (ITB/FBD)" on page 316 and "Encryption Keys editor (InterBase/
Firebird)" on page 499.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Rename Report
EVENTS

Rapid SQL provides support for events, letting you work with these state changes that can be
monitored or used as trigger conditions.

Platform availability
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Creating and editing

Rapid SQL does not support creation or editing of this object type against a Sybase 1Q
datasource.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Object Properties
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EXCEPTIONS

Rapid SQL provides support for exceptions, letting you work with these named error messages.

Platform availability
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Creating and editing

See "Exceptions Wizard (ITB/FBD)" on page 317 and "Exceptions Editor (InterBase/Firebird)"
on page 500.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Rename Report

EXCLUSION CONSTRAINTS

An Exclusion Constraint guarantees that if any two rows are compared on the specified columns
or expressions using the specified operators, not all of comparisons will return TRUE.

Platform availability
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Creating and editing

Exclusion constraints currently cannot be created or edited within Rapid SQL.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract
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EXTENDED PROCEDURES

Extended Procedures are dynamic link libraries that can be used to load and execute application
routines written in other programming languages, such as C or Visual Basic. Extended
Procedures function and appear in the same manner as normal stored procedures in that you
can pass parameters to them and obtain results.

NOTE: Extended Procedures can only be accessed on the Master database.

Platform availability
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Creating and editing

e "Extended Procedures Wizard (Sybase ASE)" on page 433 and "Extended Procedures
Editor (Sybase ASE)" on page 569

Object actions/operations supported

Drop Describe Execute Extract Hide Text
Rename Report

EXTERNAL FUNCTIONS

Rapid SQL provides support for external functions, letting you work with declarations for existing
functions.

Platform availability
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Creating and editing

See "External Functions Wizard (ITB/FBD)" on page 318 and "External Functions editor
(InterBase/Firebird)" on page 501.

196 RAPID SQL 8.7.2/XE6 USER GUIDE



SUPPORTED OBJECTS > SUPPORTED OBJECTS

Object actions/operations supported

The

following object actions are available for this object type. For an introduction to object

actions and details on usage of specific actions, see "Object actions" on page 585.

Rename

FOREIGN KEYS

Foreign keys enforce referential integrity between tables by verifying the existence of foreign
key values in the parent table before letting you insert or update foreign key values in the child
table.

Platform availability
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Creating and editing

"Foreign Keys Wizard (DB2 LUW)" on page 262 and "Foreign Keys Editor (IBM DB2 LUW)"
on page 464

"Foreign Keys Wizard (DB2 Z/OS))" on page 289 and "Foreign Keys Editor (IBM DB2 Z/OS)"
on page 482

"Foreign Keys Wizard (ITB/FBD)" on page 319 and "Foreign Keys editor (InterBase/
Firebird)" on page 501

"Foreign Keys wizard (MySQL)" on page 370 and "Foreign Keys editor (MySQL)" on
page 533

"Foreign Keys Wizard (Oracle)" on page 383 and "Foreign Keys Editor (Oracle)" on
page 540

"Foreign Keys Wizard (SOL Server)" on page 340 and "Foreign Keys Editor (SQL Server)" on
page 515

"Foreign Keys Wizard (Sybase ASE)" on page 434 and "Foreign Keys Editor (Sybase ASE)"
on page 570

NOTE: Creation and editing of objects of this type is not supported against PostgreSQL,
Sybase 1Q, or Teradata datasources.
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Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.
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Change Status (check constraints) v v
Drop v v v v v v v v v
Extract v v v v v v v v
Rename 4 4 v v v v
Report v v v v v v
Transfer Ownership v
DBMS platform-specific notes
MySQL MySQL recognizes two types of tables, MylISAM and InnoDB. MyISAM tables access data

records using an index, where InnoDB tables allow transactions and foreign keys.
Therefore, the discussion of foreign keys is limited to your InnoDB tables.

FULL-TEXT CATALOGS

A full-text catalog is a set of operating system files that store full-text indexes. Full-text catalogs,

along with full-text indexes and the object actions supported for these object types, provide full
text search support in Rapid SQL.

NOTE: Before working with full-text catalogs, consult Microsoft SQL Server documentation for

a general understanding of full-text searching. For more information, see "Accessing
Third Party Documentation” on page 13.

Platform availability
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Creating and editing

e "Full-text Catalogs Wizard (SQL Server)" on page 341 and "Full-text Catalogs Editor (SQL
Server)" on page 516
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Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Rebuild (Full-text Catalogs) Reorganize (SOL Server Full-text Report
Catalogs

Related information
e "Full-text Indexes" on page 199

FULL-TEXT INDEXES

A full-text index stores information used by the Full-Text Engine to compile full-text queries that
can quickly search a table for particular words or word combinations. A full-text index stores
information about key words and their location within one or more columns of a table.

Full-text indexes, along with full-text catalogs and the object actions supported for these object
types, provide full text search support in Rapid SQL.

NOTE: Before working with full-text indexes, consult Microsoft SQL Server documentation for
a general understanding of full-text searching. For more information, see "Accessing
Third Party Documentation" on page 13.

Platform availability
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Creating and editing

e "Full-text Indexes Wizard (SQOL Server)" on page 342 and "Full-text Indexes Editor (SOL
Server)" on page 516

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Change Status (Full-text Indexes) Drop Extract Population status Report

Related information
e "Full-text Catalogs" on page 198
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FUNCTIONS

Functions are subroutines that you define. Functions are useful for reusable application logic.
You can use functions to determine the best methods for controlling access and manipulation of
the underlying data contained in an object.

The table below describes the types of user-defined functions that Rapid SQL lets you create:

Function

Description

Column or External
Table Function

You can write in a host programming language, such as C. This function can act on a table and
returns a table value rather than a scalar value.

External Scalar
Function

You can write in a language other than SQL, such as C++ or Java and returns a scalar value to
the program. This type of function is referenced by the CREATE FUNCTION statement and
can be used to perform computations on data contained in the database but cannot directly
reference the data.

OLEDB Function

Accesses OLE DB data in user-defined OLE DB external tables.

Sourced Function

Inherits the semantics of another function and can be an operator.

Template Function

Partial functions that do not contain any executable code. Mainly used in a federated
database to map the template function to a data source function -Oracle, SQL Server, Sybase
ASE, etc. A function mapping needs to be created in conjunction with the template function.

Platform availability
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Creating and editing
e "Functions Wizard (DB2 LUW)" on page 264 and "Functions Editor (IBM DB2 LUW)" on

page 464

e "Functions Wizard (DB2 Z/OS)" on page 290 and "Functions Editor (IBM DB2 Z/OS)" on

page 483

e "Functions wizard (MySQL)" on page 371 and "Functions editor (MySQL)" on page 533

e "Functions Wizard (Oracle)" on page 384 and "Functions Editor (Oracle)" on page 540

e "Functions Wizard (SOL Server)" on page 343 and "Functions Editor (SQL Server)" on

page 517

e "Functions Wizard (Sybase ASE)" on page 435 and "Functions Editor (Sybase ASE)" on

page 571

NOTE: Creation and editing of objects of this type is not supported against Sybase 1Q or
PostgreSQL datasources.
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Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

v x
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Change Owner v

Change Owner v

Compile v

Create Synonym v

Describe v v v

Drop v v v v v v v v

Execute v

Extract v v v v v v v

Hide Text v

Object Properties v v

Rename v v v

Report v v v v v v

Transfer Ownership 4

Important Notes

With respect to functions and stored procedures, it can be necessary to have statements
executed before and after creation of the procedure or function. This can be useful for example,
if you need to create or drop temporary tables used by the function or procedure. Rapid SQL
supports the use of two tag pairs, ETStart and ETEnd, that let you embed statements in the first
comment block of a stored procedure or function. The following shows the expected syntax:

create procedure dbo.procname(@a numeric) as
/*

<ETStart>SQL Statement</ETStart>

<ETEnd>SQL Statement</ETEnd>

*/

begin

GENERATORS

Rapid SQL provides support for generators, letting you work with these objects used to
generate sequential numbers in a column.
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Platform availability
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Creating and editing

See "Generators Wizard (ITB/FBD)" on page 320 and "Generators editor (InterBase/Firebird)"
on page 502.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Rename Report
GROUPS

Groups are a defined collection of database users. The primary use of groups is to consolidate
the management of permissions. By matching together similar users into groups, you can greatly
reduce the number of commands required to set permissions.

Every user automatically belongs to the public group. To assign a user to another group, add the
user to that group. Then the user belongs to that group and public.

NOTE: A user can only belong to one group at a time other than public.

Platform availability
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Creating and editing
e "Groups Wizard (Sybase ASE)" on page 436 and "Groups Editor (Sybase ASE)" on page 571

NOTE: Creation and editing of objects of this type is not supported against Sybase 1Q
datasources.
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Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.
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Drop v v
Extract v v
Report v
INDEXES

Indexes are optional structures associated with tables. You can create indexes specifically to
speed SQL statement execution on a table. When properly used, Indexes are the primary means
of reducing disk I/0. Indexes are logically and physically independent of the data in the
associated table. Unique Indexes guarantee that no two rows of a table have duplicate values in
the columns that define the index.

Platform availability
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Creating and editing

e "Indexes Wizard (DB2 LUW)" on page 267 and "Indexes Editor (IBM DB2 LUW)" on
page 465

e "Indexes Wizard (DB2 Z/OS)" on page 292 and "Indexes Editor (IBM DB2 Z/OS)" on
page 484

* "Indexes Wizard (ITB/FBD)" on page 320 and "Indexes editor (InterBase/Firebird)" on
page 503

® "Indexes, Primary Keys, or Unique Keys wizard (MySQL)" on page 372 and "Indexes, Primary
Keys, and Unique Keys editors (MySQL)" on page 534

e "Indexes Wizard (Oracle)" on page 385 and "Indexes Editor (Oracle)" on page 541

e "Indexes Wizard (SQL Server)" on page 344 and "Indexes Editor (SOL Server)" on page 517
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¢ "Indexes Wizard (Sybase ASE)" on page 436 and "Indexes Editor (Sybase ASE)" on
page 572

NOTE: Creation and editing of objects of this type is not supported against PostgreSQL,
Sybase IQ, or Teradata datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.
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Allocate Extent v
Analyze v
Check Index
Create Alias v
Deallocate Unused Space v
Disable Index v v
Drop v v v v v v v v v v
DBCC v
Estimate Size v v
Extract v v v v v v v v v v
Place v
Rebuild Index v v v
Rename v v v v v
Reorganize /Reorg v v v
Report v v v v v v v
Set Statistics v
Shrink 4
Transfer Ownership v
Update Statistics v v v

DBMS-specific information
¢ |BM DB2 for Linux, Unix, and Windows Indexes

IBM DB2 for OS/390 and z/OS Indexes

Microsoft SOL Server Indexes

Oracle Indexes

Svbase ASE Indexes

204 RAPID SQL 8.7.2/XE6 USER GUIDE



SUPPORTED OBJECTS > SUPPORTED OBJECTS

IBM DB2 FOR LINUX, UNIX, AND WINDOWS INDEXES
IBM DB2 for Linux, Unix, and Windows offers two types of indexes:

* Unique
* Non-Unique

Unique Indexes guarantee that no two rows of a table have duplicate values in the columns that
define the index.

MICROSOFT SQL SERVER INDEXES

Microsoft SQL Server offers two types of indexes: clustered and non-clustered. Clustered
indexes physically sort table data to match their logical order. Non-clustered indexes only order
the table data logically. In a database, an index lets you speed queries by setting pointers that
allow you to retrieve table data without scanning the entire table. An index can be unique or
non-unique.

Microsoft SQL Server creates indexes as B-Trees, which are a series of pointers mapping index
pages to their underlying data pages. As tables and, therefore, indexes grow, the number of
levels in the B-Tree increases. The B-Tree of a clustered index is shorter than that of a non-
clustered index because the leaf level of a clustered index is the data page.

A sound indexing strategy is critical to overall system performance. One pitfall to avoid is
placing many indexes on a table without regard for their cumulative cost. Remember that
indexes improve read but slow write performance because Microsoft SQL Server must update
more information in the system catalog. Consequently, extra indexes can actually slow overall
performance if data modification occurs frequently on the table. To determine the efficacy of
indexes, you should tune your queries using SHOWPLAN and IO STATISTICS and analyze the
selectivity of indexes using DBCC SHOW_STATISTICS.

Rapid SQL separates system indexes from user-defined indexes in the Datasource Navigator to
ensure that system indexes are not accidentally altered or dropped.

ORACLE INDEXES
Oracle offers two types of indexes. The table below describes these indexes:

Index Description

Table A table index is defined on an individual table.

Cluster A cluster index is defined on a set of tables physically stored together in a cluster. In an Oracle
database, both table and cluster indexes use a B-tree structure.

RAPID SQL 8.7.2/XEé6 USER GUIDE 205



SUPPORTED OBJECTS > SUPPORTED OBJECTS

The indexing strategy, particularly with large, active tables, is critical to overall system
performance. The optimal definition and number of indexes for a given table is determined by
the mix of access paths to that table performing insert, update, delete and select operations.
For example, adding or changing an index can speed up your selects but slow your inserts,
updates and deletes. Careful tuning and testing helps you achieve the best overall performance.

TIP: Indexes generally improve read operations in a database, but you should not place too
many indexes on some tables. Since Oracle must maintain each index along with its
referenced table, placing too many indexes on a table that is the object of much insert,
update, and delete activity, can actually degrade performance.

Even when an index exists on a table, the way a SQL statement is coded can actually disallow
the use of the index. To prevent this from happening, follow these rules of thumb:

® Try not to use SQL statements that include the NOT IN, NOT LIKE, <>, IS NULL operators
because they typically suppress the use of indexes.

e \When referencing concatenated indexes with queries, be sure the leading column in the
index is used. If it isn't, the index won't be used at all.

* Avoid using functions in WHERE predicates.

If you must use functions, investigate the use of function-based indexes.

INDEX PARTITIONS

Index partitions are similar to table partitions. There are three types of partitioned indexes that
Oracle supports:

1 Local prefixed
2 Local nonprefixed

3 Global prefixed

NOTE: An index cannot be partitioned if it is a cluster index or if the index is defined on a
clustered table.

Local prefixed and nonprefixed indexes

A local partitioned index has keys that refer to rows in a single table partition. A local partitioned
index is automatically partitioned to mirror the underlying table. The number of partitions or
subpartitions and the partition bounds for the partitioned index correspond with the partitions
on the table. Oracle maintains this correspondence. If the table partitions are altered, the index
partitions are altered accordingly.

A local partitioned index is prefixed if it is partitioned on the same column as the underlying
table. The local partitioned index is nonprefixed if it is partitioned on a different column.

Global prefixed indexes
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A global partitioned index can refer to rows in more than one table partition or subpartition.
Global partitioned indexes are more difficult to manage than local partitioned indexes because
any change in the underlying table partition affects all partitions in a global index. As a result,
there is increased partition maintenance.

NOTE: A global index can only be range partitioned but it can be defined on any kind of
partitioned table.

IBM DB2 FOR OS/390 AND z/OS INDEXES
IBM DB2 for OS/390 and z/OS offers two types of indexes:

* Unique
¢ Non-Unique

Unique Indexes guarantee that no two rows of a table have duplicate values in the columns that
define the index.

Non-Unique indexes let table rows have duplicate values in the columns that define the indexes.

SYBASE ASE INDEXES

Sybase ASE offers two types of indexes: clustered and non-clustered. Clustered indexes
physically sort table data to match their logical order. Non-clustered indexes only order the table
data logically. In a database, an index lets you speed queries by setting pointers that let you
retrieve table data without scanning the entire table. An index can be unique or non-unique.

Sybase ASE creates indexes as B-Trees, which are a series of pointers mapping index pages to
their underlying data pages. As tables and, therefore, indexes grow, the number of levels in the
B-Tree increases. The B-Tree of a clustered index is shorter than that of a non-clustered index
because the leaf level of a clustered index is the data page.

A sound indexing strategy is critical to overall system performance. One pitfall to avoid is
placing many indexes on a table without regard for their cumulative cost. Remember that
indexes improve read but slow write performance because Sybase ASE must update more
information in the system catalog. Consequently, extra indexes can actually slow overall
performance if data modification occurs frequently on the table. To determine the efficacy of
indexes, you should tune your queries using SHOWPLAN and IO STATISTICS and analyze the
selectivity of indexes using DBCC SHOW_STATISTICS.

Rapid SQL separates system indexes from user-defined indexes in the Datasource Navigator to
ensure that system indexes are not accidentally altered or dropped.

INSTANCE
NOTE: This object is support for IBM DB2 and Oracle.
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Rapid SQL places Instance as the first level of information under the Datasource node in the
Datasource Navigator. Instance includes:

* DB Manager Configuration

® Data sources
Available Functionality
Rapid SQL offers the following functionality for this object:

Databases Wizard Quiesce (Database) Unguiesce

(DB2 LUW

JAVA CLASSES

The Java Classes contain compiled Java code. Java Classes are made up of a group of data
items, with associated functions that perform operations. The data items are called fields or
variables; the functions are referred to as methods.

TIP:  Oracle is shipped with a JVM (Java Virtual Machine). The JVM provided by Oracle sits
atop the Oracle RDBMS and interacts directly with the RDBMS instead of the operating
system.

Platform availability
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Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Compile Create Synonym Drop Java Load Java Report

JAVA RESOURCES
NOTE: This object is supported by Oracle only.

The Java Resources node offers support for browsing Java resources.
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Platform availability
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Available Functionality
e Drop

JAVA SOURCES

Java Sources contain the uncompiled Java source code.

TIP:  Oracle is shipped with a JVM (Java Virtual Machine). The JVM provided by Oracle sits
atop the Oracle RDBMS and interacts directly with the RDBMS instead of the operating
system.

Platform availability
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Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Compile Drop Extract Load Java Rename
Report

JOBS (ORACLE)

The following summarizes support for this object type, making up a combination of a schedule a
program, and arguments required by the program.
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Platform availability
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Creating and editing
e "Jobs wizard (Oracle)" on page 389 and "Jobs Editor (Oracle)" on page 543

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Enable/Disable Extract Run Job (Oracle Stop Job
(Oracle Jobs) Jobs

Related Information
See details for the following object types

e "Chains" on page 184

® "Programs" on page 226
e "Schedules" on page 230

JoB QUEUES

Job Queues are built-in mechanisms that let you schedule a variety of SQL-based or command-
line driven tasks.

Platform availability
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Creating and editing

e "Oracle Job Queue Wizard (Oracle)" on page 388 and "Job Queue Editor (Oracle)" on
page 543
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Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Disable Job Drop Enable Job (Job Extract Report
Queue)

Run Job (job queues)

JOIN INDEXES
Rapid SQL offers limited support for these multi-table indexes.

Platform availability
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Creating and editing
Rapid SQL does not offer support for creation or editing of objects this type.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

© <‘
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Drop v v
Extract v v
LIBRARIES

Libraries are an object type that represent a call to an operating system shared library. After the
call is made, libraries can be used by SQL or PL/SQL to link to external procedures or functions.
Libraries are only to be used on operating systems that support shared libraries and dynamic
linking. Libraries serve as pointers or aliases to physical operating system shared library files and
do not have existence as a physical object on their own, rather they rely on the physical
existence of the files in the external operating system library to which they refer. To access the
function or procedures stored in the library, you need execute privileges at the operating system
level where the shared library resides.
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Platform availability
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Creating and editing
e "Libraries Wizard (Oracle)" on page 390 and "Libraries Editor (Oracle)" on page 544

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Rename Report
LOGINS

Logins let you access your account. Your login account controls access to the server and all of
the databases within it. Only the System Administrator or System Security Officer can create
logins. Once you can log into a server, you need additional privileges to access user databases.
Specifically, each database owner adds the login as a user or alias to the database.

Platform availability
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Creating and editing
e "Logins Wizard (SQOL Server)" on page 346 and "Logins Editor (SOL Server)" on page 518

e "l ogins Wizard (Sybase ASE)" on page 438 and "Logins Editor (Sybase ASE)" on page 573
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Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.
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Add/Modify Login Trigger v
Bind To Temporary Database v
Change Password v
Create Like
Drop 4 4
Drop Login Trigger v
Extract v v
Report v v
Unbind From Temporary v
Database

Explorer Details

Depending on the DBMS platform, the icon associated with a login differs according to the
login’s locked or unlocked state, when viewed in the Explorer.

DBMS Platform Icon Login Accont State
SQL SVR or SYB ASE B Locked
Ba Unlocked

DBMS-specific notes
® Microsoft SOL Server Logins

e Sybase ASE Logins

MICROSOFT SQL SERVER LOGINS

Logins let you access your account. Your login account controls access to the server and all of
the databases within it. Only the System Administrator or System Security Officer can create
logins. Once you can log into a server, you need additional privileges to access user databases.
Specifically, each database owner adds the login as a user or alias to the database.
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SYBASE ASE LOGINS

Logins let you access your account. Your login account controls access to the server and all of
the databases within it. Only the System Administrator or System Security Officer can create
logins. Once you can log into a server, you need additional privileges to access user databases.
Specifically, each database owner adds the login as a user or alias to the database.

MACROS

Rapid SQL provides support for macros, sequences of SQL statements that when called, may
return one or more rows of data.

Platform availability
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Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Object Properties Rename

MATERIALIZED QUERY TABLES

A materialized query table is a table whose definition is based on the result of a query. The
materialized query table typically contains pre-computed results based on the data existing in
the table or tables that its definition is based on. If the SQL compiler determines that a query will
run more efficiently against a materialized query table than the base table or tables, the query
quickly executes against the materialized query table.
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Platform availability
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Creating and editing

* "Materialized Query Tables Wizard (DB2 LUW)" on page 268 and "Materialized Query
Tables Editor (IBM DB2 LUW)" on page 467

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Build Query Create Alias Create Like Create View Describe

Drop Drop Materialized Extract Lock Refresh Table
Query Table

Reorganize /Reorg Report Schema Select * From Set Integrity

Transfer Ownership  Update Statistics

MATERIALIZED VIEWS
NOTE: This object is supported by Oracle only.

Materialized views are used to dynamically copy data between distributed databases. There are
two types of materialized views:
e Complex

e Simple

Complex materialized views copy part of a master table or data from more than one master
table. Simple materialized views directly copy a single table. You cannot directly update the
underlying data contained in materialized views.
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Platform availability
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Creating and editing

® "Materialized Views Wizard (Oracle)" on page 391 and "Materialized Views Editor (Oracle)"
on page 544

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Compile Create Synonym Drop Extract Rename
Report Shrink

MATERIALIZED VIEW LOGS

Materialized View logs are tables that maintain a history of modifications to the master table,
and they are used to refresh simple materialized views. When you create a materialized view log,
Oracle automatically creates a log table to track data changes in the master table and a log
trigger to maintain the data in the log table.

Platform availability
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Creating and editing

e "Materialized View Logs Wizard (Oracle)" on page 396 and "Materialized View Logs Editor
(Oracle)" on page 546

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Report Shrink
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OUTLINES

Qutlines are a set of results for the execution plan generation of a particular SQL statement.
When you create an outline, plan stability examines the optimization results using the same data
used to generate the execution plan. That is, Oracle uses the input to the execution plan to
generate an outline, and not the execution plan itself.

Platform availability
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Creating and editing
e "Qutlines Wizard (Oracle)" on page 398 and "Outlines Editor (Oracle)" on page 547

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Change Category Drop Drop By Category Drop Unused Disable Keys

Extract Reassign By Rebuild Outlines Rename Report
Category

PACKAGES

NOTE: This object is supported by IBM DB2 for Linux, Unix, and Windows, IBM DB2 for OS/
390 and z/OS, and Oracle only.

Packages contain all the information needed to process SQL statements from a single source
file. You can use packages to process and call batches of SQL. Depending on the platform,
packages can include:

® Procedures
® Functions

* Types

Variables

Constants
e Exceptions

e Cursors
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e Subprograms

Packages offer a number of important advantages over using standalone procedures and
functions, including the ability to:

¢ Modify package objects without recompiling dependent database objects.
e Declare global variables and cursors that can be shared within the package.
e Grant privileges more efficiently.

e | oad multiple package objects into memory at once.

Packages usually have two parts: a header or specification and a body, although sometimes the
body is unnecessary. The package header declares the members of the package while the body
details the logic underlying each of the package components.

NOTE: Rapid SQL splits out package headers and package bodies in the Datasource
Navigator; however, you create both a package header and body from the packages
node.

Platform availability
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Creating and editing
e "Packages Editor (IBM DB2 LUW)" on page 468

e "Packages Editor (IBM DB2 Z/OS)" on page 486

e "Packages Wizard (Oracle)" on page 398 and "Packages Editor (Oracle)" on page 547

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.
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Bind Package v
Compile v
Create Synonym v
Drop v v
Extract v
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Flush Cache v

Free (Packages) v

Rebind Packages v

Report v v 4

PACKAGE BODIES

Package Bodies implement the package specification in that the package body includes the
definition of every cursor and subprogram declared in the package specification.

Platform availability
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Creating and editing

While Package Bodies are listed as a separate object in the Datasource Navigator, they are
created on the Packages Editor in conjunction with Packages. For more information, see
"Package Bodies Editor (Oracle)"” on page 547.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Compile Create Synonym Drop Extract Report

PARTITION FUNCTIONS

Partition functions are functions that maps the rows of a table or index into partitions based on
the values of a specified column. Partition functions are referenced in partition scheme
definitions in partitioning indexes or tables.
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Creating and editing

See the following topics:

e "Partition Functions Wizard (SOL Server)" on page 348 and "Partition Functions Editor (SQL
Server)" on page 519

Available Functionality
Rapid SQL offers the following functionality for this object type:

Drop Extract Report

For related information, see the following topics:

e "Partition Schemes" on page 220 and "Partition Schemes Wizard (SQL Server)" on page 349

e "Indexes Wizard (SQL Server)" on page 344

e "Tables Wizard (SQOL Server)" on page 360

PARTITION SCHEMES

Partition schemes map the partitions of a partitioned table or index to filegroups. The number
and domain of the partitions for a partitioned table or index are specified in a partition function
definition. Partition scheme definitions are referenced when partitioning indexes or tables.

Platform availability
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Creating and editing

See the following topics:

e "Partition Schemes Wizard (SQL Server)" on page 349 and "Partition Schemes Editor (SQL
Server)" on page 520
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Available Functionality
Rapid SQL offers the following functionality for this object type:

Drop Extract Next Used Filegroup Report

For related information, see the following topics:

e "Partition Functions" on page 219 and "Partition Functions (SOL Server) - Properties" on
page 349

* "Indexes Wizard (SQL Server)" on page 344

e "Tables Wizard (SQL Server)" on page 360

PLANS

A Plan is an executable application created in the bind process. It can include one or more
packages or debris.

Platform availability

= 3 p iy % L
(@) wn
D o @D Q %:) = (_j‘ m m n:‘
a a = s O £ & & & =
v

Creating and editing
e "Plans Wizard (DB2 Z/OS)" on page 295 and "Plans Editor (IBM DB2 Z/OS)" on page 487

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Free Plan Rebind Plans Report

PRIMARY KEYS
NOTE: This object is supported by all platforms.

Primary Keys are a set of table columns that can uniquely identify every row of a table.
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Creating and editing

e "Primary Keys Wizard (DB2 LUW)" on page 271 and "Primary Keys Editor (IBM DB2 LUW)"
on page 468

® "Primary Keys Wizard (DB2 Z/OS)" on page 297 and "Primary Keys Editor (IBM DB2 Z/OS)"
on page 488

e "Primary Keys Wizard (ITB/FBD)" on page 322 and "Primary Keys editor (InterBase/
Firebird)" on page 503

¢ "Indexes, Primary Keys, or Unique Keys wizard (MySQL)" on page 372 and "Indexes, Primary
Keys, and Unique Keys editors (MySQL)" on page 534

e "Primary Keys Wizard (Oracle)" on page 399 and "Primary Keys Editor (Oracle)" on page 548

e "Primary Keys Wizard (SQL Server)" on page 350 and "Primary Keys Editor (SQL Server)" on
page 520

® "Primary Keys Wizard (Sybase ASE)" on page 440 and "Primary Keys Editor (Sybase ASE)"
on page 573

NOTE: Creation and editing of objects of this type is not supported against PostgreSQL,
Sybase IQ, or Teradata datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.
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Allocate Extent v
Analyze v
Change Status (check constraints) 4
Deallocate Unused Space v
Disable Index v
Drop v v v v v v v v v
Extract v v v v v v v v v
Rebuild Index v v
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Rename v v v v v v v
Reorganize /Reorg v
Report v v v v v v v
PROCEDURES

Procedures are a reusable block of PL/SQL, stored in the database, that applications can call.
Procedures streamline code development, debugging, and maintenance by being reusable.
Procedures enhance database security by letting you write procedures granting users execution
privileges to tables rather than letting them access tables directly.

Platform availability
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Creating and editing

e "Procedures Wizard (DB2 LUW)" on page 272 and "Procedures Editor (IBM DB2 LUW)" on
page 469

e "Procedures Wizard (DB2 Z/OS)" on page 299 and "Procedures Editor (IBM DB2 Z/QS)" on
page 489

e "Procedures Wizard (ITB/FBD)" on page 323 and "Procedures editor (InterBase/Firebird)"
on page 504

e "Procedures Wizard (Oracle)" on page 401 and "Procedures Editor (Oracle)" on page 550

e "Procedures Wizard (SQL Server)" on page 351 and "Procedures Editor (SQOL Server)" on
page 522

® "Procedures Wizard (Sybase ASE)" on page 441 and "Procedures Editor (Sybase ASE)" on
page 574

NOTE: Creation and editing of objects of this type is not supported against Sybase IQ and
Teradata datasources.
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Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.
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Build v

Compile v v

Create Synonym v

Describe v v v v v

Drop v v v v v v v

Execute v v v v

Extract v v v v v v v v

Hide Text v

Object Properties v

Rename v v v v v v v

Report v v v

Transfer Ownership v

For more specific information, see the following topics:

e DB2 z/OS Procedures

e Sybase ASE Procedures

e Executing Statements Before and After Procedure or Function Creation

DB2 z/OS PROCEDURES

Only IBM DB2 for OS/390 and z/OS SQL stored procedures created by Rapid SQL, or IBM's
Stored Procedure Builder can be retrieved by Rapid SQL.
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SYBASE ASE PROCEDURES

Procedures perform procedural logic in your Sybase ASE applications. They are batches of SQL
statements that are compiled and stored in the system catalog. Procedures execute faster than
embedded SQL statements because they are pre-compiled and have execution plans for use by
the optimizer. When you create a procedure, Sybase ASE builds a query tree, which it stores in a
system table. When you execute a procedure for the first time, Sybase ASE loads it from the
system table, compiles, and optimizes it. Sybase ASE places the resulting query plan in the
procedure cache where it remains on a most recently used basis. In addition to better
performance, procedures yield other benefits, including easier code maintenance, additional
security and reduced network traffic.

NOTE: Rapid SQL also supports extended procedures. For details, see Extended Procedures.

EXECUTING STATEMENTS BEFORE AND AFTER PROCEDURE OR FUNCTION CREATION

With respect to functions and stored procedures, it can be necessary to have statements
executed before and after creation of the procedure or function. This can be useful for example,
if you need to create or drop temporary tables used by the function or procedure. Rapid SQL
supports the use of two tag pairs, ETStart and ETEnd, that let you embed statements in the first
comment block of a stored procedure or function. The following shows the expected syntax:

create procedure dbo.procname(@a numeric) as
/*

<ETStart>SQL Statement</ETStart>

<ETEnd>SQL Statement</ETEnd>

*/

begin

PROFILES

Profiles are a mechanism for allocating system and database resources to users. Profiles let you
specify limits on:

o Number of sessions

CPU time

Connect time

Idle time

Logical reads and space in the SGA's shared pool

You can assign profiles to one or more users. The database's default profile and all of its
resource limits are assigned to users without a specific profile assignment.
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38* Sl g | w

) %)

3138 |09 2l a | 2|9 | «

ggﬁm%ﬁ)l—a‘mmm

o | a | & [ 3| | & | & | & | A | H
v

Creating and editing
e "Profiles Wizard (Oracle)" on page 402 and "Profiles Editor (Oracle)" on page 550

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Report
PROGRAMS

The following summarizes support for this object type, making up a collection of metadata
about a particular task.

Platform availability
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Creating and editing
e "Programs wizard (Oracle)" on page 404 and "Programs Editor (Oracle)" on page 551

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Enable/Disable (Oracle Jobs) Extract

Related Information

See details for the following object types
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e "Chains" on page 184

e "Jobs (Oracle)" on page 209
e "Schedules" on page 230

RECYCLE BIN

Rapid SQL provides basic support for Oracle’s Recycle Bin feature. When enabled, dropped
tables, indexes, and associated objects are stored in the Recycle Bin until explicitly purged.

Platform availability
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Creating and editing

The Recycle Bin cannot be created or edited.

Object actions/operations supported

On the Datasource Navigator, selecting the Recycle Bin node has the same effect as issuing a
SHOW RECYCLEBIN statement. The contents of the Recycle Bin are displayed.

Related actions include:

Enable Recycle Bin Flashback Recycle Bin Entry  Purge Recycle Bin Purge Recycle Bin Entry

NOTE: Select * From functionality is supported as a right-click option for individual tables in
the Recycle Bin. For details on this feature, see "Select * From" on page 698.

ROLES

Roles are sets of user privileges you associate with access to objects within a database. Roles
streamline the process of granting permissions. You can use roles to grant sets of permissions
and privileges to users and groups.
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Creating and editing
e "Roles Wizard (ITB/FBD)" on page 324 and "Roles editor (InterBase/Firebird)" on page 505

e "Roles Wizard (SQL Server)" on page 353 and "Roles Editor (SOL Server)" on page 522
e "Roles Wizard (Oracle)" on page 405 and "Roles Editor (Oracle)" on page 552

NOTE: Rapid SQL does not allow you to create or edit this object type against PostgreSQL
data sources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.
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Drop v v v v
Extract v v v v
Report v v v
Role Activation v v

For related information
e Microsoft SOL Server Roles

¢ Oracle Roles

MICROSOFT SQL SERVER ROLES

Roles let you manage permissions for users to perform a set of activities based on job functions.
Roles are a mechanism for streamlining the assignment of object and system privileges to
multiple users. Instead of granting sets of privileges to individual users, you can create a role,
grant system and object privileges to that role, and then grant that role to all the users who
should share the same privileges. You can grant one or more roles to the same user. Therefore, if

you need to change the permissions for a certain role you can do so, and not have to grant or
revoke the permissions for each individual user.
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ORACLE ROLES

Roles are a mechanism for streamlining the assignment of object and system privileges to
multiple users. Instead of granting sets of privileges to individual users, you can create a role,
grant system and object privileges to that role, then simply grant that role to all the users who
should share the same privileges. You can grant one or more roles to the same user.

DBMS-specific functionality

® For information on activating and deactivating roles for the current login in the current
session, see "Role Activation" on page 696.

RULES

Rules promote data integrity by allowing you to validate the values supplied to a table column.
They are reusable objects that you can bind to table columns or user datatypes. For example,
you can create a rule, bind it to a column in a table and have it specify acceptable values that
can be inserted into that column.

Platform availability
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Creating and editing
® "Rules Wizard (SQL Server)" on page 353 and "Rules Editor (SQL Server)" on page 523

e "Rules Wizard (Sybase ASE)" on page 442 and "Rules Editor (Sybase ASE)" on page 575

NOTE: Rapid SQL does not allow you to create or edit this object type against PostgreSQL
data sources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

Drop

Extract

Hide Text

< | «|PSTGRS *
<| «[SQL SVR
<| «| «|SYBASE
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Rename v v
Report v v
SCHEDULES

The following summarizes support for the object type that implements a schedule defining when
a job should be run or when a window should open.

Platform availability
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Creating and editing
e "Schedules Wizard (Oracle)" on page 407 and "Schedules Editor (Oracle)" on page 554

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract

Related Information
See details for the following object types

e "Chains" on page 184
e "Jobs (Oracle)" on page 209

e "Programs" on page 226
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SCHEMA

A Schema is a container of objects that can be owned by any user.

NOTE: The Schema nodes available under DB2 LUW, DB2 z/OS, and Oracle datasources do
not own a specific set of objects. They are simply an organizational container for all
database objects for a datasource or database.

Platform availability
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Creating and editing

e "Schema Wizard (SQOL Server)" on page 354 and "Schemas Editor (SQL Server)" on
page 523

NOTE: Rapid SQL does not allow you to create or edit this object type against PostgreSQL
data sources.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.
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Change Owner v

Change Schema v

Drop v v

Extract v v

Rename v

Report v
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SEGMENTS

Segments are a mechanism for placing tables and indexes on specific logical partitions. You
create segments on one or more fragments of a database. You can map segments to specific
database fragments, which in turn reside on specific hard disks; and, mapping segments lets you
increase i/o throughput by placing intensively used tables and indexes on different physical
devices. You can allocate tables and indexes to segments by including placement statements at
the end of CREATE TABLE or CREATE INDEX statements.

Platform availability
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Creating and editing

e "Segment Wizard (Sybase ASE)" on page 443 and "Segments Editor (Sybase ASE)" on
page 575

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Report
SEQUENCES

Sequences are programmable database objects that generate a definable sequence of values.

Platform availability
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Creating and editing

e "Sequences Wizard (DB2 LUW)" on page 274 and "Sequences Editor (IBM DB2 LUW)" on
page 470

e "Sequences Wizard (Oracle)" on page 408 and "Sequences Editor (Oracle)" on page 554
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e "Sequences Wizard (SQL Server)" on page 355 and "Sequences Editor (SQL Server)" on
page 524

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

DB2 LUW
RC
SQL SVR

Create Alias v

Create Synonym
Drop

Extract

Rename

NS
NV IANIRNEEN RN

Report

Restart Sequence(s)

N IENEENEEN IR

AN

Run Job (job queues)

Transfer Ownership

SHADOWS

Rapid SQL provides support for shadows, letting you create one or more in-sync copies of the
database stored on secondary storage devices.

Platform availability
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Creating and editing

See "Shadows wizard (ITB/FBD)" on page 324 and "Shadows editor (InterBase/Firebird)" on
page 506.
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Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Rename Report

STRUCTURED TYPES

Structured types define an abstract data type or object composed of a collection of similar
types of data. For example, create an structured type that defines a full address rather than the
pieces of an address, such as city, state and postal code. An structured type stores the pieces of
an address in a single type, storing them in the same location and allowing the full address to be
accessed and manipulated as single unit rather than multiple units.

Structured types are useful for ensuring uniformity and consistency as they are defined as single
encapsulated entity that can be reused in other structured types and objects. They also offer
flexibility by allowing for the creation of objects that represent real-world situations which is
limited in relational objects.

Platform availability
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Creating and editing
e "Structured Types Wizard (DB2 LUW)" on page 275 and "Structured Types Editor (IBM DB2

LUW)" on page 471

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Report Transfer Ownership

SYMMETRIC KEYS

Symmetric keys, in addition to asymmetric keys and certificates, provide Rapid SQL support for
Public Key Encryption. Symmetric keys consist of a private key and corresponding public key and
are used to secure symmetric keys.

234 RAPID SQL 8.7.2/XE6 USER GUIDE



SUPPORTED OBJECTS > SUPPORTED OBJECTS

Platform availability
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Creating and editing

e "Symmetric Keys Wizard (SQL Server)" on page 356 and "Symmetric Key Editor (SQL
Server)" on page 524

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Drop Extract Report

Related information

e "Certificates" on page 183

e "Asymmetric Keys" on page 182

SYNONYMS
The function and usage of synonyms differs by DBMS platform
DB2 z/0OS An alternate name for an existing table, view, or alias.
Oracle An alternative name for a table, view, sequence, procedure, function, package,

materialized view, java class, type, or another synonym.

SQL Server A single-part name used to reference multi-part names in SQL statements. While
synonyms can be created for functions, procedures, tables, and views, consult Microsoft
SQL Server documentation for restrictions on function and procedure support. For more
information, see Accessing Third Party Documentation.
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Creating and editing

e "Synonyms Wizard (DB2 Z/OS)" on page 302 and "Synonyms Editor (IBM DB2 Z/QS)" on
page 491

e "Synonyms Wizard (Oracle)" on page 410 and "Synonyms Editor (Oracle)" on page 555

e "Synonyms Wizard (SQL Server)" on page 359 and "Synonyms Editor (SQL Server)" on
page 525

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

%
o
Q =
N —1 )
318 |
&) (@) D
Create Synonym v
Describe v
Drop v v v
Extract v v v
Rename v v
Report v v v

SYSTEM INDEXES

On some DBMS platforms, Rapid SQL offers system indexes as listed separately from standard
indexes.
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Creating, Editing, and Object Actions Supported

Against SQL Server and Sybase ASE datasources, functionality offered for system indexes is
identical to that offered for standard indexes. For details, see "Indexes" on page 203.

Against Sybase 1Q datasources, Rapid SQL does not offer support for creation or editing against
this object type. The followng object actions are available:

* Drop

e Extract

SYSTEM TABLES

On some DBMS platforms, Rapid SQL offers system tables as listed separately from standard
tables.

Platform availability
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Creating, Editing, and Object Actions Supported

Against SQL Server and Sybase ASE datasources, functionality offered for system indexes is
identical to that offered for standard indexes. For details, see "Indexes" on page 203.

Against Sybase |Q datasources, Rapid SQL does not offer support for creation or editing against
this object type. The followng object actions are available:

* Drop
e Extract

e Object Properties

e Select * From
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SYSTEM TRIGGERS

Against Sybase |Q datasources, Rapid SQL offers system triggers as listed separately from
standard triggers.

Platform availability
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Creating, Editing, and Object Actions Supported

Rapid SQL does not offer support for creation, editing, and object actions against this object
type.

TABLES

Tables are a the basic unit of data storage. Tables store all the data accessible to users in rows
and columns. Each column has a name, datatype and other associated properties. After you
define a table, users can insert valid data into the table, which you can later query, update and
delete.

NOTE: Rapid SQL separates system tables from user-defined tables in the Navigator to ensure
that system tables are not accidentally altered or dropped.

Platform availability
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Creating and editing
e "Tables Wizard (DB2 LUW)" on page 277 and "Tables Editor (IBM DB2 LUW)" on page 473

e "Tables Wizard (DB2 Z/OS)" on page 302 and "Tables Editor (IBM DB2 Z/OS)" on page 491

e "Tables Wizard (ITB/FBD)" on page 326 and "Tables editor (InterBase/Firebird)" on
page 506

® "Tables wizard (MySQL)" on page 373 and "Tables editor (MySQL)" on page 534
e "Tables Wizard (Oracle)" on page 411 and "Tables Editor (Oracle)" on page 555

238 RAPID SQL 8.7.2/XE6 USER GUIDE



SUPPORTED OBJECTS > SUPPORTED OBJECTS

e "Tables Wizard (SQL Server)" on page 360 and "Tables Editor (SQL Server)" on page 525

e "Tables Wizard (Sybase ASE)" on page 444 and "Tables Editor (Sybase ASE)" on page 576

NOTE: Creation and editing of objects of this type is not supported against PostgreSQL,
Sybase |Q, or Teradata datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

DB2 LUW
DB2 z/OS
ITB/FBD *
MysaL
ORCL
PSTGRS *
SOL SVR
SYB ASE
B 1Q

SYB 1Q

=

<O

Allocate Extent

Analyze v

Analyze Tables v

Build Query v v v v v v v v

Change Access Status v

Change Owner v

Change Schema v
Check Tables v

Checksum Tables v

Convert Tables v

Create Alias v

Create Clone

Create Insert Statements v

Create Like v

SN EENEEN IR
\
\

Create Synonym
Create View v v v

DBCC

\
\
ANIRN RN RN
\
\

Deallocate Unused Space v

Delete Statistics v
Describe v v v v v v

Disable Keys v
Disable/Enable Triggers v v

Drop v v v v v v v v v

Drop Clone v

Drop Unused v
Edit Data v v v v v v v v

RAPID SQL 8.7.2/XEé6 USER GUIDE 239



SUPPORTED OBJECTS > SUPPORTED OBJECTS

)| x *
2198 213 |49 9|0
38 |e HENERERE:
Enable/Disable Filetable(s)
Enable Keys
Estimate Size v
Exchange Data With Clone v
Extract v v v v v v
Extract Data as XML v v
Flashback Table
Flush Tables
Hide Text v
Import Data From File v v v v v
Lock v v
Move Table v
Object Properties v
Optimize Tables
Place v
Rebuild Table
Recompile v v
Rename v v v v v v
Reorganize /Reorg 4 v
Repair Tables
Report v v v v v
Schema v v v v v v
Select * From v v 4 v v v v v
Set Integrity v
Shrink
Transfer Ownership v
Truncate v v v v
Update Statistics 4 v v
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DBMS platform-specific notes

MySQL MySQL servers can store tables in multiple formats, including MyISAM and InnoDB.
MyISAM tables (ISAM is the acronym for indexed sequential access method) are used
most often for read operations. The read operation is very fast, but you cannot include
any referential integrity, such as a foreign key. Also, MylISAM tables only issue table-level
locks. InnoDB tables, on the other hand, do permit transactions and foreign key
constraints. InnoDB tables also lock data at the row level, which is appropriate for high
transaction tables. Additional table types available are MERGE, MEMORY, FEDERATED,
and ARCHIVE among others.

For a complete discussion of table types, go to the MySQL documentation of table and
engine types. For more information, see Accessing Third Party Documentation.

TABLESPACES

Tablespaces are storage structures that act as partitions for the database. You can create a
tablespace to store table data and other objects related to table performance such as indexes or
large object data. Tablespaces are used to manage large complex databases. Once you have
created a tablespace, you can place objects on it.

TIP: Create separate tablespaces for your tables and indexes and put each tablespace on a
different drive or file system. Segmenting tables and their corresponding indexes in
this manner helps eliminate I/O contention at the server level.

NOTE: IBM DB2 for Linux, Unix, and Windows lets you assign a location for table or index data
directly to physical storage devices. Each tablespace can also be broken down into a
collection of containers which are the actual physical storage files or devices. You can
then spread the data or database objects across multiple file systems, thereby giving
you the necessary space for objects that require it.

Once you have created a tablespace, you can place individual tables and indexes on it. Because
tablespaces map to physical drives, you can improve i/o performance by placing tables and their
indexes on physically separated table spaces.

Platform availability
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Creating and editing

e "Tablespaces Wizard (DB2 LUW)" on page 281 and "Tablespaces Editor (IBM DB2 LUW)"
on page 476
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e "Tablespaces Wizard (Oracle)" on page 418 and "Tablespaces Editor (Oracle)" on page 558

NOTE: Rapid SQL does not allow you to create or edit this object type against PostgreSQL
data sources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

(@] *
¥l g g |5
Q &) O a
Change Owner v
Change Status v
Coalesce v
Create Alias
Drop v v v v
Extract v
Lower High Water Mark v
Rebalance v
Rename v v v
Reorganize /Reorg
Report v v v
Set Default v
Set UNDO v
Switch Online v
Transfer Ownership 4

TRIGGERS

Triggers are a special type of procedure that automatically fire when defined data modification
operations (insert, update, or delete) occur on a target table or view. Trigger support in Rapid
SQL differs by DBMS type, but in general offers options such as:

e Standard INSERT/DELETE/UPDATE event support

BEFORE/AFTER timing control

Row/statement trigger type control

INSTEAD OF triggers

Compound triggers
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¢ Enabled/disabled status options

Platform availability
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Creating and editing

e "Triggers Wizard (DB2 LUW)" on page 282 and "Triggers Editor (IBM DB2 LUW)" on
page 477

® "Triggers Wizard (DB2 Z/OS)" on page 307 and "Triggers Editor (IBM DB2 Z/OS)" on
page 494

e "Triggers Wizard (ITB/FBD)" on page 328 and "Triggers editor (InterBase/Firebird)" on
page 507

e "Triggers Wizard (Oracle)" on page 422 and "Triggers Editor (Oracle)" on page 560

e "Triggers Wizard (SQL Server)" on page 363 and "Triggers Editor (SQL Server)" on
page 527

® "Triggers Wizard (Sybase ASE)" on page 446 and "Triggers Editor (Sybase ASE)" on
page 579

NOTE: Creation and editing of objects of this type is not supported against PostgreSQL,
Sybase IQ, or Teradata datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.
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Change Status v v v
Compile v
Drop v v v v v v
Extract v v v v v v v
Hide Text v
Report v
Rename v v v v v v
Transfer Ownership v
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TYPES

Types define an abstract data type or object composed of a collection of similar types of data.
For example, create an object type that defines a full address rather than the pieces of an
address, such as city, state and postal code. An object type stores the pieces of an address in a
single type, storing them in the same location and allowing the full address to be accessed and
manipulated as single unit rather than multiple units.

Object types are useful for ensuring uniformity and consistency as they are defined as single
encapsulated entity that can be reused in other object types and objects. They also offer
flexibility by allowing for the creation of objects that represent real-world situations which is
limited in relational objects.

You can choose to create a type that is incomplete, complete, a VARRAY, or a nested table or
any combination of the above. An incomplete type specifies no attributes and can be used for
circular references such as person - female. It lets the type be referenced before it is complete.
The VARRAY type can be used to store small sets of related data. For example, if you have ten
offices (each one with a different description) at a particular division in your company, you could
create a VARRAY of 10 to hold the details of these offices. The values for a VARRAY type must be
fixed and known and small values as they are stored in RAW format. A nested table type can be
used when data is repeated for the same entity an unknown number of times and storage is a
concern.

Platform availability
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Creating and editing
e "Object Types Wizard (Oracle)" on page 424 and "Types Editor (Oracle)" on page 562

NOTE: Objects of this type cannot be created or edited against PostgreSQL datasources.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

x
&
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& s
O o
Change Owner v
Change Schema v
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PSTGRS *

Compile

<

Drop

<| «| «| ORCL

Extract

Rename

Report v

TYPE BODIES

Type Bodies implement object type specification by containing the definition of every cursor
and subprogram declared in the object type specification. While Type Bodies are listed as a

separate object in the Datasource Navigator, they are created on the Types editor in conjunction
with Types.

Platform availability
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Creating and editing

While listed as separate objects in the Datasource Navigator, type bodies are created and
edited on the Body tab of the Types Editor. For details, see "Types Editor (Oracle)" on
page 562.

Object actions/operations supported

The following object actions are available for this object type. For an introduction to object
actions and details on usage of specific actions, see "Object actions" on page 585.

Compile Drop Extract Report
UNIQUE KEYS

Unique keys can enforce logical keys that are not chosen as the primary key. They enforce
uniqueness for specified columns in a table.
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Platform availability
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Creating and editing

e "Unique Keys Wizard (DB2 LUW)" on page 283 and "Unique Keys Editor (IBM DB2 LUW)" on
page 477

¢ "Unique Keys Wizard (DB2 Z/OS)" on page 308 and "Unique Keys Editor (IBM DB2 Z/OS)"
on page 495

e "Unique Keys Wizard (ITB/FBD)" on page 329 and "Unique Keys editor (InterBase/Firebird)"
on page 508

¢ "Indexes, Primary Keys, or Unique Keys wizard (MySQL)" on page 372 and "Indexes, Primary
Keys, and Unique Keys editors (MySQL)" on page 534

e "Unigue Keys Wizard (Oracle)" on page 424 and "Unique Keys Editor (Oracle)" on page 562

e "Unique Keys Wizard (SQL Server)" on page 365 and "Unique Keys Editor (SOL Server)" on
page 528

¢ "Unique Keys Wizard (Sybase ASE)" on page 448 and "Unique Keys Editor (Sybase ASE)" on
page 579

NOTE: Creation and editing of objects of this type is not supported against PostgreSQL or
Sybase |Q datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.
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Allocate Extent v
Analyze v
Change Status v
Deallocate Unused Space v
Disable Index v
Drop v v v
Extract v v v v v v v v v
Rebuild Index v v
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Rename v v v v v v

Reorganize /Reorg v

Report v v v v v v v

Transfer Ownership v

USER DATATYPES

User-defined datatypes promote domain consistency by streamlining the definition of commonly
used table columns in a database. You can build a customized datatype from system datatypes
and bind defaults and rules to it to enhance integrity. When you reference the user datatype in a
column, the column assumes all of the properties of the user datatype.

Platform availability
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Creating and editing

e "User Datatypes (DB2 LUW)" on page 284 and "User Datatypes Editor (IBM DB2 LUW)" on
page 478

e "User Datatypes Wizard (DB2 Z/OS)" on page 311 and "User Datatypes Editor (IBM DB2 Z/
OS)" on page 496

e "User Datatypes Wizard (SQL Server)" on page 367 and "User Datatypes Editor (SOL
Server)" on page 530

e "User Datatypes Wizard (Sybase ASE)" on page 449 and "User Datatypes Editor (Sybase
ASE)" on page 580
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Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

TERA

Drop

<| «|DB2 LUW
< | «|DB2z/OS

Extract

Rename

AN
AN
<| «| & «|SQLSVR

<| «| | «|SYBASE

Report

Transfer Ownership v

USER MESSAGES

User Messages lets you catalog error messages that your database applications can re-use.
Microsoft SQL Server stores your error messages in a system table, sysmessages. To return error

messages from stored procedures and triggers, you need to call a system stored procedure and
pass an error number as a parameter.

Platform availability
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NOTE: On SQL Server, User Messages can only be accessed from the master database for a
specific server.

Creating and editing

e "User Messages Wizard (SQOL Server)" on page 366 and "User Messages Editor (SQL
Server)" on page 530

e "User Messages Wizard (Sybase ASE)" on page 449 and "User Messages Editor (Sybase
ASE)" on page 581
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Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

o L
> %)
(% <
—
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) %
Drop v v
Extract v v
Report v v
USERS

A user is an individual with access to the DBMS.

Platform availability
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Creating and editing
e "Users Wizard (DB2 LUW)" on page 285 and "Users Editor (IBM DB2 LUW)" on page 479

e "Users Wizard (DB2 Z/OS)" on page 312 and "Users Editor (IBM DB2 Z/QS)" on page 496

e "Users wizard (InterBase/Firebird)" on page 330 and "Users editor (InterBase/Firebird)" on
page 508

e "Users wizard (MySQL)" on page 376 and "Users editor (MySQL)" on page 535

e "Users Wizard (Oracle)" on page 427 and "Users Editor (Oracle)" on page 564

e "Users Wizard (SQL Server)" on page 367 and "Users Editor (SQL Server)" on page 529

e "Users Wizard (Sybase ASE)" on page 451 and "Users Editor (Sybase ASE)" on page 582

NOTE: Creation and editing of objects of this type is not supported against Sybase IQ and
Teradata datasources.
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Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

o x
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Analyze v
Change Password v v v
Compile v
Create Like v v v v v v
Drop v v v v v
Extract v v v v v v v v
Hide Text v
Report v v v v v v
Transfer Ownership

Explorer Details

Depending on the DBMS platform, the icon associated with a user differs according to the
account’s locked or unlocked state, when viewed in the Explorer.

DBMS Platform Icon User Accont State
ORCL or SYB 1O & Locked
a Unlocked

Related information
Microsoft SOL Server Users

MySQL Users

Oracle Users

Sybase ASE Users

MICROSOFT SQL SERVER USERS

Microsoft SQL Server controls access at the database level by requiring the System
Administrator or Database Owner to add a login as a database user or alias. After you create a
database user, you can implement further security by the granting or revoking the privileges for
that user on specific database objects. To consolidate the process of granting or revoking
permissions to many users, the database owner can assign users to groups.
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MYSQL USERS

Unlike adding new users to other platforms, MySQL doesn't rely solely on a userid/password
combination. The MySQL server must not only validate the user and password, but also the host
from which the connection is being requested before the new user is admitted to the server’s
inner sanctum. The Rapid SQL User Wizard and User Editor enable these validations.

ORACLE USERS

To access an Oracle database, you need a user account authenticated with a password. A user
account is what Oracle uses to permit access by the user. You can assign the following optional
properties to the user:

e Default tablespace
e Temporary tablespace
* Quotas for allocating space in tablespaces

e Profile containing resource limits

SYBASE ASE USERS

Sybase ASE controls access at the database level by requiring the System Administrator or
Database Owner to add a login as a database user or alias. After you create a database user, you
can implement further security by granting or revoking the privileges for that user on specific
database objects. To consolidate the process of granting or revoking permissions to many users,
the database owner can assign users to groups.

VIEWS

Views are SQL queries stored in the system catalog that customize the display of data contained
in one or more tables. Views behave like tables because you can query views and perform data
manipulation operations on them. However, views do not actually store any data. Instead, they
depend on data contained in their base tables. Views let you:

* View a customized selection of data from one or more tables. As a result, you can display
data more cogently to different sets of users, even though the underlying data is the same.

e Restricting access to a defined set of rows and columns.
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Creating and editing

"Views Wizard (DB2 LUW)" on page 285 and "Views Editor (IBM DB2 LUW)" on page 479

"Views Wizard (DB2 Z/OS)" on page 312 and "Views Editor (IBM DB2 Z/OS)" on page 497

"Views Wizard (ITB/FBD)" on page 331 and "Views editor (InterBase/Firebird)" on page 509

"Views Wizard (Oracle)" on page 428 and "Views Editor (Oracle)" on page 565

"Views Wizard (SOL Server)" on page 368 and "Views Editor (SQOL Server)" on page 531

"Views Wizard (Sybase ASE)" on page 452 and "Views Editor (Sybase ASE)" on page 582

NOTE: Creation and editing of objects of this type is not supported against PostgreSQL,
Sybase |1Q, or Teradata datasources.

Object actions/operations supported

The following table lists object actions available for this object type. For an introduction to
object actions and details on usage of specific actions, see "Object actions" on page 585.

w * x

% QN % © % g ‘ZJ’ g o
Build Query v v v v v v v
Change Owner v
Change Schema
Compile v
Create Alias v v
Create Synonym v v
Describe v v v v
Drop v v v v v v v v v
Extract v v v
Sti?eer:j;itPackaqe/Procedure/ v v v v v v
Hide Text v
Object Properties v v
Rename v v v v v
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Report v v v v v v

Schema v v v v v v v

Select * From v v v v v v v v

Transfer Ownership v

Update Statistics v

RAPID SQL 8.7.2/XEé6 USER GUIDE 253



SUPPORTED OBJECTS > SUPPORTED OBJECTS

254 RAPID SQL 8.7.2/XE6 USER GUIDE



CREATING OBJECTS

CREATING OBJECTS

Rapid SQL offers easy-to-use wizards and dialog boxes for creating objects. For an introduction
to object creation wizards, see "Overview and Common Usage of Object Wizards" on page 255.

Platform-by-platform discussions of wizards are discussed as follows:

"IBM DB2 for Linux, Unix, and Windows Object Wizards" on page 259

"IBM DB2 for z/OS Object Wizards" on page 286

"InterBase/Firebird Object Wizards" on page 313

"Microsoft SQL Server Object Wizards" on page 332

"MySQL object wizards" on page 369

"Oracle Object Wizards" on page 377

"Sybase ASE Object Wizards" on page 429

OVERVIEW AND COMMON USAGE OF OBJECT WIZARDS

An object wizard lets you create new database and server objects on a datasource. For example,
a Tables wizard lets you create columns, set up permissions to work with that table, provide
details on physical storage for the table, and so on. Each pane on an object wizard lets you
perform a logical task or collection of logical tasks for that object type. For example:
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In order to work with object wizards, you must be familiar with the following:

® Opening an Object Wizard

¢ Navigating and Setting Properties in an Object Wizard

® Previewing the DDL Generated to Create the New Object.

OPENING AN OBJECT WIZARD

Object wizards are accessed from the Datasource Navigator pane of the Rapid SQL main
window.

To open an Object wizard for a server or database object

1 Connect to the datasource where you want to create a new resource. For more information,
see "Datasource and Server Management" on page 121.

2 On the Datasource Explorer, expand the target datasource.

3 Continue to expand folders under the datasource until the type of object you want to create
is visible.
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4 In RApid SQL, on the Datasource Navigator, right-click on the specific type of object that
you want to create and select Create from the context menu.
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Rapid SQL opens the object wizard for that object type.

NAVIGATING AND SETTING PROPERTIES IN AN OBJECT WIZARD

When you invoke an object wizard, it opens on the first pane of the wizard, typically a Properties
pane. As you select options or provide details, you use the navigation buttons at the bottom of
the window and the pane controls at the left of the window to navigate through the wizard.

e Use the Next button to move to the next pane of the wizard.

NOTE: In some cases, the Next button is not activated until required information is provided.
Similarly, some panes of a wizard do not become accessible until activated by choice
of an option or property on a previous pane. For example, a Partitions tab in a table
wizard may only become available if the Clustered and Number of Partitions options
on a prior tab are set accordingly.

¢ Use the Back button to move to the previous pane of the wizard.

e Use the pane controls at the left of the window to move to a specific pane of the wizard.

ADDING A COMMENT TO AN OBJECT

The object wizards for certain object types feature a Comment tab that lets you add an
explanatory note to specific object definitions. Comments are stored in the REMARKS column of
the object’s system-catalog.
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To add a comment to an object:

1 Open an object wizard on an object type that permits comments. For details, see "Opening
an Object Wizard" on page 256.

See the topics for specific Object editors later in this chapter for information on whether
that object type supports comments.

2 Click the Comment panel when enabled.

Carnment

Camment:

1

3 Inthe Comment area, type an explanatory note of up to 254 characters long.

SETTING PERMISSIONS OR PRIVILEGES FOR AN OBJECT

When you open an Object wizard to create an object with associated privileges, the Permissions
(or Privileges or Object Permissions or System Permissions) panel for that editor displays the
relevant privileges and lets you make changes accordingly:

To set permissions for an object:

1 Open an object wizard on an object type with associated permissions or privileges. For
details, see "Opening an Object Wizard" on page 256.

1 object type with associated permissions or privileges.

See the topics for specific Object wizards later in this chapter for information on whether
that object type supports permissions/privileges.

2 Click the Permissions (Privileges, Object Permissions or System Permissions) panel when
enabled.

3 For each specific permission to be granted to an entity such as a user, login, or group, select
the cell corresponding to the entity and specific permission, and click the Grant button. To
revoke a privilege, select a cell showing a Granted permission and click Revoke.

PREVIEWING THE DDL GENERATED TO CREATE THE NEW OBJECT

The final pane or tab of a wizard or editor is most commonly designated DDL View or
Definition.

e A DDL View tab/panel lets you view the DDL generated by your selections on the other
tabs/panels of the wizard or editor.
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¢ A Definition tab/panel is only available for objects such as triggers and procedures, for
which you must provide the additional SQL statements that provide the actions taken for
that object.

In most cases you arrive at DDL View or Definition by navigating through panes or tabs,
choosing options as you proceed. Alternatively, if you have provided all required information for
that object type, you can click Finish or Execute to create the object.

IBM DB2 FOR LINUX, UNIX, AND WINDOWS OBJECT WIZARDS
Rapid SQL lets you create DB2 LUW objects using the following wizards:

Aliases Wizard (DB2 LUW)

Databases Wizard (DB2 LUW)

Foreign Keys Wizard (DB2 LUW)

Functions Wizard (DB2 LUW)

Indexes Wizard (DB2 LUW)

Materialized Query Tables Wizard (DB2 LUW)

Nodegroups Wizard (DB2 LUW)

Primary Keys Wizard (DB2 LUW)

Procedures Wizard (DB2 LUW)

Schemas Wizard (DB2 LUW)

Sequences Wizard (DB2 LUW)

o Structured Types Wizard (DB2 LUW)

Tables Wizard (DB2 LUW)

Tablespaces Wizard (DB2 LUW)

Triggers Wizard (DB2 LUW)

Unigue Keys Wizard (DB2 LUW)

User Datatypes (DB2 LUW)

Users Wizard (DB2 LUW)

Views Wizard (DB2 LUW)

In addition, see Create Synonym.
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ALIASES WIZARD (DB2 LUW)

An alias offers you security and convenience so that you can refer to an object without revealing
who owns it or what database it belongs to. You can create aliases for tables, views, and even
other aliases. The Alias Wizard lets you create an alias without knowing the underlying
commands. As you complete the Alias Wizard process, Rapid SQL constructs the necessary
CREATE ALIAS statement based on the information that you supply.

To create a new alias using a wizard:

1 Open a creation wizard for an alias. For details, see "Opening an Object Wizard" on
page 256.

2 Use the following topics as a guide to setting properties and performing tasks as you pass
through the wizard panels:

* Properties panel - for details see Aliases (DB2 LUW) - Properties.

e Comment panel - for details, see "Adding a Comment to an Object" on page 257.

e DDL View panel - for details, see "Previewing the DDL Generated to Create the New
Object" on page 258.

3 Finally, use the Execute button to create the object.

ALIASES (DB2 LUW) - PROPERTIES
When creating or editing an alias, this tab/panel lets you work with the following settings:

Setting Description

Schema Select the schema that is to own the alias.

Name Provide a name for the alias

Target Owner Select the owner of the object to which you are creating an alias.
Target Type Select the type of object to which you want to create an alias.
Target Name Select the specific object to which you are creating an alias.

For context information on the wizard and editor that include this tab/panel, see "Aliases Wizard
(DB2 LUW)" on page 260 and "Aliases Editor (IBM DB2 LUW)" on page 462.

DATABASES WIzARD (DB2 LUW)

The Database Wizard lets you create a database (a structured collection of data that can be
updated or queried) without knowing the underlying commands. Databases can be simple, that
is one file with many records and the same fields, or much more complicated with multiple files
with different fields.
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To open the IBM DB2 for Linux, Unix, and Windows Database Wizard
On the Registration tool bar, click New UDB Database.

OR

On the Navigator right-click an instance node or the Datasources node, and then click New

UDB Database.

The tables below describe the fields you may encounter as you complete the wizard.

Naming the New Database

Required Information

Description

What is the name of the
database?

Each database requires a unique name. The database name should be between 1 -8
characters and must begin with a letter A-Z. It's wise to avoid the symbols @, #, and $
if the database will exist in a communications environment or be summoned from an
area where those characters do not exist in the language (and hence, on a

keyboard).

What is the datasource name
for the new database?

Each datasource should have a unique name. This is the name that will appear on
the Navigator.

What is the alias name of the
database.

OPTIONAL: A database alias is the local synonym given to the database you are
creating, and must be unique. If you don't assign an alias, the database name
becomes the default alias.

Note that a DB2 client can have connections to two different databases with the
same name if those databases live on different servers and each database has its
own alias.

What is the comment used
for the database?

OPTIONAL: Lets you type a comment up to 30 characters. Any comment you enter
can be changed later.

Drive Path and Parameters

Required Information

Description

On what drive/path will the
database reside?

OPTIONAL: Leave blank if you want Rapid SQL to create the database using the
DFTBPATH (default database path configuration) parameter.

What default tablespace
parameters should be used?

OPTIONAL

Extent size: This is the number of pages of table data that will be written before data
is written to the next container.

Number of segments: The default is 0. The number you designate specifies the
number of extended memory segments available for the database to use. You
should only set this number if you have a large amount of real memory.

What global default
parameters should the
database use?

Territory: The territory where the database was created. This is purely informational,
for example, en_US and is related to region-specific support.

Codeset: IBM-1252 or UTF-8 are the options for language support.

Collating Sequence: Compatibility, Identity, System are your choices for comparing
character data. Note: The collation sequence can't be changed after the database
has been created.
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Required Information Description

Finish Opens the Preview SQL dialog.

Add Catalog/Temporary/User Containers

There are three distinct wizard panels, one for each container type, that enable you to customize
your database. Click Next or Finish depending on how you want to proceed.

Required Information Description

What container(s) will be Use System Managed Space: If you select this option, the operating system’s file
used to store the catalog/ system manager allocates and manages the space where the catalog tables are
temporary tables? stored. This is the default.

Use Database Managed Space: If you select this option, the database manager
controls the storage space for catalog tables.

Add or Edit - For details, see Add/Edit Container for Tablespace.

What optional default Optionally identify values for extent size, pre-fetch size, transfer rate, and overhead.
storage parameters should

be used.

Finish Opens the Preview SQL dialog.

ADD/EDIT CONTAINER FOR TABLESPACE
The table below describes the options and functionality on this dialog:

Required Information Description

Container Parameters These parameters are enabled for modification only if you have opted to use
database managed space. When enabled, you can either indicate file size
parameters or specify device information.

Directory Identify the directory where the catalog table container will be stored.
File Name Identify a name for the file where the catalog table container will be stored.
Device Information Enable either raw partition and type a value, or raw drive, and select a value.

FOREIGN KEYS WIZARD (DB2 LUW)

Foreign keys are unique values that refer to specific columns of other tables. Thus, a foreign key
links two tables together. Embarcadero Rapid SQL's Foreign Key Wizard makes it easy for you to
create a relational link between two tables, thereby speeding queries and giving you faster
access to data.The Foreign Key Wizard lets you create a foreign key without knowing the
underlying commands.
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To create a new foreign key using a wizard:

1 Open a creation wizard for a foreign key. For details, see "Opening an Object Wizard" on

page 256.

2 Use the following topics as a guide to setting properties and performing tasks as you pass
through the wizard panels:

® Properties panel - for details, see Foreign Keys (DB2 LUW) - Properties

¢ Column Mapping panel - for details, see Foreign Keys (DB2 LUW) - Column Mapping

* Comment panel - for details, see "Adding a Comment to an Object" on page 257.

e DDL View panel - for details, see "Previewing the DDL Generated to Create the New
Object" on page 258.

3 Finally, use the Execute button to create the object.

FOREIGN KEYS (DB2 LUW) - PROPERTIES
When creating or editing a foreign key, this tab/panel lets you work with the following settings:

Setting

Description

Table Schema

The schema owning the table where the foreign key is being created.

Table Name

This is the table where the foreign key link originates--the child table.

Name Lets you select a constraint name.
System Generated Name - DB2 automatically generates a name.
User Specified Constraint Name - You type the name.

Enabled TRUE enables the Foreign Key while FALSE disables the Foreign Key.

Delete Rule

Select an action:

NO ACTION - ensures that referenced values cannot be updated or deleted if to do so
would violate referential integrity.

CASCADE permits a referenced row in a child table to be deleted/updated if it is
deleted/updated in the parent table. A row in the child table is SET NULL when rows in
the parent table are deleted/updated.

RESTRICT prevents a command from executing if changes to referential data prompts an
error.

Update Rule

Select an action.

NO ACTION - ensures that referenced values cannot be updated or deleted if to do so
would violate referential integrity.

RESTRICT - prevents a command from executing if changes to referential data prompts
an error
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FOREIGN KEYS (DB2 LUW) - COLUMN MAPPING

1 Under Referenced Table, choose the Owner and then the Name of the referenced, or
parent, table.

2 Under the Main Table, select check boxes corresponding to the columns that are to
reference columns in the referenced table.

FUNCTIONS WIZARD (DB2 LUW)

To create a relationship between one set of values and another, Rapid SQL offers the Function
Wizard. You can develop reusable subroutines so you can control, access, and manipulate the
data that underlies an object. As you complete the Function Wizard process, Rapid SQL
constructs the necessary CREATE FUNCTION statement based on the information that you
supply. The Function Wizard lets you create a function without knowing the underlying
commands.

NOTE: To create a user-defined function, you need CREATE ANY privileges or
IMPLICIT_SCHEMA authority on the database if the schema does not already exist.

To create a new function using a wizard:

1 Open a creation wizard for a function. For details, see "Opening an Object Wizard" on
page 256.

2 Use the following topics as a guide to setting properties and performing tasks as you pass
through the wizard panels:

® Properties panel - for details, see Functions (DB2 LUW) - Properties.

® Advanced panel - for details, see Functions (DB2 LUW) - Advanced.

® Source panel (only available for a Function Type of SOURCED) - for details, see Functions
(DB2 LUW) - Source.

e Parameters panel (only available for a Function Type of SQL, SOURCED, or TEI\/IPLATE) - for details, see
Functions (DB2 LUW) - Parameters.

¢ Return Scalar panel - for details, see Functions (DB2 LUW) - Return Scalar.

e Return Columns panel (only available when you choose a Function Type of EXTERNAL TABLE) - for
details, see Functions (DB2 LUW) - Return Columns.

® Body panel - for details, see Functions (DB2 LUW) - Body.

* DDL View panel - for details, see "Previewing the DDL Generated to Create the New
Object" on page 258.

3 Finally, use the Execute button to create the object.
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FUNCTIONS (DB2 LUW) - PROPERTIES
When creating or editing a foreign key, this tab/panel lets you work with the following settings:

Setting Description

Schema, Name, and Let you select the owner of the function, provide a name for the function, and provide

Specific Name the Specific name to be used by some SQL statements and DB2 commands for this
function.

Function Type Select the type of function:

External Scalar - written in a programming language and returns a scalar value.
External Table - written in a programming language and returns a complete table.
OLEDB - accesses OLE DB data in user-defined OLE DB external tables.

Sourced - another function is invoked to implement the function you are creating.
SQL Language - written in SQL and returns a table, scalar value, or single row.

Template: - this is a partial function and can only be invoked from a federated
datasource.

For more information, see "About function types" on page 266.

Language If you chose a Function Type of EXTERNAL SCALAR or EXTERNAL TABLE, specify a
language of C, JAVA, or OLE. For more information, see "About function types" on
page 266.

Return Type For a Function Type of SQL, select ROW, TABLE, or SCALAR. For other Function Type
choices, this indicates the default return type for that choice.

External Name Provide the External Name of the function.

SQL Access Level Indicates whether the function can execute SQL statements.

CONTAINS SQL: Statements that don't read or modify SQL can be executed.
NO SQL: No SQL statements can be executed.
READS SQL: Statements that cannot modify SQL can be executed.

FUNCTIONS (DB2 LUW) - ADVANCED

This tab is only available after clicking the Advanced button on the Function wizard's Properties
panel. It lets you work with the Threadsafe, Fenced, Scratchpad, Scratchpad Length, Allow
Parallel, Final Call, Parameter Style, Inherit Special Registers, DBINFO, Deterministic,
External Action, Called on Null Input, and Parameter CCSID properties.

FUNCTIONS (DB2 LUW) - SOURCE
NOTE: This panel is only available for a Function Type of SOURCED.

Select the Schema, Name, and Specific Name of the source function. Function Parameters and

Return Type for the selected function are displayed. For more information, see "About function
types" on page 266.

FUNCTIONS (DB2 LUW) - PARAMETERS
NOTE: This panel is only available for a Function Type of SQL, SOURCED, or TEMPLATE.

RAPID SQL 8.7.2/XE6é6 USER GUIDE 265



CREATING OBJECTS

For each parameter for this function, use the New button to add a new parameter, provide a
name for the parameter, and in the Attributes area, select a Type, and if appropriate, the
Precision, Scale, and Size options.

FUNCTIONS (DB2 LUW) - RETURN SCALAR

Under Return Datatype, select a Type and depending on your choice, provide or select
Precision, Scale, Size, and As Locator options.

To make use of a CAST FROM clause, under Cast Datatype set Enabled to True, select a Type,
and if appropriate, the Scale, Size, and As Locator options

FUNCTIONS (DB2 LUW) - RETURN COLUMNS
NOTE: This panel is only available when you choose a Function Type of EXTERNAL TABLE.

For each column returned by this function, use the New button to add a new parameter, provide
a name for the parameter, and in the Attributes area, select a Type, and if appropriate, the
Precision, Scale, Size, and As Locator options.

FUNCTIONS (DB2 LUW) - BoDY
Enter the return statement for the function.

ABOUT FUNCTION TYPES

External Scalar/Table/OLE DB Function

External scalar user-defined functions are implemented in an external programming language.
The functions are executed on the server and can read SQL data but cannot make changes to
the data. These functions are often used to extend the set of built-in functions for DB2, perform
logic inside a SQL query that SQL can't perform on its own, and, encapsulate a scalar query that
is often used as a subquery in SQL statements, for example, if given an ingredient, search a table
for a recipe that uses that ingredient.

When specifying the Specific Name for one of these function types:

e |f you are using C language, specify the full library path and the function name, otherwise
IBM DB2 Database Manager assumes the function is under the IBM DB2 library.

* |f you are using Java script, specify the Class ID and the function name, otherwise IBM DB2
Database Ma